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Welcome to the mc²56 MKII

Welcome to the mc²56 MKII

This  documentation  covers  the  installation,  configuration  and
service/maintenance of the mc²56 MKII.

For  more  on  operation,  please  see  the  "mc²56  Operators
Manual".

You can access all manuals and other information by registering at www.lawo.de (click on Login). By
registering  you  will  receive  the  latest  news  for  your  product,  and  can  download  software  and
documentation.

We also recommend that you carefully observe the release notes delivered with your system.

Getting Started

Read the Technical Overview for an introduction to the system.

Installation deals with installing the hardware.

AdminHD covers the Lawo configuration software.

Service/Maintenance includes hardware servicing and software diagnostics.

The Trouble-shooting section includes a series of example problems and fault-finding tips.

Part numbers for system components are included in the Appendices.

You will find Technical data, and a Glossary of terms at the end of the manual.

The ““mc2_Nova73_documentation” guide contains mechanical drawings, data sheets and
further information on all control surface, Nova73 and DALLIS components. The guide is
included with the "CD_mc2_56_X-XX-X-x" software release, available from the
Download-Center after logging in at www.lawo.de.

Marginal Notes

The following symbols are used to draw your attention to:

Points of clarification.

Useful tips and short cuts.

Warning

Warnings – alert you when an action should always be observed.

http://www.lawo.de
http://www.lawo.de
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Important Safety Instructions

Important Safety Instructions

Warning

Exposure to  excessive sound  pressure  levels  can  lead  to  impaired  hearing  and  cause
damage to the ear.

Please read and observe ALL of the following notes:

Check all of the hardware devices for transport damage. 

Any devices showing signs of mechanical damage or damage from the spillage of
liquids  MUST NOT  be connected to  the mains  supply or  disconnected  from  the
mains immediately by pulling out the power lead.

All devices MUST be grounded. Grounding connectors are provided on all devices.
In addition, all low-voltage devices  external  to  the system  must  also be grounded
before operation.

For  Scandinavian  countries,  ALWAYS  use  a  grounded  mains  connection,  to
prevent  the  device  from  being  grounded  through  Ethernet  or  other  signal
connections.

All  devices  MUST  be connected to  the  mains  using  the  three-cord  power  leads
supplied with  the system.  Only supply electrical  interfaces  with  the  voltages  and
signals described in these instructions.

Do NOT use the system  at  extreme temperatures.  Proper  operation can only be

guaranteed between temperatures  of  10  C  and  35  C  and  a  maximum  relative
humidity of 85%.

Neutrik PowerCon and Harting connectors must NOT be disconnected under load.

Only Lawo service staff may replace batteries.

Servicing of  components  inside  a  device  MUST  only  be  carried  out  by  qualified
service personnel according to the following guidelines:

o We recommend switching off the loudspeakers before servicing.

o Before removing parts of the casing, shields, etc. the device MUST be switched
off and disconnected from all mains.

o Before opening a device, the power supply capacitor MUST be discharged with
a suitable resistor.

o Components  that  carry heavy electrical  loads,  such as  power  transistors  and
resistors, should NOT be touched until cool to avoid burns.

Servicing unprotected powered devices may only be carried out by qualified service
personnel at their own risk. The following instructions MUST be observed:

o NEVER touch bare wires or circuitry.

o Use insulated tools ONLY.

o DO NOT touch metal semi-conductor casings as they can bear high voltages.
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Important Safety Instructions

Defective Parts/Modules

Warning

The system  components  contain  no  user-serviceable  parts.  Therefore  DO  NOT
open the devices other than to perform the procedures described in this manual.

In the event of a hardware defect, please send the system component to your local
service representative together  with  a  detailed description of  the fault.  We  would
like  to  remind  you  to  please  check  carefully  whether  the  failure  is  caused  by
erroneous  configuration,  operation or  connection  before  sending  parts  for  repair.
We recommend contacting our service department before sending parts for repair.

First Aid (in the case of electric shock)

Warning

DO NOT touch the person or his/her clothing before power is turned off, otherwise
you risk sustaining an electric shock yourself.

Separate  the  person  as  quickly  as  possible  from  the  electric  power  source  as
follows:

o Switch off the equipment.

o Unplug or disconnect the mains cable.

o Move the person away from  the power  source by using dry insulating material
(such as wood or plastic).

If the person is unconscious:

o Check their pulse and reanimate if their respiration is poor.

o Lay the body down and turn it to one side. Call for a doctor immediately.

Having sustained an electric shock, ALWAYS consult a doctor.
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Chapter 1: Technical Overview

Chapter 1: Technical Overview

Introduction

This chapter introduces the technical components of the mc²56 MKII system:

Hardware Components

Redundancy

Sample Rate & System Clock

Networking I/O Resources

Nova73 DSHS (Dual Self-Healing Star)

Configuration

System Options
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Chapter 1: Technical Overview
Hardware Components

Hardware Components

The mc²56 MKII consists of three principal components:

Console control surface - with integrated power supplies and local I/O connections.

Nova73 – with Router Modules, DSP boards and AES, MADI, ATM or RAVENNA I/O. Available
in two sizes: Nova73 HD (10RU) or Nova73 Compact (7RU).

DALLIS I/O – offering further I/O breakout options; connected to the Nova73 via MADI, ATM or
RAVENNA I/O.

The exact hardware specification defines how many analogue and digital  connections  are available
for external equipment, and how much DSP processing is available for input channels, monitor return
channels, groups, sums and auxiliary sends. For a summary of the system capabilities, please see
Technical Data.
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Console Control Surface

The mc²56 MKII control surface is constructed in 16-fader sections, with frame sizes scaling from 16
faders up to 80 faders. You may add 16-fader extenders to expand the number of fader strips.

A  range  of  console  options  offer  wide  (studio)  or  narrow  (OB)  side  panels,  table-top  or  stand
mounting, overbridge metering, etc.

Control surface power is provided by internal  power  supplies,  with  n+1 redundancy and two mains
connections for phase redundancy. PSU status may be monitored from the console GUI.

All application software and user data is handled by the control system, located on the Router Module
(MKII) within the Nova73.  The surface connects  to  the Nova73 via  TCP/IP  Ethernet;  if  a  redundant
Router Module is fitted, then main and backup connections can be installed.

The  control  surface  also  houses  a  local  I/O  board,  for  monitoring,  metering,  talkback  and
headphones.  This  is  available  in  two  versions,  connecting  to  the  Nova73  via  either  MADI  or
RAVENNA.

As the control system is integrated within the Nova73, the control surface may be powered
off without loss of user data or audio!
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Hardware Components

Nova73

The Nova73 forms the "heart" of the system, and is available in two sizes - Nova73 HD (10RU)  or
Nova73 Compact (7RU):

Nova73 HD (10RU) Nova73 Compact (7RU)

In each case, the front of the frame houses the:

Router  Modules MKII  -  two  central  slots  are  available  for  a  main  and  redundant  Router
Module. The Router Module MKII (980/33) contains the summing matrix AND control system.
The summing matrix offers a  8k2  capacity*  router  at  48kHz  (or  4k2  capacity at  96kHz).  The
control system runs on an embedded Linux operating system, and stores both the application
software and user data. Connections are made via the two TCP/IP Ethernet ports:

o ETHERNET A – connects to the control surface.

o ETHERNET B – connects to the Lawo system network (to other Lawo devices; third-party
controllers; computers running configuration, maintenance or remote control software).

DSP and I/O Modules - 16* slots are available for plug-in DSP or I/O modules. Up to 8* DSP
boards may be fitted supporting a range of DSP configurations; I/O options include AES/EBU,
MADI,  ATM  and  RAVENNA,  see  Nova73  Module  Options.  All  modules  are  hot-pluggable
enabling  them  to  be  be  replaced  without  affecting  other  aspects  of  the  system.  Further
breakout formats are realised by connecting to DALLIS I/O.

Power Supply Units - two slots are available for main and redundant power supplies.

The rear of the frame houses the:

Sync ports - accepting Wordclock, AES/EBU (AES3-id) or Video Black Burst (PAL or NTSC).

Alarm  and control  contacts  -  including  a  global  alarm;  prepare  cold  start;  force  redundant
Router Module takeover.

AES connector panels - for front-mounted AES3 I/O modules.

5* Cooling Fans - hot-pluggable and easily accessible.

* The figures above are for the Nova73 HD. For more details on the Compact core, see the Nova73
Compact Appendix.
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DALLIS I/O

Front View

Rear View

The I/O capabilities of the system are expanded by adding DALLIS unit(s). Each may be either 3RU
(shown above) or 6RU in height, and may be remote from the rest of the system.

The front of the frame houses the:

DALLIS  Master  Boards  -  two central  slots  are provided for  a  main and redundant  master
board.  A  choice  of  board  types  provide  connection  to/from  the  Nova73  via  MADI,  ATM  or
RAVENNA, see DALLIS Interface Options.

The type of DALLIS master board, and hence the connection, determines the maximum
number of audio channels to/from the Nova73: up to 60 (MADI), 80 (ATM) or 128
(RAVENNA).

DALLIS I/O cards - 18 slots are available for a range of I/O breakout options (Mic/Line, Line,
AES, SDI, GPIO, etc.), see DALLIS Interface Options.

All cards are hot plug-able, with the exception of Phantom Power.

The rear of the frame provides access to:

Main and redundant power supplies 

Alarm and control contacts - including a local DALLIS alarm.
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Local I/O

The  MKII  mc256  control  surface  includes  an  integrated  local  I/O  board.  This  provides  dedicated
connections for local devices such as monitoring, metering, talkback and headphones.

(Note that on the classic mc256, similar functionality may be provided via an external DALLIS.)

All local I/O connections are accessed from the control surface rear panel:

The local I/O provides:

16 Line In - wired to 2 x DSub (female). 

Note that Line In 16 may be fed from the integrated talkback mic preamp, according to the jumper
switch positions set for the Local I/O.

16 Line Out:

o Line Out 1-8 - wired to 8 x XLR (male). By default, these outputs are routed from the CRM
1 monitor output.

o Line Out 9-16 - wired to 1 x DSub (male).

8 AES3 In - wired to 2 x DSub (female). 

8 AES3 Out:

o AES3 Out 1-4 - wired to 4 x XLR (male).

o AES3 Out 5-8 - wired to 1 x DSub (male).

Note that AES IN 5-8 and AES OUT 5-8 connect to the RTW meter, if either of the TM 7 or TM 9
Overbridge options are fitted.

8 GPIO - wired to 2 x DSub.

2 Stereo Headphones  -  wired to  the headphone 1 &  2 connectors  on the console's  front
buffer.

1 MADI or 1 RAVENNA - the local  I/O  board is  available  in  two versions,  connecting to  the
Nova73 via either MADI or RAVENNA (see Local I/O Connection). You will need to reserve one
MADI, or one RAVENNA, port within the Nova73 for this connection.

Please see Local I/O Wiring for more details on wiring, pin-outs and jumper switch options.
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Redundancy

One of  the strengths  of  the  mc²56  MKII  is  its  ability  to  withstand  component  failures,  and  every
component is designed with fault tolerance in mind:

Star2 Technology

Link & Port Redundancy

Nova73 & DALLIS Power

Redundant DSP

Control System

Redundant Router Module and Control System

Control Surface Power

Control Surface Internal Wiring
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Star2 Technology

All components within the system utilise Lawo’s Star2 technology:

Point-to-point connections – with point-to-point connections, a fault only affects that part of
the system, unlike a TDM bus architecture where a fault may disrupt everything connected to
the bus! 

Dual  star  topology –  with  redundant  Router  Modules  fitted  to  the  Nova73,  and  redundant
Master Boards in every DALLIS, then components connect in a dual ‘star’ mode. This protects
signal paths from any single point-of-failure. See Link & Port Redundancy.

Hot-swappable Modules/Cards – every plug-in module or card can be hot-swapped without
affecting the rest of the system enabling online maintenance of the system.

Redundant  Power  Supply Units  –  both Nova73 and DALLIS  units  can be fitted  with  dual
redundant power supplies, which can be isolated and exchanged from the front  or  rear.  See
Nova73 & DALLIS power.

Passive  backplanes  –  the  frame  backplanes  are  entirely  passive.  With  no  active
components, this increases reliability.
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Link & Port Redundancy

For crucial interconnections  between DALLIS  and Nova73 units,  you can specify either  link,  or  link
and port, redundancy:

Link Redundancy – two physical connections (MADI, ATM or RAVENNA) are made from the
DALLIS master board to the Nova73. If the active link fails, then the redundant link ensures an
automatic recovery. 

Link &  Port  Redundancy -  two master  boards  are fitted to  each DALLIS,  and  connect  to
different Nova73 ports (preferably on a different module). Port redundancy provides automatic
recovery from a:

o Failure of the active physical link (MADI, ATM or RAVENNA).

o Malfunction of the active DALLIS master board.

o Malfunction of the Nova73 module.

To specify link redundancy:

MADI - order a double-port Nova73 module and DALLIS master board for each connection.

ATM  -  order  a  double-port  Nova73  module  and  two  DALLIS  master  boards  for  each
connection.

RAVENNA - install both the copper and fibre optic connections from the RAVENNA module /
master board.

To specify link & port redundancy:

MADI,  ATM or  RAVENNA -  order  two  master  boards  per  DALLIS  plus  enough  single-port
Nova73  modules  to  support  the  connections.  AdminHD  configures  which  ports  provide
redundancy.
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Nova73 & DALLIS Power

Nova73 HD front view Nova73 Compact front view

DALLIS internal view of PSUs

The Nova73 HD, Nova73 Compact and DALLIS provide two slots for dual redundant power supplies,
see Nova73 power and DALLIS power. Their status may be monitored from  the console GUI using
the Signal Settings display.



mc²56 MKII Technical Manual V4.24/1 17

Chapter 1: Technical Overview
Redundancy

Redundant DSP

Within the Nova73 a DSP board may be reserved to provide redundant processing (indicated by the
STANDBY LED).

In the unlikely event of a failure, the system automatically switches  all  DSP resources  and settings
from the faulty board to the spare; the faulty board may then be safely removed and replaced.

This  option is  enabled from  the console GUI  using the DSP Configurations  display,  and is  saved
within the production.
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Control System

The control system resides on the Router Module MKII (980/33)
within the Nova73. 

It runs on an embedded Linux operating system  for  speed and
increased reliability, and stores both the application software and
user data.

The Router Module MKII (980/33) contains a backup
power unit which provides up to 3 seconds of backup
power to deal with short interruptions to mains (AC)
power.

Warm Start & Cold Start

Following switch-off, power is  provided to  the control  system  for  a  further  18 seconds.  During this
time, all current settings are saved to flash memory; this is known as the system's warm start data.

By default, the warm start data is loaded at the end of boot-up. This means that the console comes
back  exactly  as  it  was  when  you  last  shut  down,  ensuring  fast  recovery  of  all  previous  settings
following a loss of power.

Alternatively, you can perform a cold start if you suspect a problem with the warm start data.

Data Recovery

Two flash cards are used to store the application software (System Flashcard) and user data (Data
Flashcard)  separately.  You  may  create  a  backup  copy  of  the  flashcards  so  that  they  may  be
replaced if necessary.

During operation, any errors generated by the control system are stored in the message
logfile. This can be copied to USB via the File display, or monitored remotely via the Web
Browser Interface.
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Redundant Router Module and Control System

By  fitting  a  second  Router  Module  to  the  Nova73,  the  system  can  provide
redundancy for the routing matrix and control system.

In  order  to  provide  redundancy,  your  Nova73  must  be  fitted  with  two  Router
Modules  MKII;  Ethernet  A  and  Ethernet  B  connections  from  both  the  main  and
redundant modules are required:
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Automatic Takeover

If the main Router Module fails, then the redundant module automatically takes over. This ensures a
seamless recovery without any interruption to operation. 

Note that a brief interruption to audio will occur while routes are reconfigured.

The redundant control system is automatically activated if, internally, a loss of connection is noticed
by the redundant  system.  This  could be due to  a software failure,  hardware error  or  reboot  of  the
main control system. 

If the Ethernet connection between the control  surface and Router  Module fails,  then an automatic
takeover does not occur, as the failure may be deliberate (for example, if you disconnect the cable).

Instead the operator is presented with an error message:

1. Click on the message and a confirmation pop-up appears:

2. Select Yes to switch to the redundant control system or No to cancel.

Selecting Yes causes an interruption to the audio.

If you select No, then you MUST fix the problem with the connection before you can regain control of
the audio.
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Manual Takeover

You  can  force  a  manual  takeover  at  any  time,  using  the  Redundancy  takeover
option in the System Settings display:

1. Select the Global topic followed by the Redundancy takeover option.

A confirmation dialogue box appears:

2. Select Yes to confirm or No to cancel the operation.

Selecting Yes switches to the redundant control system.

Alternatively, press the Module Takeover button on the front of the redundant Router Module.

A manual takeover may also be forced using the ROUTER TAKEOVER contact,
connected to GPI 1 on the Nova73 rear panel, see Nova73 Alarm & Control Contacts.
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Control Surface Power

Control surface power is  provided by internal  power  supplies.  Depending on the frame size,  either
one or  two PSU blocks  are fitted to  each frame.  Each block is  equipped with  two power  supplies
running in parallel. Both share the current  load;  if  one fails,  then the second is  powerful  enough to
handle the required load alone.

Power Supply Desk Alarm

From Version 4.8 software onwards, the Central GUI offers status monitoring for all PSU blocks fitted
to the control surface.

The status of each PSU block is represented by a symbol which appears at the bottom right of every
console display:

The number of symbols relates to the number of PSU blocks within the control surface and whether
any extender bays with their own PSU are fitted. PSU blocks are represented from  left  to  right,  and
each block consists of two supplies running in parallel. 

The symbols indicate:

Green Circle – the PSU block is working fine.

Yellow triangle with an exclamation mark – the PSU block is working fine, but there was a
fault in the past which has now been cleared. Click on the icon to reset it.

Red circle with an exclamation mark – there is a fault.

Hover over the symbol to reveal more information:

Our example shows the status for Bay 1 - the first bay on the left of the console.

Note that within the text on the GUI, bays are counted from BAY 1 upwards. However,
internally bays are addressed from 0. This means that BAY 1 on the GUI relates to an
internal Bay Server address of 0, BAY 2 to an internal address of 1, and so on.
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Control Surface Internal Wiring

Within  each channel  and  central  bay,  individual  panels  and  displays  connect  to  an  Ethernet  Bay
Server. (Control surface panels via USB; displays via LVDS for high resolution graphics and USB for
touch control).

Each Bay Server then connects to an Ethernet switch, mounted inside the control surface frame. The
network connection from the switch appears on the rear panel as ETHERNET A. 

By fitting a redundant Router Module to the Nova73, a second Ethernet A connection can be installed
for automatic redundancy.

Internally, point-to-point connections provide fault tolerance, and allow any bay or panel to be isolated
from the rest of the console.

Control surface panels and displays are hot-pluggable making them easy to service.
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Sample Rate & System Clock

Internal Sample Rate

The system may operate at a choice of internal sampling rates including 96kHz, 88.2kHz, 48kHz and
44.1kHz. 

The maximum  sample rate (96kHz  or  48kHz)  is  set  by the AdminHD  configuration and cannot  be
modified from the console. (AdminHD: the maximum sample rate is defined when you select the type
of Nova73 Core). 

Having configured the maximum rate, you may use the Sample rate option, in the System Settings
display, to change from 48kHz to 44.1kHz, or from 96kHz to 88.2kHz, 48kHz or 44.1kHz.

System Clock (Sync Reference)

The Nova73 offers  a  fully  redundant  clock source structure with  two independent  clock  inputs,  an
internal  sync  generator  and the ability  to  lock to  sync  from  an incoming multi-channel  signal.  This
allows the console to be clocked from a variety of  sync  sources  and recover  from  loss  of  external
sync.

External sync connections are located on the Nova73 rear panel.

The sync signal priorities are defined using the Wordclock options in the System Settings display.
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Networking I/O Resources

The mc²56 MKII console is just one member of the mc2 family of  products,  which utilise the same
Nova73 and DALLIS architecture, and run on the same operating system and application software. 

The Nova73 and DALLIS system is available in its own right as a stand alone routing matrix. Multiple
systems may be networked to provide sharing of sources and destinations:

In  the example above,  mics  are physically connected,  via  a  DALLIS,  to  each  system.  Signals  are
transferred between systems via ‘Netlinks’, providing the ability to share any mic input. 

Each ‘Netlink’ is  an audio connection which may be MADI, RAVENNA, ATM, AES or analogue audio,
and signals are dynamically allocated as each operator makes routes from the Signal List display.

Any number  of  sources  may be distributed depending on the physical  limitations  of  your  network.
Please consult your system specification for details.

On any console within the network, you can view which sources are distributed from the % column
on the Signal List display:

 indicates  that  a  source  is  connected  locally  to  this  console,  and  is  ‘Shared’  (made
available) to other consoles within the network.

 indicates  that  a  source is  ‘Imported’.  In  other  words,  it  is  not  connected  locally  to  this
console.

From version 4.0.2.2 onwards, all Lawo products have adopted a consistent software
release numbering system to indicate compatibility. In each case, the first three digits of
the software version must match. 

So, for example, a mc266 console running version 4.20.2.0 can be networked to a mc256,
mc290 or Nova73 running 4.20.2.x.  You can check the software version of your mc2

system from the Global Options in the System Settings display.
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Nova73 HD Dual Self-Healing Star

The Nova73 HD can be implemented in a dual star topology to form a self-healing architecture where
one Nova73 is active and the other passive. In the case of a component failure, the system switches
to the redundant signal path. This type of system is known as the Dual Self-Healing Star:

Please see the "Nova73 MKII Technical Manual" for more details.
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Configuration

The mc²56 MKII can be customised by operators, technicians or Lawo personnel as follows:

Custom Functions

Functions  such  as  user  buttons  can  be  re-assigned  from  the  console  GUI  using  the  Custom
Functions display:

Custom functions are stored at a lower level to productions. This means that any changes will affect
all users.

AdminHD

At a lower  level  (not  accessible  from  the GUI)  are a number  of  files  which configure the system’s
hardware and define settings such as the sampling frequency, and the organisation of signals within
the  Directories  and  Subdirectories  of  the  Signal  List  display.  The  AdminHD  configuration  is  an
essential part of the system. If a hardware component is not defined within the configuration, then it
will  not  be visible  to  you even if  it  is  powered and connected.  In  other  words,  the  configuration  is
always the ‘master’ of the system, regardless of what physical components are added or removed.

The configuration is not designed to be changed by an operator, but can be edited by your systems
engineer using a software application called AdminHD. For example, if a DALLIS stagebox is hired in
for a production, then the unit must be added to the configuration and uploaded to the system before
the signals and parameters become available to the operator.

TCL Functions

At a lower level than AdminHD, a number of other options may be factory-configured using TCL (Tool
Command Language). TCL functions can only be programmed by Lawo personnel, and are designed
to provide some flexibility at the specification stage. TCL allows  the logical  interlinking of  GPIs,  soft
keys  and events.  For  example,  tally  states,  automated input  allocation and fader  starts  can  all  be
programmed using this protocol. Console monitoring is also handled by the TCL protocol.



V4.24/128 mc²56 MKII Technical Manual

Chapter 1: Technical Overview
System Options

System Options

The principle  system  components  offer  a  number  of  options  which define the layout  of  the control
surface, the modules fitted to the Nova73 and the cards fitted to each DALLIS. For details see Control
Surface Options, Nova73 Module Options and DALLIS Interface Options.

In addition, the following features may be installed, or configured, to provide further integration with the
production environment:

mxGUI - a Lawo software programme which runs on an external computer to provide offline
setup or  remote operation of  any mc2  system.  mxGUI is  covered  in  the  "mc²56  Operators
Manual".

AdminHD (& ControlHD) - a Lawo software programme which runs on an external computer
to provide system configuration or remote operation of  matrix crosspoints,  signal  labels  and
IO parameters. See AdminHD.

Audio  Follow Video (AFV)  -  the console supports  up  to  128  external  events  to  open  and
close any channel or main fader. AFV events are factory-configured, and received via TCP/IP
Ethernet (using Lawo's Remote MNOPL protocol)  or  GPIO.  Please contact  your  local  Lawo
representative or email service@lawo.de for more details.

General Purpose Channels (GPCs) - the console supports up to 256 GPCs which may be
used to  remotely control  parameters  within  an external  device via  MIDI.  The assignment  of
GPC  objects  to  MIDI  program  changes  and  controller  values  is  factory-configured.  Please
contact your local Lawo representative or email service@lawo.de for more details.

Plugin Server  -  the optional  LAWO  Plugin Server  allows  plugins  to  be controlled from  the
mc2 console, and all settings to be stored and recalled by a production or snapshot. See the
"Lawo Plugin Collection Operators Manual", and the “Plugin Server Technical Documentation”
for details.

Remote MNOPL - Lawo’s  Remote MNOPL protocol  is  a  freely available  Ethernet  (TCP/IP)
protocol providing control of virtually any system parameter from an external device. A typical
application is to provide third-party matrix control from external systems such as VSM, Evertz,
Quartz, BFE, Pharos and others. See AdminHD: mapping tables.

Remote  Desktop  -  any  of  the  console’s  TFT  displays  (Channel  or  Central  GUI)  may  be
switched to a remote server in order to view and control other applications. The server running
the desktop must be connected to the Lawo system network. The remote desktop function is
programmed from  the  console  GUI,  using  the  Custom  Functions  display,  see  the  "mc²56
Operators Manual".

Lawo Remote App - is  a free App which allows you to operate any fader  of  a  mc²  console,
recall snapshots and control  user-defined functions  remotely from  an iPhone,  iPod or  iPad.
The Lawo Remote App is covered in the "mc²56 Operators Manual". For details on configuring
the wireless network access point, see the “TD_AccessPoint.iApp” guide.

Machine  Control  -  the  optional  Recording  Com  Kit  provides  Sony  9pin,  LTC  and  MIDI
connections to an external  playback device.  The operation of  machine control  is  covered in
the "mc²56 Operators Manual".

Networked  Resources  -  for  more  information  on  configuring  'Netlinks'  to  share  audio
resources  between  systems,  please  contact  your  local  Lawo  representative  or  email
service@lawo.de

mailto:service@Lawo.de
mailto:service@Lawo.de
mailto:service@Lawo.de
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Web Browser  Interface  -  the control  system  includes  an  integrated  web  server,  allowing
status  information  to  be  monitored  from  an  external  computer,  see  the  Web  Browser
Interface.

Dial-up Router - this option may be installed to provide remote 'dial-up' maintenance from the
Lawo  service  department.  Please  contact  your  local  Lawo  representative  or  email
service@lawo.de for more details.

mailto:service@Lawo.de
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Chapter 2: Installation

Introduction

This chapter deals with installing the hardware components, connecting up the system and powering
on:

Installing the Nova73

Installing the DALLIS Unit(s)

Installing the Control Surface

System Connections

Powering On & Checking the System

System Settings

The ““mc2_Nova73_documentation” guide contains mechanical drawings, data sheets and
further information on all control surface, Nova73 and DALLIS components. The guide is
included with the "CD_mc2_56_X-XX-X-x" software release, available from the
Download-Center after logging in at www.lawo.de.

http://www.lawo.de
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Installing the Nova73

Both the Nova73 HD and Nova73 Compact core are designed to be mounted in a 19” rack.

All plug-in connectors are located at the front or rear of the unit. Therefore, when using 19’’ racks with
front doors please leave enough room for the cables.

Cables plugged into the front of the unit can be ducted backwards underneath the unit for distribution
within the rack.

Warning

Use the rack-rails supplied to mount the Nova73. The 19” frame MUST NOT carry the
complete weight of the unit.

Dimensions and Weight

Frame: Nova73 HD Nova73 Compact

Width 19”

483mm (front plate)

440mm (chassis)

Height 10RU 7RU

Cable Duct 1RU below the frame is required for cable ducting and ventilation.

Depth (including rear
connectors and system
locking devices)

510mm 489mm

Weight 16.25 Kg (one PSU fitted)

Each PSU weighs 4.25 Kg

14.5 Kg (two PSUs fitted)

Each PSU weighs 2.86 Kg

Ambient Conditions/Air Conditioning

Proper operation of the Nova73 can only be guaranteed at  an ambient  temperature between 10°  C
and 35° C and a relative humidity between 15% and 85% (not condensing).

When the Nova73 is out of action, it can be stored at a temperature between 0° C and 40° C and a
relative humidity between 10% and 85% (not condensing).

The Nova73 is cooled actively by built-in fans. The housing of the Nova73 is perforated at the top and
at the bottom to guide air flow in and out of the unit; the air stream is guided from bottom front to top
rear. Ensure that the cooling air stream is guided to cool the unit efficiently.

The air-flow  rate depends  on the mounted components.  To calculate the air  conditioning required,
assume a maximal air-flow rate of approximately 200 m³/h.

The life  cycle  of  a  fan is  typically 70.000 operating hours  (at  a  maximum  ambient  temperature  of
40° C). For details on how to change a fan, see Nova73 fan replacement.

Warning

Take care that no devices or cables obstruct the flow of air thereby hindering cooling.
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Nova73 HD Frame (980/02)

Frame 980/02, front view 

Frame 980/02, side view 
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Nova73 Compact Frame (980/06)

Frame 980/06, front view 

Frame 980/06, side view 
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Grounding

Although operator protection is guaranteed (the Nova73 is connected via the IEC Power Connectors
to  the  ground  of  the  power  supply  system)  it  is  best  to  establish  an  additional  ground  for  EMC
reasons. 

1. Fasten the grounding cable to  the CASE  grounding bolt  (M4 x 8)  on the Nova73 rear  panel
using a Torx driver:

Warning

The Nova73 must be on the same potential as all other system devices/modules.

For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the
device from being grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AES3, digital interfaces should be connected to a field ground.
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Power

Nova73 HD front view Nova73 Compact front view

The front  of  the  Nova73  frame  offers  two  slots  for  the  installation  of  power  supply  units.  On  the
Nova73 HD, the second PSU is optional. The Nova73 Compact is always installed with two supplies.

To operate the Nova73, one PSU is sufficient. When a second PSU is fitted for redundancy, the load
is shared between the two supplies.

The PSUs are hot pluggable. For details on how to change a PSU, see Nova73 PSU replacement.

Warning

All devices MUST be connected to the mains using the three-cord power leads supplied
with the system.

When running with two mains supplies (PSU 1 and PSU 2), make sure that both circuits lie
on the same ground potential. Otherwise, an internal bridge of two ground wires will lead to
a ground loop!

For air conditioning reasons, both PSU slots MUST be occupied when the Nova73 is
operational:

Nova73 HD:  if  only  one  PSU  is  installed,  then  please  fill  the  empty  slot  with  a
dummy plate (Type 980/21). 

Nova73 Compact: leave both PSUs in the frame until a replacement can be fitted.
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Power Consumption

The power  consumption of  the Nova73 varies  from  a minimum  of  60W  to a maximum  of  1000W,
depending on the voltage and the amount of modules and PSUs fitted.

Electrical Voltage

Nova73 HD Frame PSU Specification

980-25 (1000W Power Supply) Input: 100-240 VAC (PFC)/ 47–63 Hz/ max. 13,5 A

Output: 48 VDC / 23 A

980-22 (600W Power Supply) Input: 100-240 VAC (PFC)/ 47–63 Hz/ max. 8,2 A

Output: 48 VDC / 13 A

980-21 (Dummy Plate) n/a

Nova73 Compact Frame

980-27 (500W Power Supply) Input: 100-240 VAC (PFC)/ 47–63 Hz/ max. 5,5 A

Output: 48 VDC / 10,5 A
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Plug-in Modules and Connector Panels

Normally the Nova73 is delivered with the plug-in modules and rear connector panels fitted within the
chassis. However, if you need to fit additional cards or re-arrange the layout, follow these instructions.
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AES3 Rear Connector Panels

 Nova73 HD

Optionally, the Nova73 HD may be fitted with D-Sub and/or BNC AES3 rear connector panels. These
provide connections for any front-mounted AES3 modules (of type 981/02). The two panel types may
be mixed allowing up to 8 rear connector panels:

D-Sub, 8HP (980/14) - AES3, balanced 

BNC, 16HP (980/15) - AES3-id, unbalanced 

See Nova73 Rear Connector Panels for pin-out information.

The position of the rear connector panels determines the slot numbers which MUST be
used for front-mounted AES3 modules. Therefore, it is important to fit the rear panels
BEFORE mounting any plug-in modules.

1. Establish the first free slot (seen from the right) at the rear of the frame.

2. Remove the existing dummy plate if fitted.

Note that dummy plates are 8HP wide. If you want to mount a connector panel with a width of 16HP
you will need to remove two dummy plates.

3. Position the connector panel so that the inscription is legible!

4. Fasten the connector panel with its 4 screws.

5. Repeat for every connector panel/dummy plate.

Warning

Where no connector panels are required please cover the rear of the frame with dummy
plates of the type 980/13.



mc²56 MKII Technical Manual V4.24/1 39

Chapter 2: Installation
Installing the Nova73

 Nova73 Compact

The  Nova73  Compact  comes  with  rear-mounted  AES3  connectors  as  standard.  These  provide
balanced  D-Sub connections  for  up to  two  front-mounted  AES3  modules  (of  type  981/02).
Note that the AES3 modules MUST be fitted to slots 2 and 6 at the front of the core.

See Nova73 Rear Connector Panels for pin-out information.
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Front Module Slots

The diagrams above show the front module slots available within the Nova73:

Slot A – fit the main Router Module here.

Slot B – reserved for a redundant Router Module. 

Slots  1-16*  –  available  for  DSP  or  I/O  modules.  (*10  slots  are  available  for  DSP  or  I/O
modules in the Nova73 Compact core).

See Nova73 Module Options for details on all plug-in modules.

Note  that  the  Nova73  will  only  work  once  slot  A  is  fitted  with  a  Router  Module.  When  fitting  a
redundant Router Module, it must be of the same type fitted to slot A.

Note that the system logfile counts slots from 0 upwards (e.g. physical slot 1 = slot 0 in the logfile).

To ensure efficient cooling, you should spread the modules evenly within the Nova73.

Not every I/O or DSP module can be used in every slot so it is best to check your
configuration within AdminHD before fitting the physical modules.

One MADI, or ATM, port is required to provide the Port DSP resources used for the
console's monitoring (Listen surround and Listen stereo). Therefore, you must fit at
least one MADI, or one ATM, module to the Nova73.
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AES3 Modules

In the Nova73 HD, modules of type 981/02 AES3 should be mounted so that they are right-aligned to
the rear connector panel position (looking from the front of the frame). For example, if the 1st and 2nd
rear  connector  panels  (working  from  right  to  left)  are  D-Sub  and  the  3rd  is  BNC,  then  the  AES
modules must be front-mounted in slot 2 (D-Sub1), slot 4 (D-Sub2) and slot 8 (BNC).

In the Nova73 Compact core, AES3 modules MUST be mounted in slots 2 and 6.

If a module has been fitted incorrectly, then you may see its AES3 LOCK 1 LED blink.

DSP Modules

DSP modules of type 983/02 or 983/03 should be mounted from right to left filling up the odd slots -
15, 13, 11, 9, 7, 5, 3, 1 in the Nova73 HD or 9, 7, 5, 3, 1 in the Nova73 Compact core.

The logical numbering of the DSP boards follows the mounting order described above (DSP board 1
in slot 15, DSP board 2 in slot 13, etc.):
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>> Mounting the Front Modules

Warning

The Nova73 plug-in modules carry highly sensitive electronic components, and therefore
should only be handled by authorized personnel, and with the utmost care. 

ALWAYS observe the following procedures:

1. Discharge yourself before touching a plug-in module.

2. Wear  conductive safety-shoes  and grounding wristbands  to  reduce the risk of  electrostatic
charging.

3. DO NOT bend the modules.

4. Make sure that all rear connector panels are mounted before inserting the respective plug-in
module.

5. To remove an existing module, unfasten the front panel screws, release the locking catches
(as shown below) and pull out the module.

Some  modules  include  DIP  switches  to  set  certain  features.  Therefore,  check  the  DIP  switch
settings before inserting a replacement! Further information can be found in the data sheet, available
in the "mc2_Nova73_documentation" guide.

6. When fitting a module, make sure that it glides smoothly into the top and bottom guide-rails:

When fitted correctly, it will lock into place.

7. ALWAYS fasten the front panel screws in order to fix the module in place. This protects  the
operator from contact with live parts; protects the module from being pulled out unintentionally; and
reduces the emission of electro-magnetic radiation.

Tighten  the  screws  carefully  to  a  maximum  torque  of  0.25  Nm;  we  recommend  using  a
dynamometric screwdriver.

8. When you have fitted all  the plug-in  modules  for  your  system,  close  any  empty  slots  with
dummy plates.
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Installing the DALLIS Unit(s)

Each DALLIS is designed to be mounted in a 19” rack and comes in a choice of frame heights: 3RU
or 6RU.

All  plug-in  connectors,  with  the exception of  power  and alarm,  are located at  the  front  of  the  unit.
Therefore, when using 19’’ racks with front doors please leave enough room for the cables. 

Cables plugged into the front of the unit can be ducted backwards underneath the unit for distribution
within the rack.

Warning

Use the rack-rails supplied to mount the DALLIS. The 19” frame MUST NOT carry the
complete weight of the unit.

Dimensions and Weight

DALLIS: 3RU Frame 6RU Frame

Width 19”

483mm (front plate)

440mm (body)

19”

483mm (front plate)

440mm (body)

Height 132.5mm 265mm

Cable Duct 1RU below the frame is required
for cable ducting and ventilation.

1RU below the frame is required
for cable ducting and ventilation.

Depth (of unit) 433mm 433mm

Weight (without cards) 7.15 Kg 11 Kg

Ambient Conditions/Air Conditioning

The DALLIS requires a constant air stream with a maximum exhaust air temperature of 32° C. Thus
installation in a 19” rack is recommended.

The housing of the DALLIS is perforated at the top and at the bottom to guide air flow in and out of the
unit. Ensure that the cooling air stream is guided to cool the unit efficiently.

To calculate the air conditioning required, assume a power consumption of 200 Watts.

Warning

ALWAYS leave 1 RU below the DALLIS frame for ventilation and cable ducting. Take care
that no devices or cables obstruct the flow of air thereby hindering cooling.

ALWAYS observe the minimum distances at the front and rear of the unit to allow for
ventilation and cable ducting.
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Minimum Distances for DALLIS Installation
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3RU Frame (940/30)

Frame 940/30, front view

Frame 940/30, rear view

Frame 940/30, side view
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6RU Frame (940/60)

Frame 940/60, front view

Frame 940/60, side view
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Grounding

Although operator protection is guaranteed (the DALLIS is connected via the IEC Power Connectors
to  the  ground  of  the  power  supply  system)  it  is  best  to  establish  an  additional  ground  for  EMC
reasons. 

1. Fasten the grounding cable to the M4 CASE grounding bolt on the rear panel:

Warning

The DALLIS must be on the same potential as all other system devices/modules.

For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the
device from being grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AES3, digital interfaces should be connected to a field ground.

For  connecting  microphones,  guide  the  ground  connection  from  the  DALLIS  to  the  microphone
directly via the cable shielding, otherwise phantom power cannot be transferred.  Take care that  the
shielding does not lie on the field  ground.  This  way you will  prevent  interference and loss  of  signal
quality.
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Power

DALLIS rear view DALLIS internal view

Depending  on  your  system  specification,  each  DALLIS  may  be  delivered  with  single  or  dual
redundant power supply units (PSUs). 

When a redundant PSU is fitted (type 940/16), the load is shared between the two supplies. 

The PSUs are hot pluggable. For details on how to change a PSU, see DALLIS PSU replacement.

Warning

All devices MUST be connected to the mains using the three-cord power leads supplied
with the system.

When running with two mains supplies (PSU 1 and PSU 2), make sure that both circuits lie
on the same ground potential. Otherwise, an internal bridge of two ground wires will lead to
a ground loop!

Power Consumption

The power  consumption of  the DALLIS  varies  from  a minimum  of  70W  to  a  maximum  of  180W,
depending on the amount and type of I/O cards fitted, and whether there are dual power supplies.

Electrical Voltage

3RU frame, PSU specification:

Input: 100-240 VAC (PFC)/ 48-62 Hz/ 1.6-2 A

Output: 12 VDC / 8.3-11 A

6RU frame, PSU specification:

Input: 100-240 VAC (PFC)/ 48-62 Hz/ max. 2A

Output: 12 VDC / 11 A
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Plug-in Cards

Normally  the  DALLIS  is  delivered  with  the  plug-in  I/O  cards  and  master  boards  fitted  within  the
chassis.  However,  if  you need to  fit  additional  plug-in  cards  or  re-arrange  the  layout,  follow  these
instructions.
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Equipping the 3RU Frame

18 single  width DALLIS  I/O  card slots  are available  within  the 3RU frame.  Double width I/O  cards
(8GU) occupy two slots; single width I/O cards (4GU) occupy one slot.

Slot M1 – fit the main master board here.

Slot M2 – reserved for a redundant master board.

Slots 1-18 – available for I/O cards.

See DALLIS Interface Options for details.

Note  that  the  DALLIS  will  only  work  once  slot  M1  is  fitted  with  a  master  board.  When  fitting  a
redundant master board, it must be of the same type fitted to slot M1.

Note that the system logfile counts slots from 0 upwards (e.g. physical slot 1 = slot 0 in the logfile).

Not every interface card can be used in every slot. As a general rule, if an interface card is
permitted within AdminHD, then it can be fitted to your system.

The type of DALLIS master board, and hence the connection, determines the maximum
number of audio channels to/from the Nova73: up to 60 (MADI), 80 (ATM) or 128
(RAVENNA).
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Equipping the 6RU Frame

18 double width DALLIS  I/O  card slots,  plus  a single  width slot  reserved for  Phantom  Power,  are
available within the 6RU frame. Double width I/O cards (8GU) occupy the whole slot; single width I/O
cards (4GU) must be fitted on the left of the slot and a dummy plate fitted to the right to close the gap.

Slot M1 – fit the main master board here.

Slot M2 – reserved for a redundant master board.

Slots 1-18 – available for I/O cards.

Slot  19  –  reserved for  Phantom  Power.  If  specified,  fit  the  Phantom  Power  card  (947/10)
here.

See DALLIS Interface Options for details.

Note  that  the  DALLIS  will  only  work  once  slot  M1  is  fitted  with  a  master  board.  When  fitting  a
redundant master board, it must be of the same type fitted to slot M1.

Note that the system logfile counts slots from 0 upwards (e.g. physical slot 1 = slot 0 in the logfile).

Not every interface card can be used in every slot. As a general rule, if an interface card is
permitted within AdminHD, then it can be fitted to your system.

The type of DALLIS master board, and hence the connection, determines the maximum
number of audio channels to/from the Nova73: up to 60 (MADI), 80 (ATM) or 128
(RAVENNA).
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Mounting the Cards

Warning

To avoid any unpleasant clicks or pops, the system resets when a Phantom Power card is
replaced. Therefore, you should only replace a Phantom Power card when off air!

The DALLIS plug-in cards carry highly sensitive electronic components, and therefore
should only be handled by authorized personnel, and with the utmost care. 

ALWAYS observe the following procedures:

1. Discharge yourself before touching a plug-in card.

2. Wear  conductive safety-shoes  and grounding wristbands  to  reduce the risk of  electrostatic
charging.

3. DO NOT bend the cards.

4. To remove an existing card, unfasten the front panel screws and pull out the card.

Note  that  some  DALLIS  I/O  cards  include  DIP  switches  to  set  certain  features  of  the  cards.
Therefore,  when  replacing  cards,  check  the  DIP  switch  settings  before  inserting  the  new  card!
Further  information can be found in  the data sheet,  available  in  the  "mc2_Nova73_documentation"
guide.

Note also that the DALLIS master board provides a switch to set whether the board performs a cold
or warm start when powered on. You may need to set this switch to cold start to initialise the system.
For details please consult the relevant data sheet.

5. When fitting a new card, make sure that it glides smoothly into the top and bottom guide-rails. 

When fitted correctly, it will lock into place.

6. ALWAYS  fasten the front  panel  screws  in  order  to  fix  the card in  place.  This  protects  the
operator from contact with live parts; protects the card from  being pulled out  unintentionally;  and
reduces the emission of electro-magnetic radiation.

7. When you have fitted all the plug-in cards for your system, close any empty slots with dummy
plates (For single width slots use part number 940/31, and for double width slots use 940/33. Use
part number 940/32 to blank the second master board slot).



mc²56 MKII Technical Manual V4.24/1 53

Chapter 2: Installation
Installing the Control Surface

Installing the Control Surface

The console control surface consists of the:

Frame (available in a range of pre-determined sizes).

Stand (optional).

Console Keyboard (English or  German)  -  a  floating keyboard which may be connected to
any USB port.

Removable Script tray (optional).

The frame is designed for table-top mounting onto a cross bar (not supplied). Note that no separate
OB mounting kit  is  required,  as  mounting  threads  are  integrated  into  the  frame.  Alternatively,  the
control surface may be delivered with the optional stand.

All plug-in connectors are located on the rear panel. Therefore, when installing, please leave enough
room for the cables.

Extenders  require  their  own  power  and  grounding  connection,  and  connect  to  the  main  control
surface frame via Ethernet.

Please see control surface options for details on customisation options.

The ““mc2_Nova73_documentation” guide contains mechanical drawings, data sheets and
further information on all control surface, Nova73 and DALLIS components. The guide is
included with the "CD_mc2_56_X-XX-X-x" software release, available from the
Download-Center after logging in at www.lawo.de.

http://www.lawo.de
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Ambient Conditions/Air Conditioning

Proper operation of the control surface can only be guaranteed at an ambient  temperature between
10° C and 35° C and a relative humidity between 15% and 85% (not condensing).

To keep the control surface cool in extreme environments, the front panel is fitted with low noise fans.
A sensor within the console activates the cooling fans if the temperature rises above 30° C. 

At  temperatures  below  30°  C  the cooling fans  are  switched  off  permitting  installation  within  noise
critical environments. When relying on convection cooling, ensure that the unit’s  ventilation holes are
not blocked to allow air circulation.

Warning

ALWAYS observe the minimum distances around the console frame to allow for
ventilation and cable ducting.

Take care that no devices or cables obstruct the flow of air thereby hindering cooling.
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Dimensions and Weight

16+16C Studio Profile 16+16C Studio Overhead

Frame Size Part Number Studio Version OB Version

16C 959-09 Width:

Weight:

809mm

32.4kg

731mm

32.4kg

16+16C 959-10 Width:

Weight:

1319mm

47.3kg

1241mm

47.3kg

16+16C +16 959-11 Width:

Weight:

1829mm

62.6kg

1751mm

62.6kg

32+16C+16 959-12 Width:

Weight:

2339mm

80.6kg

2261mm

80.6kg

32+16C+32 959-13 Width:

Weight:

2849mm

96.3kg

2771mm

96.3kg

Extender (16-fader) 959-22 Width:

Weight:

601mm

23.1kg

523mm

23.1kg



V4.24/156 mc²56 MKII Technical Manual

Chapter 2: Installation
Installing the Control Surface

Minimum Distances & OB Van Mounting

Mechanical data for the Studio and OB version of the 16+16C frame are included here. You can find
similar data for other frame variations in the “mc2_Nova73_documentation” guide.

16+16C Studio Frame Installation
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16+16C OB Van Frame Installation
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Grounding

Although  operator  protection  is  guaranteed  (the  control  surface  is  connected  via  the  Power
Connectors to the ground of the power supply system) it is  best to establish an additional ground for
EMC reasons.

1. Fasten the grounding cable to the CASE grounding bolt (M5 x 12)  on the rear  panel  using a
Torx T25 driver:

Warning

The control surface must be on the same potential as all other system devices/modules.

For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the
device from being grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AES3, digital interfaces (connected to the Local I/O) should be connected to  a
field ground.
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Power

Control  surface  power  is  provided  by  internal  power  supplies,  and  the  power  consumption  is
dependent on the number of panels fitted to the surface.

Depending on the frame size, either one or two PSU blocks are fitted to each frame.  Each block is
equipped with two power supplies running in parallel. Both share the current load; if one fails, then the
second is powerful enough to handle the required load alone.

Each of the supplies connects to the mains via its own terminal.  Therefore,  it  is  possible  to  realise
phase redundancy if each terminal is connected to a different phase (see below).

Larger frames require two PSU blocks, and any frame extenders also require their own supply. 

The status of all PSU blocks may be monitored from the console GUI.

For details on how to change a PSU, see Control Surface PSU replacement.

Mains Connections

For each PSU block, two mains  connectors  (MAINS 1  &  MAINS 2)  are located on the rear  of  the
frame. Only one mains connection is essential for operation; the second provides redundancy. 

It is  recommended that MAINS 1 and MAINS 2 be run from  separate phases  of  the mains  supply,
and that  the same two phases  are used for  all  parts  of  the desk.  It  is  also recommended  that  all
power connections are controlled from a common mains switch.

Warning

All devices MUST be connected to the mains using the three-cord power leads supplied
with the system.

Make sure that ALL circuits lie on the same ground potential. Otherwise, an internal bridge
of two ground wires will lead to a ground loop!
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To unplug the MAINS cables, press the red button to unlock the IEC connector:

Power Consumption

The maximum power consumption, per mains connection, for a fully loaded frame is:

Current (max): 1.4 A to 3.4 A (depending on the voltage)

Power (max): 340 Watts

A control surface with fewer panels requires less current and power.

Due to the power supply inrush current,  no more than three PSU blocks  should be used per  16 A
circuit breaker.

Frame Spec & (Part Number) No. of PSU blocks per phase

16C (959-09) 1

16 + 16C (959-10) 1

16 + 16C + 16 (959-11) 1

32 + 16C + 16 (959-12) 2

32 + 16C + 32 (959-13) 2

16 Fader Extender (959-22) 1

Electrical Voltage

The specification for each PSU block is:

Input: 100-240 VAC (PFC)/ 47–63 Hz

Output: 13 VDC / 18 A (max)/ 234 Watts (max)
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Console Keyboard Driver

The console keyboard is available in either English or German; if you change the keyboard, then you
will  need  to  modify  the  driver  as  follows.  For  the  mc²56  MKII,  the  parameter  for  the  keyboard
language is saved on the GUI_0 Bay Server (inside the control surface).

1. Using a computer connected to the Lawo system network, open a telnet session to the mc²56
MKII control system, and remotely login to the GUI_0 control system.

Once logged in, you should see the GUI_0 control system prompt.

2. Type remountRW /dev/hdcl and press Enter.

This step changes the write protection for the keyboard configuration file directory, so that the file
may be altered.

3. Type cd  /media/hdc1 and press Enter.

This navigates to the correct directory.

4. Type joe keyboard and press Enter:

This step starts a text editor, called joe, and opens the keyboard configuration file.

5. To change the language version, type:

KEYBOARD=GERMAN (all capital letters), or

KEYBOARD=ENGLISH (all capital letters):

6. Close the editor and save the file by pressing CTRL + K + X.

The new driver is configured and will become active after the next reboot.

Note that the write protection of the keyboard configuration file is reset after the reboot.

You can reboot the control system from the telnet client by typing reboot and Enter.
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System Connections

The control  system  resides  on the Router  Module MKII (980/33)  within  the Nova73.  Therefore,  the
following essential connections are required to boot and test the system:

Ethernet A - connects the control surface to the Nova73 Router Module.

Control Surface Power - mains connections to the control surface frame.

Nova73 Power - mains connections to the Nova73.

All other connections, including those to/from DALLIS I/O units, may be made as and when required.

You may connect your external I/O to the:

Nova73 - see Nova73 Module Options.

DALLIS - see DALLIS Interface Options.

Local I/O (in the control surface) - see Local I/O.
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Ethernet A

This port connects the console control surface to the control system on the Nova73 Router  Module
MKII (980/33).

Connections  are made via  TCP/IP  Ethernet.  Only one connection (to  the active Router  Module)  is
essential for operation; the second is required if a redundant Router Module is fitted:

Use a straight (1:1) network cable (STP-CAT 5 with RJ45 connectors):

1. Connect either of the control surface ETH A ports  (on the rear  connector  panel)  to  the first
Nova73 Router Module.

On the control surface, you may use either port (ROUTER 1 or ROUTER 2).

On the Nova73, make sure you connect to ETHERNET A (and not ETHERNET B).

Control Surface Rear Nova73 Router Module MKII Front

2. If a redundant Router Module is fitted to the Nova73, then run a second network cable from the
spare  control  surface  port  (ROUTER  1  or  ROUTER  2)  to  the  redundant  Router  Module
(ETHERNET A).

This second connection is essential to support control system redundancy.

3. You may now power on to boot and check the system, or continue with the rest of the system
wiring.
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Ethernet B (System Network)

The ETHERNET B port, on the Nova73 Router Module MKII (980/33), connects the control system to
the rest of the Lawo system network. This connection supports various applications including:

Remote control from Lawo's mxGUI software.

Remote configuration from Lawo's AdminHD software.

Remote control from a third-party device via Lawo's Remote MNOPL.

Diagnostics  and  maintenance  from  the  Web  Browser  Interface,  Telnet
session, etc.

Control connections to other Lawo systems to support audio networking.

Remote  maintenance,  from  Lawo's  service  department,  via  the  dial-up
router.

Connections are made via TCP/IP Ethernet.

A single  device can  connect  directly.  However,  more  commonly,  a  network  switch  is  installed  to
support a wider system network.
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Network Connection

For a Direct Connection

Use a crossed network cable (STP-CAT 5 with RJ45 connectors):

1. Connect the device to the ETHERNET B port on the active Router Module MKII:

If a redundant Router Module is fitted, and a control system takeover is actioned, you will
lose your network connection. Therefore, a network switch is recommended.
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For a Connection via a Network Switch

Use a straight (1:1) network cable (STP-CAT 5 with RJ45 connectors):

1. Connect the device to the network switch.

And, if not already installed:

2. Connect the network switch to the ETHERNET B port on the Router Module MKII.

3. If a redundant Router Module is fitted,  then run a second network connection.  This  ensures
continued operation should a control system takeover occur:

Warning

You must use a network switch and NOT a hub.

Keep the Lawo network separate from other network traffic within the installation.

For  more  information  on  installing  a  suitable  network  switch,  please  contact  your  local  Lawo
representative or email service@lawo.de.

Depending on the number of network connections, one mc²56 MKII system is able to support up to 16
clients simultaneously

mailto:service@Lawo.de
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TCP/IP Configuration

To establish communication with the control system, you will need to configure the TCP/IP  settings
for your device’s network interface card.

The following screenshots demonstrate how to  do so on a computer  running Windows  7 and Mac
OS X:

Windows 7:

Mac OS X:

You can find further information from www.microsoft.com or www.apple.com.
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IP Address

The IP  address  of  your  device’s  network interface card must  be unique,  and  set  within  the  same
range as that of the mc²56 MKII control system.

You can check the IP address of your control system from the console GUI (using the Signal Settings
display). See also TCP/IP Addresses for a list of the default IP addresses for different Lawo products.

For example, to connect to a mc266 with a default IP address = 192.168.102.65, set your device's IP
address to 192.168.102.101.

In a networked installation, it is likely that you will be connecting via an Ethernet switch, so please
consult your network administrator for further details.

Take care when setting the IP address of your device. If there is an IP conflict within the
network, then the mc2 or Nova73 may not operate correctly.

Subnet Mask

The Subnet Mask of your device’s network interface card should be identical  to  that  of  the system.
For all products, the default Subnet Mask is 255.255.255.0.

Checking Network Communication

You can use AdminHD, mxGUI or the Web Browser Interface to check the network communication.
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Wiring from the Control Surface

Main Frame (Rear Connector Panel)

The principle connections come from the main control surface frame:

MAINS 1 & MAINS 2 - see control surface power. Only one mains connection is essential for
operation; the second provides redundancy. 

CASE - see control surface grounding.

ROUTER  1 &  ROUTER  2 (ETH  A)  -  see Ethernet  A.  Only  one  connection  (to  the  active
Router  Module)  is  essential  for  operation;  the second connection is  required if  a  redundant
Router Module is fitted.

ETH Extension x 2 (ETH A) - connect to extender frames.

MADI  &  RAVENNA -  one of  these ports  connects  the  local  I/O  board  to  the  Nova73.  The
connection  type  is  pre-determined  by  the  version  of  the  Local  I/O  board,  so  check  your
system specification for details.

TBK, LINE, AES &  GPIO  -  audio and GPIO  breakouts  for  the local  I/O,  see Local  I/O  and
Local I/O Wiring.
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Extender Frames

Extenders  require  their  own  power  and  grounding  connection,  and  connect  to  the  main  control
surface frame via Ethernet:

Use a straight (1:1) network cable (STP-CAT 5 with RJ45 connectors) to connect the extender to one
of the ETH Extension ports on the main frame.  If  more than two extenders  are fitted,  then a Fast
Ethernet switch is supplied.

If you are adding a new extender, then you may need to adjust the Bay Server address settings.

Main Frame (Front)

Note that a number of "user" connections are also available at the front of the console:

USB x 2 - on the Overbridge, to connect the console keyboard or a data memory stick.

XLR x 1 - on the Overbridge. This is the talkback mic connector.

Stereo Headphones x 2 - in the arm rest. The default monitoring configuration sets HP 1 to
follow  the CRM 1 monitor  source selector,  and HP 2 to  follow  CRM 2.  Note  that  on  larger
frames, two additional phones connectors (HP 3 & 4) operate in parallel with HP 1 & 2.

Ethernet x 1 - in the arm rest. Another network port for  connecting an mxGUI or  AdminHD/
service computer.
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Wiring from the Nova73

The Nova73 HD (shown below) and Nova73 Compact core provide identical connections:

Nova73HD Front View Nova73HD Rear View

Front Connections:

PSU 1 & PSU 2 - see Nova73 power.  Only one PSU is  essential  for  operation;  the second
provides redundancy. 

Router Module(s) MKII:

o ETHERNET A – connect to the control surface. 

o ETHERNET B – connect to the Lawo system network.

If two Router Modules are fitted,  then run Ethernet  A and Ethernet  B  connections  from  both the
main and redundant Router Modules.

MADI,  ATM  &  RAVENNA -  connect  to  DALLIS  units  or  external  I/O  devices.  See  Nova73
Module Options. One MADI or RAVENNA port must be reserved for the local I/O.

Rear Connections:

SYNCHRONISATION  Ports -  see External  Sync.  If  a  sync  reference is  not  connected,  or
invalid, then the system automatically switches to internal sync.

GPI 1 & 2, Global ALARM - see Nova73 Alarm & Control Contacts.

AES Breakout Connectors - see Nova73 rear connector panels.
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Wiring from DALLIS Unit(s)

Front View (3U frame)

Rear View (3U frame)

Front Connections:

DALLIS Master Board(s):

o MADI, ATM or RAVENNA - connect to the Nova73, see DALLIS  Interface Options.  If  two
master boards are fitted, then you may configure Link & Port Redundancy.

o CTRL, WCLK, SYNC - on some master boards, you will find additional connections for a
control computer and local sync.  Please refer  to  the relevant  data sheet,  available  in  the
"mc2_Nova73_documentation" guide. Note that external sync for the mc²56 MKII should be
made to/from the Nova73.

DALLIS I/O Cards - audio and GPIO breakouts, see DALLIS Interface Options.

Rear Connections:

PSU 1 & PSU 2 - see DALLIS  power.  Only one PSU is  essential  for  operation;  the second
provides redundancy.

ALARM & FORCE M2 - see DALLIS Alarm & Control Contacts.
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Nova73/DALLIS Interconnects

The type of master board determines how each DALLIS unit connects to the Nova73. There are three
possible options: MADI, ATM or RAVENNA:

MADI

AES10, multi-channel digital audio interface.

Connections are either multi-mode or single-mode fibre, depending on the master board type;
duplex-SC connectors:

o Multi-mode fibre: 62.5 / 125 µ m, 1300nm

o Single-mode fibre: 9 / 125 µ m, 1300nm

Up to 64-channels at 48kHz, or 32-channels at 96kHz, per port.

A minimum of 4-channels are used to transport Port DSP resources to/from the DALLIS.
This leaves up to 60-channels at 48kHz, or 28-channels at 96kHz, for plug-in I/O.

ATM

ATM, over STM-1, multi-channel digital audio interface.

Connections are either multi-mode or single-mode fibre, depending on the master board type;
duplex-SC connectors:

o Multi-mode fibre: 62.5 / 125 µ m, 1300nm

o Single-mode fibre: 9 / 125 µ m, 1300nm

Up to 80-channels at 48kHz, or 40-channels at 96kHz, per port.

RAVENNA

Ravenna Link 1.0, multi-channel digital audio over IP interface.

Two physical connections, per port, for standard CAT 5 Ethernet and optical fibre:

o CAT 5/6/7 Gigabit Ethernet, RJ45 connectors, crossed or straight (1:1) cable, up to 100m.

o Optical  transceivers  (SFPs)  can be installed for  multi-mode or  single-mode fibre.  These
must be Lawo-certified, see SFP Modules.

Up to  128-channels  at  48kHz,  and  96kHz*,  per  port,  for  DALLIS  interconnects.  (RAVENNA
supports 128/256-channels per port for non-DALLIS applications.)

* 96kHz RAVENNA is a future option.
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Connecting the RAVENNA Ports

RAVENNA links  should  be  directly  wired  to  the  corresponding  RAVENNA  port.  The  interface  is
completely self-configuring. Thus, once you have connected the ports (from your Nova73 to DALLIS),
no further network configuration is necessary.

Warning

To guarantee low latency, reliability and easy setup, do NOT connect any network
equipment between the two RAVENNA ports. 

When both copper and fibre are installed at start-up, fibre is the preferred medium. In either case, the
second medium can be hot-plugged without disturbing the current operating link. If a link breaks, then
the card automatically switches to the second medium (if installed) - note that there will be an audible
audio interruption until the automatic link/stream setup re-establishes the connection.

Close any unused optical connectors, with a protection plug, to avoid performance
degradation by dust or dirt.

For more details, see Service/Maintenance: RAVENNA Interfaces.
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External Sync

All external sync connections should be made to and from the Nova73 rear connector panel:

INPUT 1 & INPUT 2 - accept Wordclock, Video Black Burst (PAL or NTSC) or AES 3-id.

When running the system referenced to Wordclock, the frequency of the sync source 
MUST match the internal operating sample rate of the system.

The Nova73 supports only one video format at a time. Thus, if both inputs are supplied with
Video Black Burst, only signals of the same type can be used (either PAL or NTSC).

THRU 1 & THRU 2 - provide an output of the sync signals connected to INPUT 1 & INPUT
2. Note that the THRU ports provide a "looped-through" signal, and do NOT follow the system
clock selection.

Warning

If no further components are connected to the THRU ports, then it is essential to terminate

included in the delivery.

WCLK OUT - provides an output of the current system clock. This output follows the system
clock selection.

The sync signal priorities are defined using the Wordclock options in the System Settings display.

A star-like clock distribution, via a distribution amplifier, offers better signal quality and
should be preferred to that of passive daisy chaining.
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Nova73 Alarm & Control Contacts

Three alarm connectors appear on the Nova73 rear panel:

GPI 1 & GPI 2 - two 25-pin D-Sub connectors carrying various input and output signals.

GLOBAL ALARM - one BNC carrying the global alarm.

GPI 1 GPI 2

On both D-Sub connectors, you can pick up a short-circuit proof voltage feed (+5V, max
150mA).
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GPI Inputs

The GPI inputs are opto-couplers; accept voltages of 3V..20V; draw a typical current of 8 mA; and are
floating and galvanically isolated.

 GPI 1

GENERAL PURPOSE IN 1 & 2 –  used for  project-specific  applications,  please check your
system specification for details.

ROUTER  TAKEOVER  (IN)  –  use  this  input  to  force  a  takeover  to  the  redundant  Router
Module. The takeover is triggered by a positive edge at the input.

PREPARE COLDSTART (IN) – when turning on the Nova73, supply a voltage at this input to
force a cold start.

 GPI 2

ALARM IN 1 to 4 - may be used to monitor peripheral equipment such as devices from other
manufacturers. The inputs MUST be factory-configured. Each alarm is triggered by an applied
voltage.  When the input  is  open or  grounded,  the alarm  is  cancelled.  Within  the  AdminHD
configuration,  you can assign a text  error  message for  each input,  and  define  whether  the
input activates the global alarm. Predefined standards are:

o ALARM 1 IN = failure of the external clock supply (activates the global alarm).

o ALARM 2 IN = failure of the external power supply (activates the global alarm).

o ALARM 3 IN = failure of the external I/O system (activates the global alarm).

o ALARM 4 IN = the external device exceeds its operating temperature (activates the global
alarm).
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GPI Outputs

The GPI outputs  are relays;  output  a  maximum  of  30V /  500 mA;  and are floating and galvanically
isolated.

 GPI 1:

2nd ROUTER ACTIVE – this contact reports the activation of  the redundant  Router  Module
(closed status).

GENERAL PURPOSE OUT 1 & 2 – used for project-specific applications, please check your
system specification for details.

 GPI 2:

CTRL LIFE-WATCH – this is a project-specific  contact which can be used to report the loss
of a connection to another control system. Please contact your local  Lawo representative or
email service@lawo.de for more details.

PSU ALARM – this contact reports the failure of either of the Nova73 PSUs (closed status).

GLOBAL ALARM – this contact signals that the global alarm is active (closed status).

mailto:service@Lawo.de
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Global Alarm

The global alarm can be output by both the GLOBAL ALARM BNC and GPI 2 D-Sub connectors.

The global alarm status can also be monitored from the Web Browser Interface.

Global alarm errors are stored on the control system in the alarm.log system logfile.

The global alarm may be disabled by the AdminHD configuration (see Parameters: Core -> System
Settings).

When enabled, the global alarm is triggered when any of the following conditions are satisfied: 

Within the Nova73:

Malfunction of a Router module.

High temperature on a Router module – triggered if the temperature exceeds 45° C.

Too high or too low a voltage to a Router module.

Malfunction of an I/O module in the Nova73.

Malfunction of a PSU.

Malfunction of a fan.

Active external  control  input  –  the global  alarm  can be triggered by a control  input  from  an
external device (e.g. via GPI).

Internal sync (optional) - the the AdminHD configuration can set the global alarm to be triggerd
if the system switches to internal sync (see Parameters: Core -> Data).

From an I/O Port (e.g. DALLIS or external device):

If the port is not supplied with a valid signal.

Malfunction of a DALLIS master board.

Malfunction of a DALLIS I/O card.

Malfunction of a DALLIS PSU.
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DALLIS Alarm & Control Contacts

Three alarm connectors appear on the DALLIS rear panel:

ALARM FORCE M2 -15-pin D-Sub carrying the DALLIS local alarm and other signals.

FORCE M2 - BNC for the FORCE M2 control signal.

ALARM - BNC carrying the DALLIS local alarm.

ALARM FORCE M2 D-Sub ALARM FORCE M2 Block Diagram
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ALARM FORCE M2

The following contacts are accessible via the ALARM FORCE M2 (15-pin D-Sub) connector:

Force second masterboard M2 (Pins 14&15) – use this input  to  force a redundant  Master
Board takeover (if two master boards are fitted to the DALLIS). The takeover is triggered by a
positive edge at the input.

Alarm (Pins 7&8) – this contact signals that the DALLIS local alarm is active (closed status).

Alarm Inverted (Pins 5&13) – as above, but the status is inverted.

PSU 1 (Pins 3&11; Pins 2&10) – these contacts report the failure of PSU 1 (closed status).

PSU 2 (Pins 1&9) – this contact reports the failure of PSU 2, if fitted (closed status).

The two BNC connectors provide:

FORCE M2 – use this input to force a redundant Master Board takeover (as above).

ALARM – outputs the DALLIS local alarm.
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DALLIS Local Alarm

A local alarm for the DALLIS unit can be output by both the ALARM BNC and ALARM FORCE M2 D-
Sub connectors.

Note that some of the alarm conditions vary for DALLIS fitted with the RAVENNA master
board (947/21); the differences are highlighted in the second table below.

Local Alarm Output States for DALLIS fitted with 947/03, 947/13, 947/05, 947/07 and 947/15

Condition ALARM (BNC / D-Sub Pin
7&8)

ALARM Inverted (D-Sub
Pin 5&13)

No power closed open

1 card in left slot, booting closed open

1 card in left slot, no error present open closed

1 card in left slot, error present closed open

2 cards, booting closed open

2 cards, left no error, right no error open closed

2 cards, left error, right no error closed open

2 cards, left no error, right error closed open

2 cards, left error, right  error closed open

Local Alarm Output States for DALLIS fitted with 947/21

Condition ALARM (BNC / D-Sub Pin
7&8)

ALARM Inverted (D-Sub
Pin 5&13)

No power closed open

1 card in left slot, booting closed open

1 card in left slot, no error present closed open

1 card in left slot, error present open closed

2 cards, booting closed open

2 cards, left no error, right no error closed open

2 cards, left error, right no error closed open

2 cards, left no error, right error closed open

2 cards, left error, right  error open closed
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Powering On & Checking the System

For details on how to power on, see System Shutdown and Restart.

Once the system has booted, you can check that the status of all Nova73 and DALLIS components
by looking at the console’s Signal Settings display. If all modules and DALLIS units are installed and
operating correctly, then they appear in grey:

If any components are not installed or connected, then a red/white cross in  the System  tree,  and a
red highlighted card, shows the location of the problem. See Diagnosing System Errors.

You can also check the status LEDs on each unit’s front panel:

The  ACTIVE  LED  on  each  Nova73  module,  or  DALLIS  card,  should  blink  in  time  with  all  other
ACTIVE LEDs (at approximately 100Hz). This shows that the card is synchronous to the rest of the
system.  If  an LED  is  out  of  sync,  then check that  the card is  fitted correctly,  and  if  the  symptom
persists, replace the card.

See also trouble-shooting for a list of example problems and fault-finding tips.
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Diagnosing System Errors

In the event of a component failure, a hazard warning flag appears in the title bar of the Central GUI.
Note that this flag will appear at the top of any SCREEN CONTROL display, so you don’t need to be
viewing the Signal Settings display to monitor your system hardware:

1. Press  the SIGNAL button,  located on  the  SCREEN  CONTROL  panel,  to  view  the  Signal
Settings display:

A red/white cross in the System tree, and a red highlighted card, show the location the problem.

2. If the fault is hidden within the System tree, follow the red warning flags and open each branch
of the tree to find the problem – in our example, a DALLIS card.

3. Open the DALLIS card further, and you will see grey/white crosses beside Signal In 1, Signal
In 2, etc. These show that the AES signals are no longer available:

3. Check and replace the card if necessary. 

Once all components are connected and working correctly, the red/white crosses disappear from
the System Settings display and the hazard warning flag in the title bar is cleared.
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System Settings

At this stage, you may also want to adjust the following System Settings from the console GUI:

Wordclock Options - sample rate and system clock priorities.

Level Options - reference level and headroom.

All System Settings are stored and recalled with productions. Therefore, any changes
should be saved for recall at a later date.
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Wordclock Options

The Wordclock topic covers a range of options for selecting the internal sample rate of the system,
and defining source priorities for system sync.
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Max Sample Rate & Sample Rate

The option to run at higher (96kHz or 88.2kHz)  or  lower  (48kHz  or  44.1kHz)  sample rates  is  made
within the AdminHD configuration and cannot be modified from the console. 

Higher sample rates use twice as much DSP resource as lower sample rates; this is
reflected in the DSP Configurations display. 

Higher sample rates also affect the crosspoint capacity of the routing matrix (8k² at 48kHz,
or 4k² at 96kHz).

Max Sample Rate

The maximum rate is displayed in the Max Sample Rate field. This field is for display purposes only,
and determines the available Sample Rate options below.

Sample Rate

This option selects the internal sample rate of the system.

If the system is configured to run at lower  sample rates  (by AdminHD),  then you may select  either
48kHz or 44.1kHz operation.

If  the system  is  configured to  run  at  higher  sample  rates,  then  you  may  select  96kHz,  88.2kHz,
48kHz or 44.1kHz operation. 

It is recommended that you mute your loudspeakers when changing the system sample
rate.

When running the system referenced to Wordclock, the frequency of the sync source
MUST match the internal operating sample rate of the system.
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The remaining Wordclock options define the system's sync reference.

The Nova73 offers  a  fully  redundant  clock source structure with  two independent  clock  inputs,  an
internal  sync  generator  and the ability  to  lock to  sync  from  an incoming multi-channel  signal.  This
allows the console to be clocked from a variety of  sync  sources  and recover  from  loss  of  external
sync.

Source Priority 1 & 2

These two options define the main and redundant clock source.

If  sync  is  lost  or  a  signal  of  an  incorrect  frequency  appears  on  Source  Priority  1,  the  system
automatically switches  to  Source  Priority  2.  Similarly,  if  sync  is  lost  on  Source  Priority  2,  the
system automatically switches to internal sync.

You can set each of the options to:

Input 1 – connected to the Nova73 rear panel (Wordclock, Video Black Burst or AES3-id).

Input 2 – connected to the Nova73 rear panel (Wordclock, Video Black Burst or AES3-id).

MultiCh - Multichannel Sync (MADI or ATM, as defined by AdminHD).

Active Synchronization Source

This option displays and sets the active sync source for the system: 

Src Prio 1 – the input selected as Source Priority 1.

Src Prio 2 – the input selected as Source Priority 2.

Internal.

Return Mode

This option activates a return mode so that the system will switch back to Source Priority 1  (or  2)
when it returns. The system even checks whether the return sync is valid and will not switch until the
sync source matches the chosen operating frequency of the console.

Return Mode (On) - activates the return mode.

Return Mode (Off) - deactivates the return mode.

To force the system to run on internal sync, deactivate the return mode and set the Active Source  to
Internal.

Alarm when Internal

This option activates an alarm when the system is running on internal sync:

Alarm when internal (On) - activates the alarm.

Alarm when internal (Off) - deactivates the alarm.

The alarm  triggers  on-screen Warning flag and illuminates  the  red  LED  on  the  front  panel  of  the
Nova73 Router Card.
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External Sync Input Status

The next  five options  are for  display purposes  only and show  the status  of  the external  and multi-
channel sync signals. 

The example above shows that a valid Wordclock signal is connected to external inputs 1 and 2, and
the Active Synchronisation Source is Src Prio 1 = Input 1.
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Level Options

Select  the  Level  topic  to  make  changes  to  the  system's  reference  level,  headroom  or  overload
threshold:

These  levels  affect  the  maximum  analogue  level  from  your  system  according  to  the  following
equation:

Maximum Analogue Level = Reference Level + Headroom

The system supports a maximum analogue level = +24dB, and a minimum analogue level = +12dBu.

Warning

Changing the Reference Level or Headroom options move the internal 0dB operating
point for the system and therefore will change the behaviour of any level dependent
settings such as dynamics processing and metering. Therefore, it is not advisable to alter
these levels once dynamics processing has been set.

For systems fitted with fixed level analogue I/O cards:

The  Headroom  and  Reference  Level  cannot  be  altered  independently.  For
example,  with  a  +15dBu  fixed  analogue  I/O  card  and  +9dB  Headroom,  the
Reference Level must be +6dBu.

The Maximum Analogue Level of the whole system is defined by the DALLIS  card
with  the lowest  GDA (General  Device Address)  -  this  is  the card with  the lowest
address fitted to the DALLIS frame connected to the lowest port number of the first
Nova73.  (If  a  different  fixed  level  analogue  card  is  fitted  elsewhere  within  the
system, then a warning appears in  the log file;  however,  the card with  the lowest
GDA still wins.)
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Reference Level

Sets the reference level of your analogue interfaces in dBu.

Reference level may be set from 0dBu to +24dBu, depending on the Headroom.
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Headroom

Sets  the  operating  headroom  to  the  external  world;  this  is  the  difference  between  the  analogue
reference level and digital full scale (0dBFS). 

Headroom may be set from 0dB to +20dB depending on the Reference level.

Note that the internal Headroom is more then 380dB which means, if you route from input to group to
group to sum, you can overdrive the level more then 380dB before clipping!
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Chapter 3: AdminHD

Introduction

This chapter covers AdminHD, the Lawo software programme which runs on an external computer
to provide remote configuration of any mc2 system.

Topics covered are:

Overview

AdminHD and mxGUI

Compatibility

Computer System Requirements

Software Installation

Connecting to the Lawo Control System 

Configuration Files

Operating Principles

Core Configuration: First Steps

Core Configuration: Defining the System

Core Configuration: Editing Parameters

Signal List Configuration

Online Operation

System Diagnostics

The ‘Connect Manager’

Documenting the Configuration

Core Configuration: Parameters

mxDSP Configuration

The 'Console Panel'
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Overview

AdminHD is the Lawo software application used to configure all Nova73 systems.

It is responsible for generating the config.tcl and gui_config.tcl configuration files, which are read by
the  control  system  at  boot-up  following  a  cold  start.  These  files  define  the  Nova73  and  DALLIS
system components, and the console GUI's Signal List display:

System Configuration Signal List Editor

It  can  also  run  online  to  provide  control  of  matrix  crosspoints,  signal  labels  and  I/O  settings,  or
perform system diagnostics:

Online Connect Manager System Diagnostics

In addition, a number of useful tools are included for documenting the configuration.
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The  configuration  files  created  by  AdminHD  are  an  essential  part  of  the  system.  If  a  hardware
component is not defined within these files, then it will not be visible to the user even if it is  powered
and connected. In other words, the configuration is always the ‘master’ of the system, regardless of
what physical components are added or removed.

This brings a number of advantages:

The configuration is always controlled by AdminHD. 

You can configure components which may not be permanently connected (e.g.  Stageboxes)
so that  routes  can be made to/from  these  devices  without  relying  on  a  physical  hardware
connection.

You can easily test changes to  the configuration offline.  If  a  component  or  parameter  is  not
available  within  the  AdminHD  software,  then  it  is  ‘illegal’.  This  allows  you  to  prepare
configuration updates offline, and upload them to the system with confidence.

AdminHD can connect to the control system of mxGUI. This allows you to open mxGUI using
a pre-prepared configuration in order to create user settings ahead of an event.
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AdminHD and mxGUI

From Version 4.8 software onwards, a separate programme – mxGUI – is available to complement
AdminHD.

Both programmes can run online to remotely control a real system. AdminHD offers control of matrix
cross points, signal labels and I/O parameters only (via the 'Connect Manager'). mxGUI emulates the
GUI displays of the mc2 consoles, providing control of virtually any user parameter.

Both programmes  can also run offline on your  computer.  This  allows  you  to  prepare  a  complete
system ahead of an event as follows:

1. Use AdminHD to define the Core configuration (config.tcl) and Signal List (gui_config.tcl).

2. Upload  the  configuration  files  from  AdminHD  to  the  mxGUI  local  control  system  on  your
computer.

3. Use mxGUI to prepare and save user settings (by saving a production). 

4. Once connected to the final  system,  you can use mxGUI  to  transfer  both the configuration
and production(s) from your computer to the Lawo control system.

For more details on mxGUI, please refer to the "mc²56 Operators Manual".
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Compatibility

AdminHD may configure, or connect to, any Nova73 system. To ensure that you can only access the
options supported by your product, the software can be opened in one of two modes:

AdminHD for Mixing Consoles – supports mc256, 66 and 90 consoles (MKI and MKII).

AdminHD for Nova73 & DSHS – supports the Nova73 stand-alone routing matrix, or Nova73
HD Dual Self-Healing Star.

When new hardware options or software features are released for any of these systems, then a new
version of AdminHD is also issued.

From version 4.0.2.2 onwards, all Lawo products have adopted a consistent software
release numbering system to indicate compatibility. In each case, the first three digits of
the software version must match. 

So, to prepare a configuration or connect to a mc2 console running 4.20.2.0, you need to
run AdminHD 4.20.2.x. 

You can check the software version of your mc2 system from the Global Options in the
System Settings display, and the version of AdminHD from the ? main menu.

Note that:

Configurations  saved by an  earlier  version  of  AdminHD  can  be  opened  in  a  later  release.
However, configurations saved by a newer release are not backwards compatible.

Configurations created for one type of system are NOT compatible with another; you cannot
open a mixing console configuration from AdminHD for Nova73 & DSHS, or vice versa.
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Computer System Requirements

To install and run the AdminHD software, your computer MUST meet or exceed the following system
requirements:

Windows PC:

Hardware: 500MHz.

Operating System: Windows XP, Windows Vista (32-bit), Windows 7 (32-bit and 64-bit)

RAM: 1.5GB RAM (Windows XP), 2GB RAM (Windows Vista/7).

Hard Disc: minimum 200 MB free space.

Operation: Keyboard and mouse.

Interface: Ethernet 10/100Mbit.

MAC:

Hardware: 500MHz.

Operating System: MAC OS X 10.6 (Snow Leopard), 10.7 (Lion), 10.8 (Mountain Lion)

RAM: 2GB RAM

Hard Disc: minimum 200 MB free space.

Operation: Keyboard and mouse.

Interface: Ethernet 10/100Mbit.
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Software Installation

During installation, you may choose to install AdminHD and/or ControlHD:

AdminHD  is  the administration programme providing configuration,  remote  control,  system
diagnostics and documentation.

ControlHD  is  a  subset  of  the  AdminHD  software.  It  looks  and  operates  in  an  identical
manner,  but  can  only  be  used  for  remote  control  and  system  diagnostics  (i.e.  not
configuration).

By installing only ControlHD on some computers and AdminHD on others, you can set up
computers for different users within the facility. Remember that you may also use mxGUI
for online operation of the system.

In each case,  both modes  are installed  (...  for  Mixing  Consoles  and  ...  for  Nova73  &  DSHS),
resulting in up to four programme entries on your computer:

You can install multiple AdminHD versions (4.18, 4.20, etc.) as shown above; there is no
need to uninstall older versions. This is particularly useful when working with systems
running different releases of software..

Licensing

Lawo’s AdminHD/ControlHD application is free of charge and does not require a software licence.
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Installation Procedure

1. Copy the AdminHD_Release_X-X-X-X.zip onto your computer and unpack the file.

2. Double-click on the relevant installer. 

AdminHD is delivered in a compressed format, so it may take a few seconds before you see the
‘Setup Wizard’:

If you are running Windows 7, then you may be prompted to allow changes to your User
Account; select Yes to continue.

If you are running MAC OS X 10.8 (Mountain Lion), and have problems opening the
installer, see additional notes for MAC OS X.

3. Follow the Wizard's instructions accepting the default options provided.

As  part  of  the installation process,  you can choose  the  AdminHD,  ControlHD  or  AdminHD  +
ControlHD install set.

4. When you reach the 'Summary' window, check the options and click Install.

The software is installed onto your computer; this may take a few minutes.

By default, files are installed in the location: ‘C:\Program Files\Lawo/AdminHD X.XX’.  where X.XX
is the release version.

5. When the installation is complete, a confirmation window will appear.

6. Click on Finish to exit the ‘Setup Wizard’.

If you have any problems with the software installation, please contact your local Lawo representative
or email service@Lawo.de.

mailto:service@Lawo.de
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Additional Notes for MAC OS X Installation

If you are running MAC OS X 10.8.x.x (Mountain Lion), then you may see the following error message
after double-clicking on the "install.exe" file:

This error can appear if your "Gatekeeper.app" does not allow installation from downloads which are
not from the MAC App Store. To change this setting:

1. Select  "System  Preferences  ->  Security  &  Privacy"  and  set  the  "Allow  applications
downloaded from:" as follows: 

2. Then retry opening the AdminHD "install.exe" file.
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Uninstall & Update

Uninstalling AdminHD

On Windows 7, use the “Uninstall a program” option within the Control Panel to uninstall AdminHD.

On MAC OS X, remove the programme from your "Applications" folder.

Updating AdminHD

To update to a newer version of AdminHD or ControlHD, simply run the installer; there is no need to
uninstall older versions. Following installation, each version appears within its own folder:
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Connecting to the Lawo Control System

In  order  to  transfer  configuration  data,  or  run  AdminHD  online,  you  will  need  a  valid  network
connection between your computer and the mc²56 MKII control system.

On the mc²56 MKII, the ETHERNET B port on the Nova73 Router  Module MKII (980/33)  should be
used: 

1. Connect your computer to the Lawo system network.

2. Configure the TCP/IP settings on your computer's network interface card.

The control system location may vary for other Lawo products, see Control System
Locations.

You  may  open  an  existing  AdminHD  file,  or  create  a  new  configuration,  without  this
connection. However, it is a good idea to configure the network now, so that you are ready
to transfer data later.
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Checking the Network Communication

If this is the first  time you have connected to  the mc²56 MKII control  system,  then start  AdminHD,
create a new session and then download the online configuration from the remote system:

If  the  connection  is  successful,  then  the  'Core  Browser'  updates  to  display  the  hardware
components for your system.

If  the  connection  fails,  then  nothing  appears  in  the  'Core  Browser',  and  the  ‘Remote  Log’
reports that the connection has timed out:

o Check the network connection and TCP/IP  settings  of  your  computer's  network interface
card. 

o Check that AdminHD is compatible with the mc²56 MKII system (the first three digits of the
software versions must match.)

o See also the trouble-shooting tips to resolve the problem.

Alternatively, if you have an existing AdminHD file, with the correct system IP address, then you can
switch online to test the network communication.
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Configuration Files

Before you start working with AdminHD, it is useful to understand how configuration data is stored on
the mc²56 MKII control system, and which files can be edited and saved on your AdminHD computer.
The diagram below illustrates the processes involved; keep reading for further explanation.
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Control System Cold Start Files

The following configuration files are stored on the mc²56 MKII control  system,  and are read after  a
cold start:

config.tcl – this file, known as the Core configuration, defines the:

o Nova73 and DALLIS components.

o System-wide parameters such as sample rate, reference levels and sync options.

o Signal parameters  such as  the HLSD  address,  name,  default  label,  I/O  settings,  silence
detects and mapping tables.

gui_config.tcl  –  this  file,  known  as  the  Signal  List  configuration,  defines  the  Directories,
Subdirectories and signal organisation within the GUI’s Signal List display.

console_config.tcl  –  this  file,  known  as  the  Console  configuration,  defines  the  control
surface layout for mc2 consoles.

custom.tcl – this file defines customer-specific functions.

userconfig.tcl – this file defines the user monitoring functions in the mc2 console series.

Custom_template_instances  –  this  folder  stores  the  custom  functions  programmed  from
the GUI’s Custom Functions display. Each function is stored as a separate .tcl file.

The table  below  summarises  which files  can be  edited  by  AdminHD  and  which  must  be  factory-
configured. Also, whether files can be accessed by mxGUI and how they are named within mxGUI's
File Transfer display:

Control System Filename

Edit in

AdminHD

File Transfer to 

mxGUI Appears in mxGUI as:

config.tcl Core Configuration

gui_config.tcl Signal List Configuration

console_config.tcl * Console Configuration

custom.tcl n/a

userconfig.tcl n/a

Custom_template_instanc
es

Custom_template_instance
s

* The console_config.tcl file can be edited using AdminHD for MKI mc266 systems only;
for all other mc2 consoles, this file is factory-configured; the file is unused by a stand-alone
Nova73.

Files such as the custom.tcl and userconfig.tcl must be edited by Lawo personnel.
Please contact your local Lawo representative or email service@lawo.de if you require
further assistance to modify these aspects of the configuration.

mailto:service@Lawo.de
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AdminHD Files (on your computer)

AdminHD cannot edit the config.tcl and gui_config.tcl files directly. Instead, it downloads the online
configuration (running in memory) from the mc²56 MKII, and saves it locally onto your computer as a
.csv or .slx file. These file types can then be opened, edited and saved by any AdminHD computer.

Once editing is  complete,  you can choose to  either  update  the  online  configuration  (in  temporary
memory) or export and upload new versions of the cold start .tcl files (recommended for permanent
changes).

Organising Your Files

These  processes  mean  that  AdminHD  creates  several  files  all  relating  to  a  single  system's
configuration.

In the example below, we have created a folder named Studio 2 to store all the AdminHD files for a
mc2 mixing console:

Create a backup folder to store copies of the current configuration files before you begin
editing.

When using both AdminHD and mxGUI, you could create a master folder for the system,
with separate sub folders for AdminHD and mxGUI.
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The following files are created by AdminHD and stored locally on your computer:

config.csv - created when you save the AdminHD configuration. This is a .csv file which can
be opened by AdminHD, ControlHD or imported into a 3rd party editor such as MS Excel.

You can give this file any name as long as it keeps the .csv suffix. It is a good idea to keep "config"
in the name to distinguish it from other .csv files.

signallist.slx - created when you save a Signal List from the ‘Signal List Editor’. This is a .slx
file  which can only be opened by AdminHD  or  ControlHD.  You will  need to  copy this  file  to
other AdminHD/ControlHD computers if you wish to open the Signal List  within  the ‘Connect
Manager’.

You can give this file any name as long as it keeps the .slx suffix. If you are creating multiple signal
lists  for  different  ControlHD/AdminHD  users,  then  choose  something  descriptive  like
AudioControl.slx, VideoGallery.slx.

config.tcl and gui_config.tcl - are the cold start configuration files exported from AdminHD.
They are stored locally  on  your  computer,  in  preparation  for  an  upload  to  the  mc²56  MKII
control system.

DO NOT rename these files, or edit them  using an application other  than AdminHD.  Otherwise,
they cannot be read by the control  system!  If  you wish to  keep copies  of  ‘older’  versions,  store
them in a sub folder or change the filename.

systemlist.csv - can be exported to produce a parts list for the hardware defined within your
configuration. It is a .csv file which can be opened by a 3rd party editor, such as MS Excel, in
order to print or view the data.

connectionlist.csv - can be exported from the ‘Connect Manager’. It is  a .csv files which can
be  opened  by  a  3rd  party  editor,  such  as  MS  Excel,  in  order  to  print  or  view  all  matrix
crosspoints set within the system.

config.bfe  - exported for use with a BFE controller system. Please contact  your  local  Lawo
representative or email service@lawo.de for more details.

remote.log - created when you save the contents of the ‘Remote Log’ window as a text file.
You may be asked for this file if you request assistance from the Lawo service department.

system_log_message.log - can be downloaded from  the  mc²56 MKII control  system.  You
may be asked for this file if you request assistance from the Lawo service department.

snapX.lsn - are snapshot files which you can save or load from the ‘Connect Manager’. If you
are creating snapshots  for  multiple  systems,  then  store  them  in  separate  folders  on  your
computer.

mailto:service@Lawo.de
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Operating Principles

This section covers the basic operating principles of AdminHD:

Starting AdminHD

The Main Operating Window

Online/Offline Status

The Main Toolbar

The Sub Windows

‘Core Browser’

‘Graphic View’

‘Parameter Box’

'Remote Log'

The Main Menus

AdminHD Preferences

If you'd like some data to work with, then create a new session and download the online
configuration from the mc²56 MKII to your computer (recommended). Or, open an existing
config.csv file.

If neither of these options are possible, create a new session and build a simple Core
configuration from scratch.
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Starting AdminHD

1. Start the programme, by selecting AdminHD  for  Mixing Consoles  from  the START menu
(Windows) or Applications folder (MAC):

Warning

It is very important that you choose the correct mode (... for Mixing Consoles and not ...
for Nova73) , AND the correct software version (the first three digits must match the
software running on your remote system).

If not, AdminHD will not be able to connect to the mc²56 MKII. Or, the system may not read
your configuration data. See Compatibility for details.

AdminHD starts up and opens the last configuration file (config.csv) you were working on:

If the file was saved in an older version of AdminHD, then you will be asked to convert it.

The ‘Core Browser’ and ‘Remote Log’ sub windows may open automatically (according to
the Extras -> Preferences -> Startup menu).
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If this is the first time you have started AdminHD, or a file could not be loaded, then AdminHD opens
with a completely empty operating window:
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File Conversion

The following dialogue pop-up appears if there is a mismatch between the AdminHD software version
and the configuration file you are trying to open:

Select Yes to convert the configuration file to the newer AdminHD release.

Select No to leave the file unchanged, and open AdminHD without any configuration data.
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The Main Operating Window

The main operating window is divided as follows:

1 Headline Displays AdminHD, or Control HD, followed by the file path of the open file
(config.csv). If no filename appears, then this is a new AdminHD session.
If the filename is followed by an asterisk (*), then changes have been made
since the last save.

On the right you can close the programme or minimise/maximise
AdminHD in the usual manner.

2 Main Menus Access to the File, Remote, Extras, Window and ? main menus.

3 Main Toolbar Fast access to common functions.

4 Sub Windows This is the main operating area in which you can open a mixture of sub
windows. In our example, only the 'Core Browser' is open.

5 Status Bar Displays the AdminHD mode (mc2 console or Nova73 HD) and online/
offline status.
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Online/Offline Status

AdminHD starts up in offline mode; the online/offline status is shown in the status bar at the bottom of
the display:

Offline

When running offline, you can:

Download configuration data (from the online system to your computer).

Edit the configuration data, locally on your computer in AdminHD.

Export and upload cold start configuration files (from your computer to the mc²56 MKII control
system).

Note  that  to  download  and  upload  data,  you  will  need  a  valid  network  connection  between  your
AdminHD computer and the  mc²56 MKII control system.

Online

You should switch to online mode if you wish to:

Monitor the system status.

Use the 'Connect Manager' to control matrix crosspoints, signal labels and I/O settings.

Update the online configuration (in memory).
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The Main Toolbar

The first six buttons provides fast access to common functions:

1 Open Opens an existing AdminHD file (config.csv).

2 Save Saves the current AdminHD configuration as a config.csv file.

3 Download Downloads configuration data from the online control system into AdminHD.

4 Upload Uploads the AdminHD configuration to the online system (available in online
mode only).

5 Online Enables (or disables) the online connection to the remote control system.

6 Preferences Opens the AdminHD Preferences window.

The remaining buttons show or hide the sub windows. 
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The Sub Windows

AdminHD  supports  seven sub windows.  They can be opened from  the main toolbar,  the  Window
menu, or by using a keyboard shortcut:

Toolbar Window menu & Keyboard Shortcuts

7 Core Browser Displays the Core configuration hardware as a system tree. You can
navigate around the system, and add or remove components. When
running online, components are colour-coded to provide diagnostics.

8 Parameter Box Used to adjust parameters for the selected component or signal.

9 Graphic View

(Frame editor)

Provides a graphical representation of the system. Works in
conjunction with the 'Core Browser' to add or remove system
components. When running online, components are colour-coded to
provide diagnostics.

10 Console Panel Defines the Console configuration (MKI mc266 systems only).

11 Signal List Editor Creates the Signal List configuration used in the GUI’s Signal List
display or AdminHD's 'Connect Manager'.

12 Connect Manager Available in online mode only. Here you can remotely control matrix
crosspoints, signal labels and I/O settings.

13 Remote Log Logs all the messages generated by AdminHD and, when online, the
mc²56 MKII control system.

Some selections may be unavailable (greyed out). For example, the 'Connect Manager'
can only be selected once you are running online.

The ‘Core Browser’ and ‘Remote Log’ may open automatically (according to the Extras ->
Preferences -> Startup menu).
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Arranging the Sub Windows

The sub windows are rarely used in isolation, and should be combined according to the application.

 For  example,  while  editing  a  configuration,  you  may  open  the  'Core  Browser',  'Graphic  View',
'Parameter Box' and 'Remote Log':

Sub windows can be closed, minimised, resized or moved as follows:

1. Click on  to close a window.

2. Click on  to minimise a window.

Minimised windows are reduced to a button, for example:

Click on the button - e.g. Core 1 - to restore the window to its original size and position.

3. To change the size of a window, point to the relevant margin or corner, and drag left/right  or
up/down accordingly.

4. To move a window, place the mouse pointer over the title bar of the window. Then drag and
drop the window to its new position.

The ‘Core Browser’ cannot be minimized or moved.

The ‘Graphic View’ cannot be resized.
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‘Core Browser’

The ‘Core Browser’ displays the Core configuration using a hierarchical system tree. It can be used
to navigate around the system, add or remove components, and monitor their status (when online).

1. Click on  from the main toolbar to show the ‘Core Browser’.

Or select Window -> Core browser (from the main menus)  or  press  CTRL +  SHIFT  +  B  (on
your computer keyboard).

The System tree appears as you last left it. When running online, components are colour-coded to
provide diagnostics:

2. Click on the + or – signs to open or close a branch of the system tree. Or, use the arrow keys
on your computer keyboard:

Up/Down - navigate up/down.

Left/Right - open/close the selected branch.

3. Hover over an individual signal (e.g. Signal In 1) to display its parameters.

4. Right-click on a component to reveal its configuration options.

Signal Parameters Summary Right-click Options



mc²56 MKII Technical Manual V4.24/1 119

Chapter 3: AdminHD
Operating Principles

The System

The System structure is hierarchical and arranged as follows:

System Each configuration consists of a single System
containing all the hardware components for your
installation.

Core Within the System, you define the Core.

Virtually all Systems consist of a single Core. (In certain
specialised Nova73 DSHS systems, two Cores may be
configured.)

Modules Next, you fit the Core with Modules. 

In our example, Core 1 is fitted with two MADI Modules,
and three DSP Modules. 

Standard components, such as the Router module,
main PSU and Redundant PSU are added automatically
when you define the Core.

Ports Each Module can then be opened to view its I/O Ports:

In the case of a MADI, RAVENNA or ATM module, the
ports offer a range options (for example, to connect to a 
DALLIS or operate as Tie-Lines).

Cards Each DALLIS may then be fitted with Cards. In our
example, you can see the MIC, AES3 and LINE cards
fitted to the DALLIS connected to Module 2, Port 1.

Signals At the lowest level of the system tree are the signals
themselves – in our example, Card 1 has been opened
to reveal the four mic/line input signals (Signal In 1 to 4).



V4.24/1120 mc²56 MKII Technical Manual

Chapter 3: AdminHD
Operating Principles

The Core Browser Toolbar

At the top of the 'Core Browser' are a number of useful functions. 

The first two buttons help with system navigation:

1 Collapse all Hides all sub nodes within the selected branch.

2 Expand all Shows all sub nodes within the selected branch.

The next four buttons can be used when editing the Core configuration:

3 Copy Copies the selected component and its sub entries.

4 Cut Cuts the selected component and its sub entries

5 Paste Pastes the copied component, with sub entries, to the selected branch of the
system. 

6 Delete Deletes the selected component and its sub entries

The last button can help identify system components:

7 Alias Displays your device alias names rather than the Lawo system names.
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‘Graphic View’

The ‘Graphic View’ provides a graphical representation of the system. It works in conjunction with the
'Core Browser' to define the Core configuration and monitor system status (when online).

1. Open the 'Core Browser' and select a component other than the System - e.g. Core 1.

2. Click on  from the main toolbar to show the ‘Graphic View’.

Or select Window -> Frame editor (from the main menus) or press CTRL + SHIFT + F (on your
computer keyboard).

A pictorial representation of the selected component appears. (When running online, components
are colour-coded to provide diagnostics.)

The ‘Graphic View’ cannot be opened if System is selected (as there is no valid hardware
component to display!) In addition, the ‘Graphic View’ will close automatically if you select
System in the 'Core Browser'.

3. Click on a module in the 'Graphic View', and the system tree selection (in the ‘Core Browser')
follows. 

4. Similarly, select a different component in the ‘Core Browser', and the 'Graphic View' updates.
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5. Right-click on a Module slot (within the Core), or a Card slot (within a DALLIS), to reveal  its
configuration options:

Core Module Options DALLIS Card Options
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‘Parameter Box’

The ‘Parameter  Box’  is  used to  adjust  settings  for  the  selected  component  or  signal.  It  works  in
conjunction with the 'Core Browser' and 'Graphic View' to define the Core configuration.

1. Open the 'Core Browser' and double-click on a component or signal - for example, Signal In
1.

Alternatively, select the component or signal, and click on  from the main toolbar to show the
‘Parameter Box’.

Or select Window -> Parameter box (from the main menus) or press CTRL +  SHIFT  +  P  (on
your computer keyboard).

Once the 'Parameter Box' is open, if you make a different selection (in the ‘Core Browser'
or 'Graphic View'), then the 'Parameter Box' follows.

2. Use the tabs to select a page - e.g. Signal, DSP, Map.

White parameter fields (e.g. Signal name, Signal label, Group) can be edited.

Grey parameter fields are usually for information purposes and cannot be modified.

Check boxes may selected or deselected.
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'Remote Log'

The 'Remote  Log'  lists  all  the  messages  generated  by  AdminHD  and  by  the  mc²56  MKII  control
system  (when online).  It  is  a  good idea to  open  this  window  when  transferring  data  to  or  from  a
system, or running online.

1. Click on  from the main toolbar to show the ‘Remote Log’.

Or select Window -> Remote log (from the main menus) or press CTRL + SHIFT + L (on your
computer keyboard).

The log displays all errors and queries since AdminHD was started:

2. Scroll up the list to view the log history.

The ‘Remote Log’ stores all messages while AdminHD is running. If you exit AdminHD and re-open it,
then the previous log is lost.

To save the log contents:

3. Right-click  anywhere  within  the  window,  and  select  Export  content..  (or  select  File  ->
Export File -> Remote Log):

A File -> Save dialogue box appears.

4. Choose a folder, enter a filename and click Save.

The log is stored as a plain text file and can be opened by any common text editor.

You can specify a default directory for your logfiles from the Extras -> Preferences ->
Common Directories menu.

To clear the log contents:

5. Right-click anywhere within the window, and select Clear content.. 

The existing contents of the ‘Remote Log’ are cleared.
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The Main Menus

AdminHD supports five main menus:

File

Remote

Extras

Window

?
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File

New – creates a new AdminHD session.

Open – opens an existing AdminHD file (config.csv).

Open recent – opens a recent config.csv file.

Close  –  closes  the  current  AdminHD  session.  You  will  be  prompted  to  save  your
configuration as a config.csv file before closing.

Save – saves the current AdminHD configuration as a config.csv file.

Save As – saves the current configuration under a new filename.

Export file - exports the following file types:

o Core cold start config (config.tcl) – the cold start Core configuration.

o Component List – a component parts list.

o BFE controller – a BFE controller file. Please contact  your  local  Lawo representative or
email service@lawo.de for more details.

o Remote log - the contents of the ‘Remote Log’.

Exit  –  click to  close the AdminHD  programme.  You will  be prompted  to  save  your  current
configuration before closing.

mailto:service@Lawo.de
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Remote

Online to remote system – enables (or disables) the online connection to the remote control
system.

Reconnect  mode  –  when enabled,  AdminHD  attempts  to  reconnect  to  the  remote  control
system if network communication is interrupted.

DSHS – access to dual self-healing star options (Nova73 DSHS configurations only).

Upload all  data to  remote  HD  –  uploads  the AdminHD  configuration to  the online system
(available in online mode only).

Upload  file  -  uploads  the  following  configuration  files  from  your  computer  to  the  remote
control system:

o Core cold start config (config.tcl) – the cold start Core configuration.

o Console  cold  start  config  (console_config.tcl)  –  the cold  start  Console  configuration
(MKI mc266 only).

o GUI cold start config (gui_config.tcl) – the cold start Signal List configuration.

Download all data from remote HD – downloads configuration data from the online control
system into AdminHD.

Download file  – downloads the following file  types  from  the remote control  system  to your
computer:

o Core cold start config (config.tcl) – the cold start Core configuration.

o System log messages - the control system log file.

o Console cold start config (console_config.tcl) – the cold start Console configuration.

o GUI cold start config (gui_config.tcl) – the cold start Signal List configuration.

Reset system (cold send) – cold starts the remote control system (available in online mode
only).



V4.24/1128 mc²56 MKII Technical Manual

Chapter 3: AdminHD
Operating Principles

Extras

Datasheet -> Comfort Text Edit Mode - enable this mode to use the naming short cut in the
Signal 'Parameter Box'.

Show mapping table – opens an overview of the mapping tables 1 to 16.

Check configuration – checks the AdminHD configuration for programming errors.

Preferences – opens the AdminHD Preferences.
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Window

Shows or hides the seven sub windows.



V4.24/1130 mc²56 MKII Technical Manual

Chapter 3: AdminHD
Operating Principles

? -> About

Information about the AdminHD software version, license and operating system.
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AdminHD Preferences

When  using  AdminHD  for  the  first  time,  it  is  a  good  idea  to  spend  a  few  minutes  adjusting  the
programme's Preferences. 

1. Select  Extras  ->  Preferences  from  the  main  menus,  or  press  CTRL  +  P,  to  open  the
'Preferences' pop-up window:

2. Use the tabs to select a page.

3. Select or unselect a preference.

4. Click OK to save your changes.

5. Restart AdminHD or re-open the relevant window for the changes to take affect.

Your preferences are stored in the setup files for the software. Therefore, they will remain
as you last left them each time you start the programme.
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Preferences -> Common

This page deals with common programme options:

Disable graphic frame pop-up after creating new hardware  – tick this box if you wish to
stop AdminHD automatically displaying the ‘Graphic View’ when new hardware is added to the
configuration.

Display large graphics (for extended screens) – select this option if you are working with a
larger screen (e.g. 21”). The graphics are doubled in size.

Disable  auto  reconnect  –  tick this  box to  prevent  AdminHD  automatically reconnecting to
the online system if network communication is interrupted.
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Preferences -> Start up

This page deals with start-up options which occur when you open or create a new configuration. 

Hide  Core  Browser  –  tick  this  box  if  you  do  NOT  want  the  ‘Core  Browser’  to  appear
automatically. 

Show remote log – tick this box if you DO want the ‘Remote log’ to appear automatically.
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Preferences -> Directories

This page allows you to specify the default directory paths  which will  be used each time you save,
open, export or download a file:

1. Click on the folder button next to the entry you want to specify – e.g. beside Config files.

A file dialogue box appears.

2. Select the folder where you usually want to save your files and click on Open.

The file dialogue closes and the path is displayed in the Preferences field.

3. Repeat for all the AdminHD file types:

Config files – AdminHD configuration files (config.csv).

Remote logfiles – ‘Remote log’ text files.

Coldstart config files – config.tcl, gui_config.tcl and console_config.tcl files.

Core log message files – System log text files.

Snapshot files – ‘Connect Manager’ snapshots.
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Preferences -> Connect Manager

Default Options Recommended Options for ControlHD

These preferences affect what happens when the ‘Connect Manager’ window opens:

Auto load connect manager in ControlHD mode – when ticked, the ‘Connect Manager’ will
automatically open when you open or download a configuration in ControlHD. This option does
not affect AdminHD.

Auto switch to remote online mode – when ticked, AdminHD will automatically select online
mode when you open the ‘Connect Manager’.

Disable online overwrite lock – tick this box if you want overwrite lock to be disabled each
time you open the ‘Connect Manager’.

Enable connect/disconnect easy step mode  – tick this box if you want easy step mode to
be enabled each time you open the ‘Connect Manager’.

Auto load config file  after startup – when ticked, AdminHD will load a signal list when you
open the ‘Connect Manager’. The signal list is  selected by clicking on the file  open icon and
making a selection from the pop-up.
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Preferences -> Signal List Editor

These preferences affect how the ‘Signal List Editor’ creates new signal lists.

The first two options affect mc2 mixing console systems only:

Enable physical Inputs/Monitors in DSP profile – tick this option to add the physical inputs
of  the  mc2  input  and  monitor  channel  DSP  channel  to  the  default  directories  of  the
Destination page.

Disable A/B of Inputs/Monitors in DSP profile  -  untick this  option if  you do NOT  wish to
add  the  mc2  input  and  monitor  channel  DSP  signals  to  the  default  directories  of  the
Destination page.

Enable physical Inputs/Monitors in DSP profile (ticked) Disable A/B of Inputs/Monitor in DSP profile (ticked)

The second two options affect all Nova73 systems:

Show foreign signals if already in matrix list – affects networked systems. Please contact
your local Lawo representative or email service@lawo.de for advice.

Skip using device alias for directory auto creation - tick this option if you do NOT want to
use the Super-device alias names when directories are automatically added to the signal list.

mailto:service@Lawo.de
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Core Configuration: First Steps

This  section deals  with  how  to  edit  and  update  the  Core  configuration.  The  best  approach  is  as
follows:

1. Create a new AdminHD session and, if possible, download the online configuration from  the
mc²56 MKII control system.

Alternatively, if you can't connect to the mc²56 MKII, open an existing config.csv  file. This may be
a file which you saved earlier or requested from your configuration engineer.

If you have neither a network connection or an existing config.csv file, then you will need to create
a  new  session  and  build  a  configuration  from  scratch.  Note  that  this  method  can  be  time
consuming, and is not recommended for minor changes to an existing system!

2. Save the configuration as  a config.csv  file  -  this  allows  you to  open it  later,  or  move  it  to
another AdminHD computer.

3. Define  the  new  system  components  and  edit  their  parameters  using  the  'Core  Browser',
'Graphic View' and 'Parameter Box'.

4. Check the configuration for programming errors.

5. Backup the system's existing cold start files.

6. Export the configuration as a cold start config.tcl file - this puts the data into a format which
can be read by the control system.

7. Upload the cold start config.tcl from your computer to the mc²56 MKII control system.

8. Cold start the mc²56 MKII to see your changes take affect.

As an alternative to exporting and uploading the config.tcl file, AdminHD can update the
online configuration (in temporary memory). However, this is not recommended for
permanent changes to a configuration.

Workflow Suggestions:

Both the config.csv  and config.tcl files can be transferred between computers. This allows  you to
download and save the configuration (as a config.csv) on a networked AdminHD computer; open it
on your personal AdminHD computer (for editing); export the config.tcl and transfer this back to the
networked computer (for upload to the control system).

If  you  are  also  editing  the  Signal  List  configuration,  then  download  and  save  both  sets  of  data
(config.csv  and  signallist.slx)  while  you  are  connected  to  the  control  system.  Once  editing  is
complete, export both cold start files (config.tcl and gui_config.tcl), and upload them to the control
system. You can then perform a single cold start to action all your changes.
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File -> New

This menu option creates a new empty AdminHD session. It should be used before downloading data
into a new session, or to build a new configuration from scratch.

1. Select File -> New from the main menus, and choose mc2 console. This mode supports the
mc256, 66 and 90 consoles (MKI and MKII):

The available options depend on the AdminHD mode and software release.

2. If  you  have  not  closed  your  previous  AdminHD  session,  then  the  following  dialogue  box
appears:

Select Yes to save the configuration (as a .csv file) before proceeding.

Select No to continue without saving.

The new session opens - you will see the entry System  in the ‘Core Browser’ and confirmation of
the system type in the status bar:
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Downloading the Online Configuration

The  best  way  to  ensure  that  you  are  working  with  your  system's  latest  configuration  data,  is  to
download the online configuration, from the mc²56 MKII control system.

To perform a successful download, you will need a valid network connection between your computer
and the control system.

We recommend running AdminHD offline, to avoid accidentally clicking the Upload button.

Open the 'Remote Log' to monitor the progress of the download. 

1. When you download the online configuration,  you will  download the current  data  (stored  in
memory). Therefore, to make sure this  data is  identical  to  the cold  start  configuration,  reset  the
system by performing a cold start.

2. Once the system has cold started, open a new AdminHD session (File -> New). 

This step ensures that you will be asked for the IP address of the Remote connection below.  If
you miss  this  step,  then AdminHD  will  attempt  to  connect  to  the IP  address  configured in  your
current session.

3. Then click on  from the main toolbar (Download all data from remote HD).

Or  select  Remote  ->  Download  all  data  from remote  HD  (from  the  main  menus)  or  press
CTRL + D (on your computer keyboard).

The following pop-up appears requesting an IP address for the Remote connection:
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4. Enter the IP address of your control system.

If a single Router Module is fitted to the Nova73, then enter the main IP address only.

If main and redundant Router Modules are fitted, tick both boxes and enter both IPs; the
redundant IP address is always 1 above the main IP address.

Router Module Redundancy

You can connect AdminHD to mxGUI by entering mxGUI's virtual IP address
(192.168.56.101).

5. Then click Connect.

AdminHD  downloads  the  online  configuration  data  from  the  remote  system;  the  'Remote  Log'
reports on the progress.

When the download is complete, any open windows such as the ‘Core Browser’ update to show the
new configuration:
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If there is a problem with the download, then:

o Check the network connection and TCP/IP  settings  of  your  computer's  network interface
card. 

o Check that AdminHD is compatible with the mc²56 MKII system.

o See the trouble-shooting tips.
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Opening a Saved Configuration

To open an existing config.csv file:

1. Click on  from the main toolbar.

Or select File -> Open (from the main menus) or press CTRL + O (on your computer keyboard):

Use File -> Open recent to select a recent configuration.

2. Select your file and click Open.

If the file was saved in an older version of AdminHD, then you will be asked to convert it.

The file opens, and the path and file name appear at the top of the display:

You  can  decide  whether  the  'Core  Browser'  appears  automatically  from  the  Extras  ->
Preferences -> Startup menu.

If there is a problem opening the file, then check:

Is the file an AdminHD .csv ?

Was the file saved by a newer release of AdminHD?

Configurations saved by an earlier version of AdminHD can be opened in  a  later  release.
However, configurations saved by a newer release are not backwards compatible.
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Saving the Configuration

Having downloaded or  opened an existing configuration,  it  is  a  good  idea  to  save  the  data  as  an
AdminHD config.csv file. This  creates  a copy,  in  AdminHD  format,  which can be opened later,  or
moved to another computer.

1. Select either File -> Save, or File -> Save As from the main menus:

File -> Save overwrites the current file name (if one exists).

File -> Save As asks for a new file name:

2. Select a path and enter a suitable file name. 

You can use any name as long as it keeps the .csv suffix, but it is a good idea to keep the
word "config" in the name to distinguish it from other .csv files. See Organising Your Files.

You can also specify a default directory for your config files from the Extras ->
Preferences -> Common Directories menu.

3. Click Save to save the configuration onto your computer’s hard disk.

4. From here on, you can quickly update the file  by clicking on  (from  the main toolbar)  or
pressing CTRL + S.

If you are making a lot of configuration changes, use File -> Save As to save different
versions during the programming. This will allow you to revert to an earlier version, if there
is an error in your programming.
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Editing the Configuration

You can edit  the Core configuration using the 'Core Browser',  'Graphic  View'  and 'Parameter  Box'
windows. The details are covered later in this chapter, please see:

Defining the System - to add or remove components, or modify the System structure.

Editing Parameters - to adjust system or signal parameters.
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Checking the Configuration

Having completed your AdminHD configuration, it is  a good idea to check it for programming errors.
This will avoid any problems later when you upload to the system.

1. Select Extras -> Check Configuration from the main menus, or press CTRL +  K  on your
computer keyboard:

AdminHD analyses the configuration to check for the following errors:

Signal HLSD Conflicts – if two signals have the same HLSD (Lawo system address).

HLSD Syntax – if there is an invalid HLSD in the configuration.

Signal Name Conflicts – if two signals have the same name.

Mapping Table Address Conflicts – if you have assigned the same mapping table address
to different signals.

The result of the check is displayed within the status bar of the display:

If an error is reported, then try retracing your steps by opening an earlier version of the config.csv.
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Backing up the Cold Start Files

Before uploading new data, it is a good idea to backup the system's cold start configuration files.

To perform a successful download, you will need a valid network connection between your
computer and the control system.

1. Select Remote -> Download file from the main menus, and click on a file option:

Core cold start config (config.tcl) – the cold start Core configuration.

System log messages - the control system log file.

Console cold start config (console_config.tcl) – the cold start Console configuration.

GUI cold start config (gui_config.tcl) – the cold start Signal List configuration.

2. You are asked to  specify a  folder  location and name for  the file  -  in  our  example,  we have
chosen the Studio  2  folder  created earlier,  and have renamed the file  as  BACKUP_config.tcl,
see Organising Your Files.

3. Click Save.

AdminHD downloads the file from the remote system; the 'Remote Log' reports on the progress.

4. Repeat for each file you wish to backup.
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Upload Options

The Core configuration may be uploaded to the mc²56 MKII in one of two ways:

For permanent changes, you should upload a new version of the cold start config.tcl file. This
file will be stored on the mc²56 MKII control system, and read following a cold start. Note that
this method requires three stages:

o Export the configuration as a config.tcl file.

o Upload the config.tcl file from your computer to the mc²56 MKII control system.

o Cold start the mc²56 MKII.

For  temporary changes,  or  for  installations  where  a  cold  start  is  not  possible,  you  should
upload your data to the online configuration. This updates the online system without requiring
a restart; AdminHD must be running online to use this method.

The next few sections work through both options.

Before uploading new data, it is a good idea to backup the system's cold start configuration
files.
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Exporting the Cold Start config.tcl

This operation exports the Core configuration from AdminHD, and puts it into a format which can be
read by the mc²56 MKII control system - the config.tcl.

1. Select File -> Export file -> Core cold start config (config.tcl) from the main menus:

2. You are asked to specify a folder location for  the file  -  in  our  example,  we have chosen the
Studio 2 folder created earlier, see Organising Your Files.

Do NOT rename the file; it must be named config.tcl in order to be read by the control
system.

You can specify a default directory for your Coldstart config files from the Extras ->
Preferences -> Common Directories menu.

3. Click Save.

The configuration is exported from AdminHD and saved on your computer.
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Uploading the Cold Start config.tcl

Having exported the config.tcl file, it may now be uploaded to the mc²56 MKII control system.

You can use this operation to upload any config.tcl file. For example, a backup file, or a file
prepared on another AdminHD computer.

To perform a successful upload, you will need a valid network connection between your
computer and the control system.

AdminHD can remain offline to upload cold start configuration files.

If you have a redundant Router Module, then you will need to disable the redundant control
system BEFORE uploading the config.tcl file, see Upgrading Configuration and Software
in a Redundant System.

1. Select Remote -> Upload file -> Core cold start config (config.tcl) from the main menus:

2. Then select the config.tcl file you wish to upload:

3. Click Open.

The  file  is  uploaded  to  the  remote  system's  cold  start  data;  the  'Remote  Log'  reports  on  the
progress:
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If there is a problem with the upload, then:

Check  the  network  connection  and  TCP/IP  settings  of  your  computer's  network  interface
card. 

See the trouble-shooting tips.

4. Cold start the mc²56 MKII to see your changes take affect.

If there is a problem reading the new configuration after the cold start:

Check that you have uploaded the correct config.tcl file - the file MUST be named config.tcl
and MUST have been created using a compatible version of AdminHD.

When uploading a config.tcl to mxGUI, you should treat the mxGUI control system like any
real mc2 or Nova73. In other words, upload the file (as above), and then cold start mxGUI.
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Uploading Data to the Online Configuration

For  temporary  changes  to  the  Core  configuration,  or  for  installations  where  a  cold  start  is  not
possible,  you should upload your  data to  the online configuration.  This  updates  the  online  system
without requiring a restart and can be useful for testing, or updating systems where a cold start is  not
possible (for example, if 24 hour continuous operation is required).

The  online  configuration  is  stored  in  the  system's  warm  start  data  (at  shutdown),  and  recalled
following a normal  restart  (warm  start).  Providing you do  not  cold  start  the  system,  any  changes
made will remain intact.

Only the Core configuration can be modified in this manner (you cannot update the
Signal List or Console Configuration).

Warm start data is temporary. Therefore, this method is NOT recommended for
permanent changes to the configuration. If the control system is 'cold started', then it reads
the config.tcl file, and any changes to the online configuration will be reset.

To upload your current AdminHD session to the online configuration:

1. Enable online mode, by clicking on  from the main toolbar (Online to remote system).

AdminHD now connects to the remote system and compares the online configuration to  the one
open in AdminHD. When the analysis is complete, an 'Upload summary' appears:

This list allows you to review the changes  which you are about  to  make BEFORE  you continue
with the upload.

2. Read through the list and click on Upload to continue (or Cancel to abort the upload).

The 'Remote Log' reports on the progress  of  the upload;  after  a  successful  upload,  the system
immediately updates.



V4.24/1152 mc²56 MKII Technical Manual

Chapter 3: AdminHD
Core Configuration: Defining the System

Core Configuration: Defining the System

This section looks at adding or removing components to/from the Core configuration - for example to
add a new DALLIS or plug-in card.

To change parameters for existing components or signals, skip straight to Editing
Parameters.

The  same  principles  apply  whether  you  are  updating  an  existing  configuration  or  building  a  new
system from scratch. The system is hierarchical, and therefore components  must  be added in  the
following order:

1. Define the Nova73 (the Core).

2. Fit modules to the Core.

3. Define the I/O ports: for example, to configure a DALLIS or Tie-Lines.

4. Fit cards to a DALLIS.

5. Define other options such as Link and Port redundancy, and Port DSP resources.

You should open both the 'Core Browser' and 'Graphic View' to perform these tasks.

Warning

It is vital that the configuration matches your intended physical installation. Otherwise
components may not operate correctly. Therefore, it is useful to have the specification
details (part numbers and options) to hand.
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Defining the Core

The first step when configuring a new System is to add the Core:

1. Select the System entry in the ‘Core Browser’ and right-click.

A list of drop-down options appears - those in black  can be selected;  those in  grey  cannot.  The
available options depend on the AdminHD mode and software release:

2. Select  an option to  define the type  of  Core.  The  first  four  options  provide  support  for  MKI
systems. For MKII systems, select one of the last four options:

HD Core MK2 (48kHz) or (96kHz) = Nova73 HD; fitted with the Router Module MKII (980/33);
with a maximum sampling rate up to 48kHz or 96kHz.

Compact Core (48kHz) or (96kHz) =  Nova73 Compact;  fitted with  the Router  Module MKII
(980/33); with a maximum sampling rate up to 48kHz or 96kHz.

The selected Core  is  added to  the  System  tree,  along  with  its  standard  components:  Router
module, PSU and Redundant PSU:

Nova73 HD Nova73 Compact

You can decide whether the 'Graphic View' appears automatically from the Extras -> Preferences
-> Common menu.
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If you want to change the Core, then you will need to delete it and make a new selection:

3. Select Core 1 in the 'Core Browser', right-click and select Delete:

You are asked to confirm - Yes or No.

4. Select Yes to remove the Core,  and all  of  its  sub components,  from  the configuration.  You
can now return to step 1 to make a new selection.

Warning

Once you have defined the Nova73 Core, you CANNOT change the type later. So take
care to select the correct option before continuing!
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Fitting Modules to the Core

Next, fit your I/O and DSP modules to the Core, using the ’Graphic View’ as follows:

1. Right-click on a module slot - e.g. Slot 4 - and select a drop-down option:

Nova73 HD Nova73 Compact

The fitted modules appear within the ‘Graphic View’ and ‘Core Browser’.

The available  options  depend on the selected slot;  you cannot  configure an illegal  option (they are
"greyed out"):
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2. To remove a module right-click on the 'Graphic  View'  slot  and select  Empty.   Or,  go to  the
'Core Browser', right-click on the module and select Delete:

You are asked to confirm - Yes or No.

3. Select Yes to remove the Module, and all of its sub components, from the configuration.

4. For the Nova73 HD, you can right-click on the second PSU to add or  remove the redundant
power supply:

Warning

Take care to fit each module so that it matches the exact slot position, and part number,
of your physical installation. Otherwise, the module may not operate correctly.
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Fitting a Redundant Router Module

To add a redundant Router Module:

1. Right-click on the redundant Router Module slot and select available:

The module is added to the 'Graphic View' and 'Core Browser':

Note that the type of Router Module is automatically configured (to match that of the
existing module).
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You can also add or remove a redundant Router Module from the ‘Core Browser’, or 'Parameter Box':

'Core Browser' 'Parameter Box'
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Defining the IO Ports

Each I/O module can now be opened within the ‘Core Browser’ to view its ports.

In the case of an AES3 module, the port is  pre-defined and can be opened to access the AES input
and output signals.

In  the  case  of  a  MADI,  RAVENNA  or  ATM  module,  the  ports  require  further  configuration.  For
example,  the  port  may  connect  to  a  DALLIS,  operate  as  Tie-Lines  to/from  an  external  device,
connect to a Lawo Plugin Server, etc.

1. Select the Port in the ‘Core Browser’ and right-click:

The drop-down options vary, depending on the module (MADI, ATM or RAVENNA), and the AdminHD
mode and software release. For a MADI port, the options are:

DALLIS - configures a DALLIS unit (3RU or 6RU frame), with either 60 or 52 audio channels
+ DSP resources.

Tie-Line - the port is configured for a direct connection to an external device, either 64 audio
channels only, or 56 audio channels + DSP resources.

Plugin Server - configures a connection to the Lawo Plugin Server.

Local I/O - configures a connection to the Local I/O board in the mc256 MKII.

RAVENNA and ATM ports support similar options:

RAVENNA 128 ch link Port Options RAVENNA 256 ch link Port Options ATM Port Options

2. Select an option to define the port.
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Your selection is added to the 'Core Browser' - for example:

Select a DALLIS 3RU (52 channels) - a DALLIS with DSP Resources (4 & 8 channels) is
added  to  the  Port.  If  you  open  the  DALLIS,  you  will  see  its  standard  components
(Masterboard, PSU, and Redundant PSU). You can now fit cards to the DALLIS.

Note that the DALLIS master board is configured automatically according to the connection
type from the Nova73 module.

Select a Tie-Line - the MADI signals are added to the Port:
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Select Plugin Server - a special 64 channel connection to the Lawo Plugin Server is added
to the Port:

Select Local I/O - Local I/O resources, supported by the mc256 MKII, are added to the Port:

The signals appear in a similar manner to DALLIS plug-in cards. However, you cannot
change the Local I/O card arrangement, as this is determined by the physical board fitted
to the control surface!

If you want to change the function of a port, then you will need to delete the current assignment:

3. For example, right-click on a DALLIS in the 'Core Browser' and select Delete:

You are asked to confirm - Yes or No.

4. Select Yes to remove the DALLIS, and all of its  sub components, from the configuration. You
can now return to step 1 to make a new selection.
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Fitting Cards to a DALLIS

You can now fit cards to DALLIS units in a similar manner to fitting Nova73 modules:

1. Right-click on a card slot and select a drop-down option:

The  available  options  depend  on  the  selected  slot  and  the  capacity  of  the  DALLIS;  you  cannot
configure an illegal option.

2. Right-click on PSU 2 to add or remove a redundant power supply:

You can check how many audio channels are left by looking in the title bar of the DALLIS
frame - in our example, 52 In and 52 Out.

The DALLIS master board type cannot be altered (as this is configured automatically when
you define the Nova73 I/O Port.

Warning

Take care to fit each card so that it matches the exact slot position, and part number, of 
your physical installation. Otherwise, the card may not operate correctly.
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Copy, Cut & Paste

If you are fitting several components of the same type, then you can use copy, cut and paste.

For example, you may be fitting several MIC cards to a DALLIS, or connecting several DALLIS (with
the same I/O configuration) to the Nova73. Or, you may need to move a DALLIS card from one slot
position to another.

Note that all sub components and parameters are copied. Therefore, you may wish to configure the
DALLIS or card completely (including any parameters), before using copy, cut and paste.

Copy & Paste from the 'Graphic View'

1. Right-click on the source DALLIS card and select Copy:

The card is copied to AdminHD's clipboard; the address is shown in the status bar at the bottom
of the display:

2. Then right-click on the destination card slot and select Paste:

The card, and all of its parameters, are pasted into the configuration.

3. Repeat step 2 to quickly assign the same card to a number of slots.

4. Select Cut (in step 1) to move a card to a different slot.

Note that Paste is only available if you select a valid destination. For example, if the
DALLIS runs out of audio channels, then you will not be able to select Paste.
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Copy & Paste from the 'Core Browser'

1. Right-click on the source component - for example, a complete DALLIS - and select Copy:

The device is copied to AdminHD's clipboard; the address is shown in the status bar at the bottom
of the display:

2. Then right-click on the destination Port and select Paste:

The DALLIS, including all of its cards and parameters, are pasted into the configuration.

3. Repeat step 2 to paste the same DALLIS configuration to multiple ports.

4. Select Cut (in step 1) to move a DALLIS to a different port.

Note that Paste is only available if you select a valid destination. For example, you can only
paste a MADI DALLIS to another MADI port.
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Deleting Components

Depending on the component, it can be deleted either from the ‘Core Browser’ or ‘Graphic View’, see
Defining the Nova73 and Fitting Modules to the Core.

Warning

Deleting a component, removes it and all of its sub components, from the configuration.
Therefore, if you wish to keep parts of an existing configuration, use Copy, Cut & Paste.



V4.24/1166 mc²56 MKII Technical Manual

Chapter 3: AdminHD
Core Configuration: Defining the System

Port Redundancy

For  crucial  interconnections  between  DALLIS  and  Nova73  units,  you  can  specify  link  &  port
redundancy. 

To configure port  redundancy,  two master  boards  are fitted to  each  DALLIS.  Each  connects  to  a
different Nova73 port (preferably on a different module). AdminHD can select which I/O port is  used
for the redundant connection as follows.

Note that to support this feature, your system must be fitted with two master boards per
DALLIS, plus enough single-port Nova73 modules to support the connections.

Let’s take an example, where the main connection to the DALLIS is from Module 4 Port 1. We have
a spare port on Module 8 Port 1 which we want to use for the redundant connection:

1. Select Module 4 Port 1 and double-click to open its ‘Parameter Box’.

2. Tick the Is redundant option.

The following pop-up appears:

3. Select the redundant port – in our example, Module 8 Port 1 and click OK.
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The ports are now linked as indicated in the ‘Core Browser’:

And  the  ‘Parameter  Box’  for  Module  4  Port  1  shows  the  address  of  the  linked  port  within  the
Corresponding port box. This is described as a system address:

4. If  you now  select  the DALLIS  and look at  its  ‘Graphic  View’,  you  will  see  that  a  redundant
master board has been fitted:

5. Right-click on the redundant master board slot and select (or unselect) available  to  add (or
remove) the link to the redundant port.
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Port DSP Resources

Whenever you define a MADI Tie-line  or  DALLIS  which is  60-channels  or  less,  you automatically
configure an amount of DSP resource.

This is DSP which is physically located on the port (within the Nova73 module), and can be used for
additional mix matrices of either 4x4 or 8x8. The applications for  this  DSP resource are defined by
AdminHD and include:

Console Monitoring - one 4x4 plus one 8x8 resource are required to support the console's
standard stereo and surround control room monitoring.

Downmix  Matrix  -  one  8x8  matrix  is  required  to  for  each  surround  downmix.  Once
configured, matrices can be controlled from the GUI's Downmix display.

The amount of DSP resource is defined when you configure each MADI Port - for example, defining a
52-channel DALLIS leaves 12 free channels to support one 4x4 plus one 8x8 DSP resource:

To configure the application of the DSP resources:

1. Right-click on the DSP Resources in the 'Core Browser'.

A drop-down menu appears listing the available options. These vary depending on the number of
channels:
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2. Select an option to configure the resources:

Listen  stereo  or  Listen  surround  –  configures  matrices  for  the  console's  stereo  and
surround monitoring.

Matrix (4 * 4) or Matrix (8 * 8) – creates summing matrices. You will need a Matrix (8 * 8) to
define a downmix matrix.

3. To define a Matrix (8 * 8) as a downmix matrix, double-click to open its 'Parameter Box', and
tick the Downmix matrix option:

Once the configuration is uploaded to the system, you will be able to control the surround downmix
from the GUI's Downmix display.

To access the inputs and outputs of a matrix, the signals must be added to the Signal List
configuration (gui_config.tcl) using the 'Signal List Editor'.
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Core Configuration: Editing Parameters

This  section  looks  at  editing  the  system-wide  and  signal  parameters  stored  within  the  Core
configuration.

To add or remove a hardware component, see Defining the System.

Whether you want to change a system  or  signal  parameter,  the operation is  essentially  the same,
see Operating Principles: 'Parameter Box'.

For  details  on all  options,  see the Parameters  reference section.  Here we will  cover  some  of  the
most common editing tasks:

Signal names and labels

Device names (Alias names)

Control system IP address

Multi-channel sync

Operating levels

Maximum sample rate

Mapping Tables
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Signal Names and Labels

For  each individual  signal,  you can  edit  the  Name  and  default  Label.  These  appear  in  the  GUI's
Signal List display, and are also used by AdminHD's 'Connect Manager': 

mc2 Signal List display

The signal  Name  is  stored only  by the  Core  configuration,  and  cannot  be  edited  from  the
console GUI. It should be used to provide a "fixed" signal name relevant to the installation.

The signal Label is the label which the system resets to after a cold start. Users can change
labels later from the GUI's Signal List display, or from AdminHD's 'Connect Manager'. 

Both the Name and Label are limited to a maximum of 8 characters.

 To edit an individual name (or label):

1. Open the branches of the ‘Core Browser’ to reveal the signal you wish to edit.

2. Double-click on the signal – for example, Signal In 1.

The 'Parameter Box' opens:

3. Click in the Signal name (or Signal label) field, and type in the new name - you may enter up
to 8 characters.

4. Press Enter to confirm the name.
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 To edit a range of names (or labels):

Once you have selected the text in the Signal name  (or Signal label) field, you can use the PAGE
UP or PAGE DOWN keys (on your computer keyboard) to navigate up or down the system tree while
retaining the selected field. 

This short cut can be applied to any "name" field - for example, the Group name, Super-
device alias name, etc.

You can also press CTRL + C to copy, and CTRL + V to paste text between fields.

Alternatively, if you want to name a range of signals with the same suffix – for example, GUEST_01,
GUEST_02, GUEST_03, then you can use the Comfort Text Edit Mode:

1. Enable this mode from the Extras -> Datasheet -> Comfort Text Edit Mode main menu.

2. Name the first signal and leave your cursor in the "name" field:

3. Now press CTRL + SHIFT + PAGE DOWN.

AdminHD  steps  down  to  the  next  signal  in  the  system  tree  and  automatically  increments  the
suffix:

4. Repeat for all the signals in the range.
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Device Names (Alias Names)

For each component you may enter an alias name to help identify components in AdminHD.

The names are used only within AdminHD, and are not transferred to the remote control system.

You can display the alias names in the 'Core Browser' by enabling the Alias button on the toolbar:

Alias off Alias on

The alias names are also used by the 'Signal List Editor' (within the Hardware Tree), and if you use
the Generate Automatic Signal List button.

To enter an alias name:

1. Double-click on the component  -  e.g.  the Core  -  within  the 'Core Browser',  and select  the
Data tab in the 'Parameter Box':

2. Enter a name into the Core alias field.

If the field is left empty, then a default system name is used to describe each component.
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Control System IP Address

These parameters set the TCP/IP address of the control system (for the Lawo system network port -
Ethernet B).

 To edit the system's IP Address:

1. Double-click on the Core  within  the 'Core Browser',  and select  the Connection  tab in  the
'Parameter Box':

2. If  a  single  Router  Module is  fitted to  the Nova73,  then enter  the main  Remote  IP  address
only.

3. If  main  and  redundant  Router  Modules  are  fitted,  then  also  tick  Remote  IP  redundant
enable.  This  enables  the  redundant  Router  Module  and  automatically  sets  the  Remote  IP
address redundant - always 1 above the Remote IP address.

We  recommend  keeping  the  default  IP  address,  where  possible,  as  this  will  simplify  remote
maintenance. However, if your mc²56 MKII is part of a larger network, then it will need a unique IP.
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Multi-channel Sync

The Nova73 offers a fully redundant clock source structure, including the ability to lock to sync from
an incoming multi-channel signal.

 To define the multi-channel sync source:

1. Double-click on the Core within the 'Core Browser', and select the Data tab in the 'Parameter
Box':

2. Click on the Enable sync port box.

A pop-up appears where you can select the multi-channel sync source:

3. Select the source – for example, Module 4 Port 1 MADI - and click on OK.

The multi-channel sync source is displayed as a system address – for example:
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Operating Levels

These parameters specify the operating levels which the system resets to  after  a  cold  start.  Users
can change the levels later from the console GUI's System Settings display.

There are three level  settings  which interact  to  define the internal  and analogue-to-digital  operating
levels of the system:

Maximum Analogue Level = Reference Level + Headroom

The system supports a maximum analogue level = +24dB, and a minimum analogue level = +12dBu.

Warning

Changing the Reference Level or Headroom options move the internal 0dB operating
point for the system and therefore will change the behaviour of any level dependent
settings such as dynamics processing and metering. Therefore, it is not advisable to alter
these levels once dynamics processing has been set.

For systems fitted with fixed level analogue I/O cards:

The  Headroom  and  Reference  Level  cannot  be  altered  independently.  For
example,  with  a  +15dBu  fixed  analogue  I/O  card  and  +9dB  Headroom,  the
Reference Level must be +6dBu.

The Maximum Analogue Level of the whole system is defined by the DALLIS  card
with  the lowest  GDA (General  Device Address)  -  this  is  the card with  the lowest
address fitted to the DALLIS frame connected to the lowest port number of the first
Nova73.  (If  a  different  fixed  level  analogue  card  is  fitted  elsewhere  within  the
system, then a warning appears in  the log file;  however,  the card with  the lowest
GDA still wins.)

 To set the levels:

1. Double-click on the Core  within the 'Core Browser',  and select  the System settings  tab in
the 'Parameter Box':

2. Select the Analog full-scale level from the drop-down menu options.

3. Then set the Reference level by clicking on the up and down arrows.

The resultant Headroom is calculated automatically.
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Internal Sampling Rate

This  parameter  specifies  the internal  sampling frequency which the system  resets  to  after  a  cold
start. Users can change the sample rate later from the console GUI's System Settings display.

Note that the maximum sample rate (96kHz or 48kHz) is defined when you select the type
of Nova73.

 To set the internal sampling rate:

1. Double-click on the Core  within the 'Core Browser',  and select  the System settings  tab in
the 'Parameter Box':

2. Select the Sampling frequency from the drop-down menu option.

The available options are defined by your choice of Core.
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Mapping Tables

Lawo’s Remote MNOPL protocol is  a freely available Ethernet (TCP/IP) protocol providing control of
virtually any system parameter from an external device. 

A  typical  application  is  to  provide  third-party  matrix  control  so  that  crosspoints  within  the  mc²56
MKII’s  routing matrix can be controlled by external  control  systems  such as  VSM,  Evertz,  Quartz,
BFE, Pharos and others. (If your preferred supplier  does  not  support  the protocol,  then please ask
them to contact Lawo for further details):

Within your AdminHD configuration, each signal may be given a mapping address. Up to 16 different
mapping tables can be defined so that different control systems can be supported simultaneously.

 To configure the mapping tables:

1. Double-click on the Core within the 'Core Browser', and select the Map tab in the 'Parameter
Box':

2. For your chosen mapping table (01 to 16), enter the signal addresses which will be submitted
to the external control system:

unknown signal - submitted when an undefined source is connected to a defined destination.

no signal address - submitted when a signal is disconnected.

Please refer to your external control system’s documentation for details on which addresses to enter.
Our example shows the addresses for a Lawo zirkon control system.

3. Now select the first signal you wish to map to the controller, and select the Map tab.
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4. For your chosen mapping table (01 to 16), assign the Mapping table address:

The format of the address will be specified by your external control system.

5. Repeat for all the signals you wish to control from your external device.

6. You can get an overview of the assignments by selecting Extras  ->  Show Mapping Table
from the main menus. 

In our example, Mapping table 1 assigns signals to a Lawo zirkon system:
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Signal List Configuration

This section deals with how to edit and update a Signal List.

Signal  Lists  are  created  by  the  ‘Signal  List  Editor‘  and  stored  as  separate  .slx  files  to  the  Core
configuration (.csv file).

The 'Signal  List  Editor‘  can produce a cold  start  file  (gui_config.tcl)  to  modify  the  console  GUI's
Signal List display, or a signallist.slx file to customise the signals visible in the 'Connect Manager'.

The gui_config.tcl can ONLY be uploaded to the remote system's cold start data. This
means that you MUST be prepared to restart the mc²56 MKII in order to change its Signal
List configuration.

The  principles  are  similar  to  editing  the  Core  configuration  (config.tcl);  the  best  approach  is  as
follows: 

1. AdminHD  must  have  a  Core  configuration  with  some  relevant  signals.  Therefore,  first
download or open a Core configuration as described earlier.

2. Open the 'Signal List Editor' sub window.

3. If  possible,  download  the  existing  Signal  List  configuration  from  the  mc²56  MKII  control
system.

Alternatively, if you can't connect to the  mc²56 MKII, open an existing signallist.slx file. This may
be a file which you saved earlier or requested from your configuration engineer.

If  you have neither  a  network connection or  an existing signallist.slx  file,  then you will  need  to
create a new Signal List and build a configuration.

4. Save the configuration as a signallist.slx file - this allows you to  open it  later,  or  move it  to
another AdminHD computer.

5. Edit the Signal List.

6. Backup the system's existing cold start files.

7. Export the Signal List configuration as a gui_config.tcl file - this puts the data into  a format
which can be read by the control system.

8. Upload the gui_config.tcl file from your computer to the mc²56 MKII control system.

6. Cold start the mc²56 MKII to see your changes take affect.

Workflow Suggestion:

If you are making changes to both the Core and Signal List configurations, then download and save
both sets  of  data (config.csv  and signallist.slx)  while  you  are  connected  to  the  control  system.
Once editing is  complete,  export  both  cold  start  files  (config.tcl  and  gui_config.tcl),  and  upload
them to the control system. You can then perform a single cold start to action all your changes.
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The 'Signal List Editor'

The ‘Signal List Editor’ is used to download, create, edit and upload the Signal List configuration used
in the console GUI’s Signal List display or AdminHD's 'Connect Manager'.

1. Click on  from the main toolbar to show the ‘Signal List Editor’.

Or select Window -> Signal list editor (from the main menus) or press CTRL + SHIFT + S (on
your computer keyboard).

AdminHD analyses its Core configuration and opens the ‘Signal List Editor’ window:

AdminHD creates a new ‘empty’ Signal List each time you open the ‘Signal List Editor’. If you wish to
edit an existing Signal  List,  then either  download the Signal  List  configuration from  the mc²56 MKII
control system, or open an existing signallist.slx file.

The ‘Signal List Editor’ is divided into two pages – Source and Destination.

2. Click on the Source and Destination page tabs to change between pages.
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Each page has three columns:

1 Directories & signals This column displays the configured Signal List. 

Signals are organised into directories and subdirectories which
may be added and renamed as you wish. Use the + and – signs to
open and close branches of the Directories & signals column to
interrogate the configured signal list.

2 Hardware Tree This column lists all the signals within the Core configuration. The
list uses the alias names (if entered). Otherwise,  default system
names are used to describe each component – for example, 
MO4PO1DAL60:

MO4 – indicates the Nova73 Module (e.g. Module 4).

PO1 – indicates the port on the Module (e.g. Port 1).

DAL60 - indicates the device on the port (e.g. a DALLIS
Device with 60 audio channels).

Use the + and – signs to open and close branches of the
Hardware Tree. Click on an individual signal, or a card, and the
signal(s) appears in the third column - Selected signals.

3 Selected signals This column is used to build a list of signals, which you can add to

the selected subdirectory using the  button. Signals in red are
already used somewhere within the configuration; those in black
are not.

For more details, see Editing a Signal List.
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The Signal List Editor Toolbar

The toolbar, at the top of the 'Signal List Editor', is used to action most of the editor's functions. 

Note  that  buttons  are  "greyed  out"  if  they  are  unavailble  -  for  example,  you  cannot  Add  a  new
directory (12) if you have a signal selected in the Directories & signals column.

1 New Creates a new signal list.

2 Open Opens an existing Signal List file (signallist.slx).

3 Save Saves the current Signal List configuration as a signallist.slx file.

4 Save as Saves the current configuration under a new filename.

5 Export Exports the current Signal List configuration as a cold start gui_config.tcl
file.

6 Download Downloads the Signal List configuration from the mc²56 MKII control system
into AdminHD.

7 Copy Copies the selected signal or directory, from the Directories & signals
column, to the clipboard.

8 Cut Cuts the selected signal or directory from the Directories & signals
column.

9 Paste Pastes the clipboard data to the selected directory in the Directories &
signals column.

10

11

Move up

Move down

Moves the position of a signal or directory in the Directories & signals
column.

12 Add directory/
subdirectory

 Adds a new directory to the Directories & signals column.

13 Delete Deletes the selected signal or directory from the Directories & signals
column. 

14 Locate signal Select a signal within the Directories & signals column, and then click this
button to locate its position within the Hardware Tree.

15 Generate
automatic
tree view 

Adds the directories and signals from the Hardware Tree into the
Directories & signals column. Use this button to quickly generate a Signal
List from your hardware components.

16 Update
hardware
signal config

Updates the Hardware Tree column if you make changes to the Core
configuration while the ‘Signal List Editor’ is open.

17 Duplicate
directory
structure

Copies the directory structure, within the Directories & signals column,
from the Source to the Destination page (or vice versa).
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Downloading the Signal List

The best way to ensure that you are working with your system's latest data, is to download the Signal
List configuration, from the mc²56 MKII.

To perform a successful download, you will need a valid network connection between your computer
and the control system.

Open the 'Remote Log' to monitor the progress of the download. 

1. Click on  (Download GUI signal list config) from the 'Signal List Editor' toolbar.

2. If you have made changes to the current Signal List, then the following dialogue box appears:

Select Yes to save the configuration (as a .slx file) before proceeding.

Select No to continue without saving.

AdminHD downloads the configuration data from the remote system; the 'Remote Log' reports on
the progress.

When the download is complete, the 'Signal List Editor' updates:

If there is a problem with the download, then:

o Check the network connection and TCP/IP  settings  of  your  computer's  network interface
card. 

o Check that AdminHD is compatible with the mc²56 MKII system.

o See the trouble-shooting tips.
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Opening a Saved Signal List

To open an existing signallist.slx file:

1. Click on  (Open signal list config) from the 'Signal List Editor' toolbar. (If you have made
changes to the current Signal List, then you will be asked if you wish to Save the changes first).

2. Select your file and click Open:

The file opens, and the path and file name appear at the top of the 'Signal List Editor' window:

If there is a problem opening the file, then check:

Is the file an AdminHD .slx ?

Was the file saved by a newer release of AdminHD?

Configurations saved by an earlier version of AdminHD can be opened in  a  later  release.
However, configurations saved by a newer release are not backwards compatible.

Does the file contain signals which are not supported by the current Core configuration? If so,
then some parts of the Signal List may not load.
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Creating a New Signal List

A new  ‘empty’  Signal  List  is  created each  time  you  open  the  ‘Signal  List  Editor’.  However,  if  you
already have a Signal List open, and wish to clear its data, create a new file as follows:

1. Click on  (New Signal List Config) from the 'Signal List Editor' toolbar.

A new list is  created, in the Directories &  signals  column,  which includes  the system's  default
directories and an unnamed entry (New_dir_001 and New subdir_001).

In the Hardware Tree column, you will see all the signals available within your Core configuration:

Use the Generate automatic tree view from config button to quickly generate a Signal List
from your Core configuration.
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Default Directories

For the mc2 mixing consoles, you will see some default Source  and Destination  directories  which
cannot be edited or deleted. 

These provide access to the console's channel DSP resources (Input/Mon A+ B, Bus Out, Direct
Out,  Insert  Send/Return),  and  other  options  dependent  on  your  Core  configuration  (mxDSP
Signals and Plugin Server):

Source Page Destination Page

You can select whether the Input/Mon A + B directory appears from the Extras ->
Preferences -> Signal List Editor menu.

You will only see the mxDSP Signals directory if an mxDSP module has been added to
the Core configuration. Similarly, you will only see the Plugin Server directory if a MADI I/
O Port has been defined for the plugin server.
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Saving the Signal List

Having downloaded, opened or created a new  Signal  List,  it  is  a  good idea to  save the data as  an
AdminHD  signallist.slx  file.  This  will  allow  you to  open the file  later,  move it  to  another  AdminHD
computer, or import it into the 'Connect Manager'.

1. Click on either  (Save) or  (Save as) from the 'Signal List Editor' toolbar:

Save overwrites the current file name (if one exists).

Save as asks for a new file name:

2. Select a path and enter a suitable file name. 

You can use any name as long as it keeps the .slx suffix. As the Signal List relates to the
Core configuration (.csv file), it is a good idea to store the two files in the same location.
See Organising Your Files.

3. Click Save to save the Signal List configuration onto your computer’s hard disk.

4. From here on, you can quickly update the file by clicking on  (Save).
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Editing a Signal List

The current Signal list configuration is shown in the Directories & signals column. Directories and
subdirectories can be added and named as you wish. Signals can then be added to subdirectories as
follows:

Note that:

The Signal  List  structure supports  three levels:  directories,  subdirectories  and  signals;  you
cannot configure additional  levels  or  add signals  directly to  directory.  These restrictions  are
required in order to support the GUI's Signal List display.

The  'Signal  List  Editor'  can  add,  remove  and  rename  directories  and  subdirectories,  and
organise signals into subdirectories. To rename the signals themselves,  use the 'Parameter
Box' to edit the Signal name field.

You can add a signal to more than one subdirectory.

Some tips:

Keep the 'Signal List Editor' open, while adding components to  the Core configuration.  Then
use the Update hardware signal config button to refresh the Hardware Tree.

You can generate a signal list automatically from the Core configuration. This is a quick way of
getting a useful starting configuration.

Use Copy, Cut and Paste to duplicate or move subdirectories.

Use the duplicate directory structure function to copy the structure of your Source  directories
to the Destination page, or vice versa.

The context menu (available from a right-click in the Directories & signals column) offers a
number of keyboard shortcuts.
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Adding & Naming Directories & Subdirectories

 To add a new directory, or subdirectory:

1. Select a position in the Directories & signals column.

2. Right-click and select Create new directory:

The new directory, or subdirectory, is added below your selection and given a default name.

Note that the Signal List structure supports three levels: directories, subdirectories and
signals; you cannot configure additional levels.

 To rename a directory, or subdirectory:

1. Double-click on the existing name.

 The text is highlighted:

2. Type in the new name on your computer keyboard and press Enter - you may enter up to 16
characters. 

For easy operation from the GUI's Signal List display, try and keep the names as short as
possible.
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Adding Signals to a Subdirectory

To add signals to a subdirectory:

1. First, use the Hardware Tree  to build up a list of signals in the Selected signals  column -

you can select single or multiple signals, and use the  button to edit the Selected signals list.
See Selection tips.

2. Once you are happy with the Selected signals content, click on the  button to add all the
Selected signals to your subdirectory:

Note that you can click the  button multiple times if you wish.

Note that in the Selected signals column, signals in red are already used somewhere within the
configuration; those in black are not.
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Selection Tips and Tricks

When adding signals, you can use the following tips and tricks to edit the contents of  the Selected
signals column.

(The same tips can be used when deleting signals, but you would make selections in the Directories
& signals column.)

To select all the signals from a card, click on the card within the Hardware Tree  - all signals
within the card are added to the Selected signals list.

To select a range of consecutive signals or cards,  select  the first  signal  or  card;  press  and
hold SHIFT (on your computer keyboard), and then select the last signal or card - all signals
within the range are added to the Selected signals list:

To  select  non-consecutive  signals  or  cards,  press  and  hold  CTRL  (on  your  computer
keyboard) and then click on the signals or cards. As long as you continue to  hold the CTRL
button, your selections accumulate within the Selected signals list:

To remove a signal, from the Selected signals column, select the signal and click on the 
button. Note that this function only edits what is in the Selected signals column. If you wish to
remove a signal from a subdirectory, then see deleting signals.
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Deleting Signals, Subdirectories & Directories

 To delete signals from a subdirectory:

1. Select the signals, from the Directories & signals column, see Selection tips and tricks.

2. Right-click and select Delete:

3. Confirm by clicking Yes.

The selected signals are deleted from the Signal List.

 To delete directories or subdirectories:

1. Select the directory or subdirectory, from the Directories & signals column. You can make
multiple selections if you wish, see Selection tips and tricks.

2. Right-click and select Delete:

3. Confirm by clicking Yes.

Note that deleting a directory deletes all subdirectories and signals within it.
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Editing the Position of Signals, Subdirectories & Directories

 To move the position of a signal, subdirectory or directory:

1. Select the signal, directory or subdirectory, from the Directories & signals column.

2. Right-click and select Move up or Move down:

Or, click on the  or   (Move node) buttons from the 'Signal List Editor' toolbar.

The selection moves accordingly.
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Copy, Cut and Paste

The Copy, Cut and Paste functions provide a quick way to edit your signal list. For example:

 To cut a subdirectory from one directory to another:

1. Select the subdirectory you wish to copy from the Directories & signals column.

2. Right-click and select Cut:

Or, click on the   (Cut) button from the 'Signal List Editor' toolbar.

The selected subdirectory is copied to the 'Signal List Editor' clipboard.

3. Now select the directory where you want to paste the selection.

4. Right-click and select Paste:

Or, click on the   (Paste) button from the 'Signal List Editor' toolbar.

The selected subdirectory is pasted accordingly, along with all of its contents.

Directories and subdirectories may be copied and pasted in a similar manner.
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Duplicating the Source/Destination Directory Structure

This function copies the structure of your Source directories to the Destination page, or vice versa.
It can be very useful if you wish to use similarly named directories and subdirectories in your Source
and Destination lists.

1. First, edit either your Source (or Destination page):

2. Then click  on the   (Duplicate directory structure) button,  from  the 'Signal  List  Editor'
toolbar, to copy the directory structure to the alternate page:

Note that  you  can  click  the   button  multiple  times  if  you  wish  -  the  structure  is  duplicated
multiple times.
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Updating the Hardware Tree

This  function  forces  the  'Signal  List  Editor'  to  re-analyse  the  Core  configuration  and  update  the
signals in the Hardware Tree. 

You should use it  if  you have added components  to  the  Core  configuration,  while  the  'Signal  List
Editor' has been open.

1. To perform the update, click on the  (Update hardware  signal  config)  button from  the
'Signal List Editor' toolbar.

The system analyses the Core configuration, and the Hardware Tree updates.
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Locating a Signal within the ‘Signal List Editor’

To quickly locate the hardware position of a signal:

1. Select the signal from the Directories & signals column.

2. Click on the  (Locate signal) button from the 'Signal List Editor' toolbar.

The Hardware Tree opens to show the location of the signal:
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Generating a Signal List from the Core Configuration

This operation adds all the directories and signals from the Hardware Tree into the Directories &
signals column, and can be used to quickly generate a Signal List from your hardware components.

It is a good idea to add this structure below your "user" directories, so that service
technicians can easily locate signals using the Hardware Tree naming structure.

1. Click on   (Generate  automatic tree  view  from config)  from  the  'Signal  List  Editor'
toolbar.

All the directories and signals from the Hardware Tree are added to the bottom of the Directories
& signals column:

The  structure  uses  the  alias  names  (if  entered).  Otherwise,  default  system  names  are  used  to
describe each component – for example, MO4PO1DAL60:

MO4 – indicates the Nova73 Module (e.g. Module 4).

PO1 – indicates the port on the Module (e.g. Port 1).

DAL60 - indicates the device on the port (e.g. a DALLIS Device with 60 audio 

2. The button may be selected multiple times to repeat the structure.

For example, you might add the structure twice; leave the lower structure unchanged (for
your "service view"), and then edit the upper structure to provide more "user friendly"
directory and subdirectory names.
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Exporting the Cold Start gui_config.tcl

To update the Signal  List  configuration on a mc2  mixing console,  you must  export  the  'Signal  List
Editor' contents, as a gui_config.tcl file, in preparation for a cold start upload.

If you have also edited the Core configuration, then export and upload both cold start files
(config.tcl and gui_config.tcl).

1. Click on the   (Export to cold start config) button from the 'Signal List Editor' toolbar.

2. You are asked to specify a folder location for  the file  -  in  our  example,  we have chosen the
Studio 2 folder created earlier, see Organising Your Files.

Do NOT rename the file; it must be named gui_config.tcl in order to be read by the
control system.

You can specify a default directory for your Coldstart config files from the Extras ->
Preferences -> Common Directories menu.

3. Click Save.

The configuration is exported from the 'Signal List Editor' and saved on your computer.
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Uploading the Cold Start gui_config.tcl

Having exported the gui_config.tcl file, it may now be uploaded to the mc²56 MKII control system.

This operation is similar to uploading the cold  start  config.tcl  file,  except  this  time upload the GUI
cold start config (gui_config.tcl):

If you have edited both the Core and Signal list configurations, then you should export and
upload both cold start files (config.tcl and gui_config.tcl).

You will need to cold start the mc²56 MKII to see your changes take affect.
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Online Operation

You should switch AdminHD online, in order to:

Monitor the status of your remote system.

Control matrix crosspoints, signal labels and I/O settings via the 'Connect Manager'.

Update the online configuration (in memory) - available for the Core configuration only.

Note that you will need a valid network connection between your computer and the mc²56 MKII control
system.

 To switch between modes:

1. Click on  from the main toolbar (Online/Offline to remote system).

Or select Remote -> Online/Offline to remote system (from the main menus).

When switching online, AdminHD connects to and synchronises with the system. The IP address
of the connected host  is  displayed in  the Status  bar  and the 'Core Browser'  and 'Graphic  View'
update:

If the connection fails, then the ‘Remote Log’ will report that the connection has timed out:

Check  the  network  connection  and  TCP/IP  settings  of  your  computer's  network  interface
card. 

Check that AdminHD is compatible  with  the mc²56 MKII system  (the first  three digits  of  the
software versions must match.)

See also the trouble-shooting tips to resolve the problem.
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2. Click on the same button , to switch offline.

3. Select  Remote  ->  Reconnect  mode  (from  the  main  menus),  if  you  wish  AdminHD  to
reconnect to the remote control system if network communication is interrupted.



V4.24/1204 mc²56 MKII Technical Manual

Chapter 3: AdminHD
System Diagnostics

System Diagnostics

Once AdminHD is running online, you can use the 'Core Browser' and 'Graphic View' to monitor the
real-time status of hardware components:

All components are monitored, including the status of the Nova73, DALLIS units and their PSUs.

Components which are operating normally are coloured green; faulty components are highlighted in
red. In our example above,  one of  the DALLIS  plug-in  cards  is  missing or  faulty.  Check the card's
connections, and if necessary replace the card.

In addition, the 'Remote Log' records all  messages  generated by AdminHD  and the online system.
You can save the contents of the 'Remote Log' to help diagnose any errors.
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The System Message Log

The  mesages  logfile  is  generated  and  stored  by  the  control  system  during  operation.  It  can  be
downloaded from remote system and saved on your computer using AdminHD.

Note that this is the one of the system logfiles which can also be copied to  USB,  from  the console
GUI, using the File display, or monitored using the Web Browser Interface.

To download the logfile:

1. Select Remote -> Download file -> System log messages from the main menus:

A ‘Save As’ file selection box appears.

2. Select a folder location and enter a filename:

You can specify a default directory for your Core logfiles from the Extras -> Preferences -
> Common Directories menu.

3. Click Save.

AdminHD downloads the file.

The log is stored as a plain text file, and can be opened by any common text editor.
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The ‘Connect Manager’

The ‘Connect  Manager’  can be  used  to  control  matrix  crosspoints,  signal  labels  and  I/O  settings
within  your  remote system.  And save and recall  snapshots  -  a  snapshot  stores  connections  to  or
from a signal, the signal’s label and I/O parameter values. 

Note that online mode must be enabled, in order to open the 'Connect Manager'.

The end-user  operation  is  identical  for  both  AdminHD  and  ControlHD.  Therefore,  please  see  the
separate “ControlHD User Manual” for full details on operation.

To determine which signals  are "seen"  by the 'Connect  Manager',  ControlHD  opens  a  Signal  List
(signallist.slx file). By creating different Signal Lists for different ControlHD clients, you can provide
users with access to different parts of the matrix.
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The Connect Manager Toolbar

1 Open Opens a Signal List file (signallist.slx) from your computer.

2 Export Exports a list of all matrix connections as a .csv file.

3 Update
hardware
config

Updates the Source and Destination signals if you have made changes to
the Core configuration while the 'Connect Manager' is open.

4 Connect Click to connect the selected source to the selected destination.

5 Disconnect Click to disconnect the selected destination.

6 Overwrite
Lock

When enabled, you are asked to confirm each Connect and Disconnect
operation.

7 Easy Step
Mode

When enabled, the 'Connect Manager' automatically steps down to the next
source/destination after a Connect occurs. This is similar to Step mode on
the console GUI's Signal List display.

8 Special User
Label Edit
Mode

When enabled, you can edit signal labels incrementally (e.g. Guest_01,
Guest_02, Guest_03, etc.) This is similar to Easy Edit mode on the GUI's
Signal List display.

9 Clear all
snapshot
flags

Click to clear all the snapshot selection flags (blue flags).

Please see the separate “ControlHD User Manual” for full details on operation.
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Exporting a Connection List

You can export a list of all matrix connections from the 'Connect Manager' as a .csv  file. This can be
opened by a 3rd party editor, such as MS Excel, to check which connections are made or document
the system.

To export the connection list:

1. Click on  (Export connection list) from the 'Connect Manager' toolbar.

Note that the button only becomes available once a connection made.

2. Select a folder location and enter a filename:

3. Click Save.

The connection list is stored as a .csv file on your computer.
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Documenting the Configuration

AdminHD  provides  two  tools  to  help  document  the  system  once  you  have  programmed  your
configuration:

Copy Image / Write Image to File

Export a Component List
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Copy Image / Write Image to File

You  can  save  the  graphical  images  used  within  AdminHD  to  help  document  your  system  -  for
example, to save the front panel configuration of your Nova73 and DALLIS.

Saving the 'Graphic View'

1. Open the 'Graphic View' and hover your mouse over the frame of the Core or DALLIS.

The frame is outlined in orange.

2. Right-click and select one of the drop-down options:

copy image to clipboard - saves the graphic to your computer's clipboard. 

write image to file - saves to graphic as a .png image file. You are asked for a folder location
and filename.

Saving the 'Console Panel'

This is similar to above, but saves the image of the console front panel. Note that the 'Console Panel'
can only be used to  configure MKI  mc266  systems,  and  does  not  represent  your  control  surface
configuration for the mc²56 MKII.
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Export a Component List

You can export a component parts list as a .csv  file. This can be opened in a 3rd party editor, such
as MS Excel.

To export the list:

1. Select File -> Export file -> Component list from the main menus:

2. Select a folder location and enter a filename:

3. Click Save.

The component list is stored as a .csv file on your computer.
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Core Configuration: Parameters

This section covers all the Core configuration parameters for the mc²56 MKII system.

Please see First Steps, Defining the System and Editing Parameters for the operating principles.

Component and signal parameters are covered according to their hierarchical order within the 'Core
Browser' System. For more details on functionality, please consult the relevant data sheet, available
in the "mc2_Nova73_documentation" guide.

In  each  case,  you  should  open  the  'Parameter  Box',  for  the  component  or  signal,  to  access  its
parameters:
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System

ID Usually all Lawo projects receive a project ID, made up of 6 integers. You
can log your project ID here; you may be asked for it when servicing your
product. The field can be left blank.

System alias Enter an alias name for the System.
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Core

Parameters for the Core are divided into pages:

Core -> Connection

Core -> Data

Core -> System Settings

Core -> Map

Core -> Network

Core -> Plugin Server
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Core -> Connection

These parameters define the TCP/IP address of the mc²56 MKII control system.  See Editing the IP
Address for details.
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Core -> Data

Core alias Enter an alias name for the Core.

Router module model
number

Router module type

These fields are for information purposes only and cannot be edited. They
show the serial number and type of Router Module. The type of Router
Module is defined when you add a Core to the System (in the 'Core
Browser').

Router module This box should always remain ticked, as every Core requires at least
one Router Module.

Redundant router
module 

Tick this box to add a redundant Router Module to the Nova73.

Redundant PSU Tick this box to add a redundant PSU to the Nova73.

Black burst
synchronised
switching

Tick this box to make matrix cross point switching synchronous to an
external Black Burst sync source.

Internal sync activates
alarm

Tick this box to activate the Global Alarm if the system switches to
internal sync.

Enable sync port Tick this box to enable the multi-channel sync port. A pop-up appears
asking you to select the sync source, see Multi-channel Sync.

Multi-channel sync
port

This box displays the multi-channel sync port source as a system
address (if Enable sync port is active).
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Core -> System Settings

Analog full-scale level
(dBU)

This option sets the analogue level which corresponds to digital full scale
level (0dBFS). You can select 12, 15, 18, 21 or 24 dBu.

Reference Level
(dBU)

This field sets the internal reference level of the system. The maximum
reference level is 24dBu.

Headroom (dB) The resultant headroom is calculated from the first two options. See 
Operating Levels for details.

Sampling Frequency This parameter sets the internal sampling frequency which the system
resets to after a cold start. See Internal Sampling Rate for details.

Disable Global Alarm Tick this box is you wish to disable the Global Alarm.
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Core -> Map

These parameters are used if you wish to  control  matrix crosspoints  from  an external  device.  See
Mapping Tables for details.
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Core -> External

These parameters are used to connect an external  file  server  to  the system.  Once configured,  the
server is available to users via the console GUI's File Import/Export page.
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Core -> Network

HLSD index This  parameter  is  used  if  your  Core  is  part  of  a  larger  network,  see
Networking I/O Resources.
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Core -> Plugin Server

IP Address Plug-in
Server

Enter the IP Address of the optional Plugin Server.

The default address is shown above.
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Modules

Parameters for a Module depend on the module type:

I/O, & Channel DSP Module Parameters Matrix DSP Module Parameters

Module alias Enter an alias name for the Module.

Slot number

Module model
number

Module type

These fields are for information purposes only and cannot be edited. They
show the Slot number used in the Core, and the serial number and type of
module, see Nova73 Module Options.

Config-ID On the 983/03_007 mxDSP module, this parameter defines how the matrix
DSP is configured. See mxDSP configuration for details.

Backplane
Hardware

On the 981/02 AES3 module, this parameter defines the rear connector
panel (either D-Sub or BNC).
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Ports

Parameters for a Port depend on the port type:

MADI, ATM & RAVENNA Port Parameters AES Port Parameters

Port Number

Interface type

These fields are for information purposes only and cannot be edited. They
show the logical port number, which is dependent on the module's slot
position in the Core, and the interface type (MADI, RAVENNA, etc.)

Is redundant Tick this box to enable port redundancy. You will be prompted to select the
redundant port.

Corresponding port Shows the system address of the linked port, if Is redundant is enabled.
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Super-Device

Super-Device is the generic term used to describe the I/O port's definition: DALLIS, Tie-Line, etc.

Tie-Line, Plugin Server and Local I/O all display similar parameters; DALLIS frames display some
additional options.

Tie-Line, Plugin Server & Local I/O Parameters DALLIS Parameters

Super-device alias Enter an alias name for the DALLIS,Tie-Line, Plugin Server, etc.

Model number &
Type

These fields are for information purposes only and cannot be edited. They
describe the serial number (of a DALLIS frame) and the type of Super-
device.

Redundant PSU Tick this box to add a redundant PSU to the DALLIS frame.

Audio channels IN
left

Audio channels
OUT left

These two boxes cannot be edited and show the number of 'free' audio
channels left in the DALLIS frame. These are channels which could be used
by fitting additional plug-in cards.)
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Cards

Parameters for the DALLIS Cards depend on the card type. Below are two examples. See also SDI
Parameters.

941/53 Mic Card Parameters 924/02 Line Card Parameters

Device alias Enter an alias name for the card.

Model number 

Typename

Slot number

Interface type

These fields are for information purposes only and cannot be edited. They
show the serial number and type of card, the slot position within the DALLIS
frame, and the interface type.

Monitoring device For 942/02 and 942/12 cards only.

Tick this box to release the card from the system reference level, if the card
is to be used for monitoring.

For details on an individual card's parameters, please refer to the relevant data sheet available in the
"mc2_Nova73_documentation" guide.
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Signals

Parameters for Signals are divided into pages:

Signal In -> Signal

Signal Out -> Signal

Signal In/Out -> DSP

Signal In/Out -> Map
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Signal In -> Signal

Signal  In  parameters  depend  on  the  type  of  signal  (Mic,  Line,  AES,  SDI,  etc.).  Below  are  two
examples. See also SDI Parameters.

Mic Signal In Parameters AES Signal In Parameters (with SRC)

HLSD High Level Signal Definition - this is the Lawo system address for the
signal. It MUST be unique, and normally you should not modify this address
from its default setting.

Signal name This is the system name of the signal. It can only be defined by AdminHD,
and should be used to provide a "fixed" signal name relevant to the
installation.

Signal label This is the user label which the system resets to after a cold start. Users
can change labels later, from the console GUI's Signal List display, or from
AdminHD's 'Connect Manager'. 

Group This is the group name for the signal. It can be used when interfacing to an 
external controller. Please refer to your external system’s documentation for
details on how to implement the group name.

SRC For AES cards with SRC only.

Tick this box to enable the sample rate converter. Users can change this
parameter later, from the console GUI's Signal Settings display.

For details on an individual card's parameters, please refer to the relevant data sheet available in the
"mc2_Nova73_documentation" guide.

To make a digital path suitable for Dolby E operation, you should turn off the I/O DSP for
both the input and output, and disable any sample rate conversion.
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Signal Out -> Signal

Signal Out parameters depend on the type of signal (Line, AES, SDI, etc.). Below are two examples.
See also SDI Parameters.

Line Signal Out Parameters AES Signal Out Parameters (with SRC)

HLSD See Signal In: HLSD.

Signal name See Signal In: Name.

Signal label See Signal In: Label.

Group See Signal In: Group.

Sampling frequency

Word length

SRC

For AES cards with SRC only.

Sets the sample rate and word length for the output.

Note that the SRC field cannot be edited and shows the status of the sample
rate converter. To disable the SRC, you must set the Sampling frequency
to System and Word length to 24-bit. For all other combinations, SRC is
always enabled.

Users can change these parameters later, from the console GUI's Signal
Settings display.

AES consumer
format

For AES cards released after 2006.

Sets the channel status of the AES output to either Consumer or
Professional. Please refer to the AES3 standard definition for details.

For details on an individual card's parameters, please refer to the relevant data sheet available in the
"mc2_Nova73_documentation" guide.

To make a digital path suitable for Dolby E operation, you should turn off the I/O DSP for
both the input and output, and disable any sample rate conversion.
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Signal In/Out -> DSP

These parameters  adjust  the I/O  DSP and Silence Detect  alarms.  Note that  not  all  cards  support
these parameters.

Signal In -> DSP Parameters Signal Out -> DSP Parameters

Signal In: I/O DSP

I/O-DSP Tick this box to enable the I/O DSP. Once enabled, the following parameters
become active:

Offset (dB)

Digital gain (dB)

Enter an offset and/or digital gain value in dB. The resultant gain (Offset +
Digital gain) is applied to the signal within the I/O card, and therefore affects
all destinations.

The two separate parameters (Offset and Digital gain) allow you to apply a
‘permanent’ and a ‘temporary’ gain change. For example, to compensate for
a low level line input, use the Offset parameter to apply a ‘permanent’ gain
change. In addition, for today’s production you may also need to compensate
for a badly recorded signal; for this ‘temporary’ adjustment, use the Digital
gain. At the end of the production, you can easily reset the Digital gain to 0
dB while keeping the Offset gain intact.
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Signal Out: I/O DSP 

Mono matrix Tick this box to enable the mono matrix settings and link the output signal to
its odd/even partner.

When the mono matrix is enabled, you can then adjust the following
parameters:

Mono matrix mode The mode can be set to:

Channel mix – sums the left and right inputs and routes the mono
sum to both left and right outputs. 

Channel swap – routes the left input to the right output and vice versa.

Left to both – routes the left input to both outputs.

Right to both – routes the right input to both outputs.

Mono attenuation
left channel (dB)

When working in Channel mix mode, you can set attenuation (e.g. -3dB) to
compensate for the mono sum. This is applied to the left output signal.

To make a digital path suitable for Dolby E operation, you should turn off the I/O DSP for
both the input and output, and disable any sample rate conversion.

Silence Detect Alarm

These parameters  can be applied to  inputs  and/or  outputs,  to  trigger  an alarm  state  if  signals  fall
below  a  certain  threshold  level.  The  silence  detect  alarms  can  be  output  to  an  external  control
system, via Lawo’s Remote MNOPL protocol, or monitoring using the Web Browser Interface.

Silence detect Tick this box to enable the Silence Detect alarm for the signal.

Stereo link for
Silence Detect

Tick this box to link the left and right sides of a stereo input or output for
'Silence Detection'. When linked, the alarm is only issued if both signals fall
below the Threshold level.

Only odd and even adjacent signals may be linked.

Threshold (dBFS) Set the threshold below which the Silence Detect alarm will be triggered.
The level can be adjusted in 0.25dB steps and is referenced to digital full
scale level (dBFS).

Attack Time (sec) This sets the length of time for which the signal must fall below the 
Threshold level before the Silence Detect alarm is activated. The time is
set in steps of 1 second.

Release Time (sec) This sets the length of time for which the signal must remain below the 
Threshold level before the Silence Detect alarm is cancelled. The time is
set in steps of 1 second.
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Signal In/Out -> Map

These parameters set the signal’s address for each of the mapping tables 1 to 16.  You should use
these parameters to map a signal to an external controller, see Mapping Tables.
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mxDSP Configuration

This section covers additional notes for the mxDSP module (983/03-007).

An mxDSP module provides a pool of DSP resource which may be applied to signal paths within the
routing matrix. For example, to apply fixed DSP settings to line arrays. 

Physically, each mxDSP module is identical to a normal channel DSP board and occupies one slot
within  the  Nova73.  However,  rather  than  DSP  channels,  which  can  be  assigned  to  the  console
surface, the mxDSP provides DSP “chains”  which can be viewed and controlled from  the mxDSP
Settings display. 

Several configuration options are supported, providing up to 192 DSP chains plus  a 64 x 64 mixing
matrix per  module.  The  DSP  chains  are  configured  from  various  elements  including  level,  mute,
delay,  EQ,  etc.  The number  of  DSP chains,  and their  signal  flow,  is  determined  by  the  AdminHD
configuration:

To configure a 983/03 DSP board for mxDSP operation, the following steps are required:

1. Edit the Core configuration using AdminHD.

2. Edit the Signal List configuration using AdminHD.

3. Update the cold start configuration (config.tcl and gui_config.tcl) using AdminHD.

4. Update the firmware on the mxDSP module via a Telnet session.
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Editing the Core Configuration

1. Download  the  online  Core  configuration  to  make  sure  that  you  are  editing  the  latest
configuration data.

2. Select the slot and change the module type to 983/03-007 mxDSP:

3. Open the module's ‘Parameters Box’ and select an option from the Config-ID menu:

These options determine the number, and signal flow, of the DSP chains, see Config-ID Options.
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Config-ID Options

The Config-ID defines the signal flow of the DSP chains, and whether the card supports the 64 x 64
mixing matrix:

 Standby

Select  this  option  to  run  the  mxDSP  module  in  standby  mode.  Use  this  mode  to  configure  a
redundant mxDSP module.

 Playout (no PPM)

This option provides 184 channels of DSP only (no mixing matrix):
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 Universal

This option provides 154 channels of DSP plus the 64 x 64 mixing matrix:

 Universal (no PPM)

This option provides 154 channels of DSP plus the 64 x 64 mixing matrix:
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 Line Control

This option provides 184 channels of DSP plus the 64 x 64 mixing matrix:

 Line Control (no PPM)

This  option provides  184 channels  of  DSP,  as  above,  but  with  less  system  resources,  similar  to
Universal (no PPM).
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Editing the Signal List

In  order  for  the DSP  chains  to  appear  within  the  console  GUI's  Signal  List  display,  the  mxDSP
module must be added to the Signal List configuration (gui_config.tcl).

Having added the mxDSP module to the AdminHD configuration:

1. Download the existing Signal  List  to  make sure that  you are editing the latest  configuration
data.

2. Click on the Update hardware signal config button.

The mxDSP signals from the newly configured card are added to the existing Signal List:

3. You can organise the signals, and name and label them, in the usual  manner  See Editing a
Signal List.
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Updating the Cold Start Configuration

1. Export and upload both of the cold start configuration files (config.tcl and gui_config.tcl), in
the usual manner.

2. Cold start the mc²56 MKII control system so that the new configuration data is active.

You can check the configuration by opening the console GUI's  mxDSP Settings  and  Signal  List
displays.
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Updating the Firmware

Before the mxDSP module will operate correctly, its software must be updated:

1. Using a computer connected to the Lawo system network, open a telnet session to the mc²56
MKII control system.

2. At the main control system prompt, type mcxsh and press Enter.

This opens the mcx shell programme.

3. Then type the command mcx_software_auto_update and press Enter.

The software on each card is automatically updated according to the Core configuration:

The mxDSP module is now ready for operation.
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The 'Console Panel'

The 'Console Panel' can be used to edit the control surface layout for a MKI mc266 system (classic
or top1), and export a cold start Console Configuration (console_config.tcl) file.

For all other mc2 systems, the console_config.tcl must be factory-configured. Please
contact your local Lawo representative or email service@lawo.de if you require further
assistance to modify its configuration. In these systems, do NOT attempt to use the
'Console Panel' to generate a new.tcl file, as the control system cannot read the data.

The console_config.tcl file is not required for a stand-alone Nova73.

You can use AdminHD to upload a console_config.tcl file on any mc2 system. This could
be a file emailed to you from Lawo service.

mailto:service@Lawo.de
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Editing the Control Surface Configuration (MKI mc266)

1. Click on  from the main toolbar to show the ‘Console Panel’.

Or select Window -> Console frame  (from the main menus) or press CTRL + SHIFT  +  O  (on
your computer keyboard).

An image of the MKI mc266 control surface configuration appears:

2. Select the console frame size from the drop-down menu (e.g. 24+8+24).

The window updates accordingly.

3. If your console frame is larger than the fader panels fitted, then right-click on the fader  panel
you wish to remove and deselect the Assign fader panel to slot option.

The display updates to show the blank fader panel.

4. You can save changes to the ‘Console Panel’ configuration by selecting File -> Save or File  -
> Save As from the main menus.

The  ‘Console  Panel’  configuration  is  stored  with  the  rest  of  the  Core  configuration  within  the
config.csv file.

5. Now export the configuration, by clicking on the Export  config  button at  the top right  of  the
‘Console Panel’ window:
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6. Select a folder location and click Save:

Do NOT rename the file; it must be named console_onfig.tcl in order to be read by the
control system.
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Uploading the Cold Start console_config.tcl

This  operation  is  similar  to  uploading  the  cold  start  config.tcl  file,  except  this  time  upload  the
Console cold start config (console_config.tcl):

You will need to cold start the mc²56 MKII to see your changes take affect.
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Chapter 4: Service/Maintenance

Introduction

This  chapter  covers  service  and  maintenance,  including  software  diagnostics  and  hardware
procedures.

See also trouble-shooting for a list of example problems and fault-finding tips.

For further assistance, contact your local Lawo representative or the service department
at service@lawo.de.

Topics covered in this chapter are:

Software Versions

System Shutdown and Restart

Restarting a Bay Server

System Logfiles

GUI Diagnostics

AdminHD/ControlHD Diagnostics

Web Browser Interface

Telnet Sessions

File Transfer via FTP

Nova73

DALLIS Unit(s)

RAVENNA Interfaces

Control Surface

mailto:service@lawo.de
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Software Versions

Compatibility

From  version  4.0.2.2  onwards,  all  Lawo  products  have  adopted  a  consistent  software  release
numbering system to indicate compatibility. This affects system networking, mxGUI and AdminHD. In
each case, the first three digits of the software version must match.

Checking the Software Version

You can check the software version of  your  mc2  system  from  the  Global  Options  in  the  System
Settings display.

Upgrading Software

Please  register  at  www.lawo.de  (click  on  Login)  and  go  to  the  Download-Center  to  download
software and documentation for your product.

Information about each software release can be found in the "Release_Notes_X.xx".

Instructions on how to perform each upgrade are included with  the first  software release candidate
("Product_systemupdate_VX-xx-x-x").  To  perform  a  system  update,  you  will  need  a  computer
connected to the Lawo system network, and installed with suitable FTP and Telnet clients. 

http://www.lawo.de
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System Shutdown and Restart

Shutdown

The console should be shut  down by powering off  the control  surface (mains  connections  at  rear)
and Nova73 (mains connections at front).

Note that the control system is located on the Router Module (MKII) within the Nova73. Therefore, it is
here where your user data is stored. 

Following switch-off, power is  provided to  the control  system  for  a  further  18 seconds.  During this
time, all current settings are saved to flash memory; this is known as the warm  start  data.  You will
hear  several  tones  signalling that  the shut  down operation has  been  successfully  completed.  The
system is shut down when the blue LED of the trackball is off.

You may switch off the power to other system components (e.g. DALLIS units) at any time. 

Starting the System (Warm Start)

To start the system, turn on the power to the control surface (mains connections at rear) and Nova73
(mains connections at front). The components may be powered in any order, but note that the control
system  resides  within  the  Nova73.  Therefore,  the  system  boots  when  you  turn  on  power  to  the
Nova73.

You may switch on the power to other system components (e.g. DALLIS units) at any time. 

The control  system  boots  in  a  few  seconds;  during this  time the Central  GUI reports  back  on  the
boot-up progress.

By default, the warm start data is loaded at the end of boot-up. This means that the system  comes
back  exactly  as  it  was  when  you  last  shut  down,  ensuring  fast  recovery  of  all  previous  settings
following a loss of power.

Depending on who was last using the console, you may be sat  in  front  of  a  fully  configured control
surface with DSP settings or a series of blank fader strips! In either case, the fastest way to reset the
console is to load a production.

The control surface and Nova73 may be booted before DALLIS units. This enables you to
prepare settings, including signal routing, before remote DALLIS stageboxes are
connected or have received power.

Starting the System (Cold Start)

Alternatively,  the  system  may  be  set  to  cold  start,  following  the  next  reboot,  using  the  Prepare
Coldstart option in the System Settings display. Or, the Prepare Coldstart button on the front of the
Router Module (MKII).

Select  the Prepare  Coldstart  option,  and  then  force  a  restart  by  powering  off,  and  then  on,  the
Nova73.

A cold start boots without loading any warm start data. You should perform a cold start only  if there is
a problem with the warm start data, or if you wish to clear all warm start data from the system.

The best way to reset the console for a new job or show is to load a production. (A cold
start resets the system back to its cold start data and factory default settings.)
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Warm Start & Cold Start Data

Warm Start Data

The following settings are stored in the warm start data, and are recalled following a warm start:

Matrix crosspoints.

The DSP configuration.

The console’s complete settings (control surface layout, etc.)

All DSP parameters (EQ, Dynamics, etc.).

All I/O parameters (Mic preamp gain, SRC on/off, etc.)

Any Core configuration settings changed by an online AdminHD computer.

Cold Start Data

Following a cold start:

All matrix connections are cleared, unless protected by a factory configuration (.tcl) file.

The default  DSP configuration is  loaded.  This  can  be  defined  from  the  Custom  Functions
display.

The control surface will appear blank (no fader strip assignments).

All DSP parameters are set to factory default values.

All I/O parameters are set to factory default values

All configuration files return to their cold start defaults (config.tcl, gui_config.tcl, etc.)
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Restarting a Bay Server

Each TFT display on the mc²56 MKII has its own Ethernet Bay Server which can be restarted from
the front panel. You should perform this procedure, rather than a system restart, if:

the graphics on an individual display freeze or look odd. 

the controls on a panel are not responding; indicators not updating.

These symptoms can sometimes occur if a Bay Server looses its Ethernet connection to the control
system.

1. Using a pointed object, press the recessed button on the top of the display:

The Bay Server restarts.

Once  the  restart  is  complete,  communication  with  the  control  system  is  re-established,  and  the
selected display reinstated.
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System Logfiles

During operation, the system generates and stores logfiles on the control system. This allows you to
export the files to assist Lawo service with fault-finding.

There are 4 principle logfiles:

alarm.log - global alarm errors (the last 5000).

alarm.log.old - archived global alarm errors (the previous alarm.log file).

messages - messaging errors generated by the control system (the last 5000).

messages.old - archived messaging errors (the previous messages file).

Logfiles  can  be  copied  to  USB,  from  the  console  GUI,  using  the  File  display,  see  the  "mc²56
Operators Manual":

Alternatively, you may monitor the contents of a log file, remotely from your computer, using the Web
Browser Interface.

mailto:service@lawo.de
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GUI Diagnostics

The console's  Central  GUI,  or  an  mxGUI  computer  running  online,  provides  the  following  system
diagnostics:

Nova73/DALLIS Status

If a Nova73 or DALLIS component fails, or a connection is lost, then a hazard warning flag appears in
the title  bar  of  the  console  GUI.  Use  the  Signal  Settings  display  to  interrogate  the  source  of  the
problem. This display monitors all the Nova73 and DALLIS components which are defined in the Core
configuration.

Control Surface Connection

If a redundant Router Module and Ethernet connection to  the control  surface are installed,  then the
operator is presented with an error message should the active connection fail. They may then decide
to force a takeover or investigate the cause of the problem.

Control Surface Power 

On the right of status bar, the console GUI offers  status  monitoring for  all  power  supplies.  You will
see a red circle with an exclamation mark if a supply has failed.

Redundant Control System Takeover

If a redundant Router Module (MkII) is  fitted to the Nova73, then you may force a manual takeover to
the redundant control system, either from the System Settings display or by pressing the recessed
button on the front of the Router Module.

Prepare Cold Start

The system may be set to cold start, following the next reboot, using the Prepare Coldstart option in
the System Settings display.

Bulb Test, Fader Calibrate, OLED Saver Enable

These options, in the System Settings display, can be used to test the control surface illumination,
calibrate the faders or enable the OLED display saver (recommended to prolong their lifespan). See
the "mc²56 Operators Manual" for details.



mc²56 MKII Technical Manual V4.24/1 251

Chapter 4: Service/Maintenance
AdminHD/ControlHD Diagnostics

AdminHD/ControlHD Diagnostics

An AdminHD, or ControlHD computer, running online provides the following system diagnostics:

Nova73/DALLIS Status Monitoring

Once AdminHD is running online, you can use the 'Core Browser' and 'Graphic View' to monitor the
real-time status of hardware components.

In addition, the 'Remote Log' records all  messages  generated by AdminHD  and the online system.
You can save the contents of the 'Remote Log' to help diagnose any errors.
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Web Browser Interface

The control system includes an integrated web server. This allows status information to be monitored
from a remote computer, via any normal web browser:

1. Connect your computer to the Lawo system network.

2. Configure the TCP/IP settings on your computer's network interface card.

3. Open your browser software, and enter the IP address of the mc²56 MKII control system into
the URL field.

You can check the IP  address  of  your  control  system  from  the  console  GUI  (using  the  Signal
Settings display).  See also TCP/IP  Addresses  for  a  list  of  the default  IP  addresses  for  different
Lawo products.

For  example,  to  connect  to  a  mc256  with  a  default  IP  address,  you  would  type
"http://192.168.102.56" and press Enter.

The System Overview page opens within the browser:

If the page does not open, then see the trouble-shooting tips.

4. To automatically refresh any page turn on the Auto Refresh  option  at  the  top  right  of  the
screen.

5. Use the navigation buttons on the left to access the other page options.

http://192.168.123.73
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System Overview

The main System Overview  provides  information  on  system  software  versions  and  the  network
configuration:

Select Netlink usage to view the usage of tie lines within a networked system:
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Select GPIO states for an overview of the High/Low status of GPIOs:

Select RAVENNA config to view the configuration of  RAVENNA devices  fitted to  your  system.  The
information includes the IP address of each device:



mc²56 MKII Technical Manual V4.24/1 255

Chapter 4: Service/Maintenance
Web Browser Interface

System Alarm

This page lists the last 5000 errors which have triggered the Global Alarm. Every error has an explicit
ID, description and time stamp for an easy overview of the alarm events. The errors are stored within
the system logfile: alarm.log.

Select the Backlog sub page to view archived errors (the previous alarm.log file). These errors are
stored within the system logfile: alarm.log.old.
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Device Availability

This page contains sub pages for each system component - in our example,  one sub page for  HD
Core 1 can be selected. Here you can find detailed information,  including feedback on sync,  alarm
status, slot status, etc.
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Silence Detects Page

This page lists any silence detect errors generated during operation.
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System Log Files

This page provides access to all logfiles stored on the control system, allowing you to  view  system
log files (messages) or alarm log errors. Select an option to view the contents of the file.
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Telnet Sessions

Many parameters  on the  mc²56  MKII  can  be  adjusted  by  opening  a  telnet  session  to  the  control
system.

Warning

Adjusting parameters via telnet will make low level changes to your system. Therefore,
these procedures should only be performed by a fully trained member of staff.

To open a telnet session:

1. Install a telnet client on your computer. We recommend using Tera Term Pro Web 3.1.3, a
free telnet client for Windows, which can be downloaded from www.ayera.com/teraterm/

2. Connect your computer to the Lawo system network.

3. Configure the TCP/IP settings on your computer's network interface card.

4. Open the Tera Term Pro Telnet client.

5. Select TCP/IP from the Setup menu, and add the TCP/IP address of your control system to
the host list:

6. Now open a new Telnet connection using File -> New connection:

http://www.ayera.com/teraterm/
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7. Choose the TCP/IP Host address of your control system:

Default IP Address of mc266 shown:

8. When prompted, enter the login name: root  and the password: hong

The session opens, and you will see the command prompt for the control system:

9. Now follow the specific instructions for the task you wish to perform.

Some parameters are not saved on the main control system, and therefore you may need
to remotely login to another part of the system.

You can reboot the control system from the telnet client by typing reboot and Enter.
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Logging in to a Remote Control System

To remotely login to another control system (for example, the GUI_0 Bay Server):

1. At the main control system prompt, type ipinfo and press Enter.

A list of all system IP addresses is displayed:

Telnet Session to mc256 shown:

For our example, the IP address we require is 192.168.105.100 (thaddeus_GUI_0).

2. Type telnet xxx.xxx.xxx.xx (where xx.. is  the IP address of the remote control system) and
press Enter.

3. When prompted, enter the login name: root  and the password: hong

The session opens, and you will see the command prompt for the remote control system:

4. Now follow the specific instructions for the task you wish to perform.

5. Once you have finished, you can return to the main control system by typing quit.
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File Transfer via FTP

All files stored on the control system can be accessed by a suitable FTP client. 

You will need this tool to transfer files, such as  system  software or  factory configuration (.tcl)  files,
which are "hidden" from normal console GUI, mxGUI and AdminHD operation.

Warning

File transfer via FTP may make low level changes to your system. Therefore, these
procedures should only be performed by a fully trained member of staff.

To perform a file transfer:

1. Install a  suitable  FTP  client  on your  computer.  We recommend using Filezilla,  a  free FTP
client for all platforms, which can be downloaded from www.filezilla-project.org

2. Connect your computer to the Lawo system network.

3. Configure the TCP/IP settings on your computer's network interface card.

4. Open the Filezilla FTP client, and enter the following information: 

Host = the IP address of your control system

Username = root

Password = hong

Default IP address of mc256 shown:

5. Click on Quickconnect to make the connection.

The session opens, and you will see the filing system  of  the control  system  on the right  (under
Remote Site):

http://filezilla-project.org/
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6. BEFORE transferring files, check that the Transfer Type is set to Binary:

Warning

It is VERY important that file transfers use "Binary" mode, and not "ASCII".

7. You can now transfer files from the control system  (Remote  site)  to  your  computer  (Local
site), or vice versa:

Use the upper  areas  to  navigate through the filing  structure  -  the  contents  of  the  selected
folder are displayed beneath (under Filename).

Right-click on a filename and select Upload or Download - the file is transferred to/from the
selected folder.

Further information on system files can be found in the relevant technical documentation.
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Nova73

This section covers hardware servicing for both the Nova73 HD and Nova73 Compact core:

Replacing the Fans

Replacing a Power Supply Unit

Router Module MKII: LEDs & Switches

Replacing a Router Module

Replacing a System or User Data Flashcard

Updating Configuration and Software in a Redundant System

I/O & DSP Modules: LEDs & Switches

Replacing an I/O or DSP Module
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Replacing the Fans

Each of the cooling fans can be replaced individually while the Nova73 is running:

Nova73 HD rear view

Nova73 Compact rear view

1. Unplug the 4-pin connector from the rear of the frame as shown above.

2. Loosen the screws and remove the fan from the frame.

3. Insert the replacement and fasten the screws to secure.

4. Plug the 4-pin connector into the coupler of the frame.



V4.24/1266 mc²56 MKII Technical Manual

Chapter 4: Service/Maintenance
Nova73

Replacing a Power Supply Unit

Each of the PSUs are individually hot pluggable. 

To  operate  the  Nova73,  one  PSU  is  sufficient.  Therefore,  when  two  supplies  are  fitted,  you  can
replace a PSU without affecting the operation of the system.

Warning

If only one PSU is operational, then powering off will shutdown the system.

The replacement PSU must be of the same type; you cannot mix PSU types.

Nova73 HD front view

Nova73 Compact front view
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1. Switch off the PSU you wish to replace from the front of the frame as shown above.

2. Disconnect the mains from either the PSU 1 or PSU 2 IEC mains connector as appropriate.

3. Unfasten the four screws and, using the handle provided, pull out the PSU.

4. Before fitting the replacement PSU make sure that it is switched off.

5. Insert the new PSU and slide it into position until it locks into place.

6. Secure the unit by fastening the four screws.

7. Re-apply the mains to the PSU IEC mains connector and switch on!

Warning

For air conditioning reasons, both PSU slots MUST be occupied when the Nova73 is
operational:

Nova73 HD:  if  only  one  PSU  is  installed,  then  please  fill  the  empty  slot  with  a
dummy plate (Type 980/21). 

Nova73 Compact: leave both PSUs in the frame until a replacement can be fitted.
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Router Module MKII: LEDs & Switches

The Router Module MKII (980/33) provides the following front panel connections, LEDs and switches:

ACTIVE LED Flashes green when the control system is booted and
running.

The ACTIVE LED on each Nova73 module, or DALLIS
card, should blink in  time with  all  other  ACTIVE  LEDs
(at approximately 100Hz). This  shows  that  the card is
synchronous to the rest of the system. If an LED is out
of sync, then check that the card is fitted correctly, and
if the symptom persists, replace the card.

STANDBY LED Illuminates in yellow if the module is in standby. 

If you have a main and redundant Router Module fitted
to the Nova73, then one module will be ACTIVE while
the other is in STANDBY.

CHARGE LED Illuminates when the backup power unit is charging. 

Off = unit is fully charged.

ALARM LED Illuminates in red when the global alarm is active.

SYNC LEDs These four LEDs indicate the system's sync source:

Flashing green = current sync reference.

Solid green = available redundant sync reference.

PREPARE
COLDSTART

Press this button (the LED illuminates) to prepare a 
cold start. The system will then cold start on the next
power cycle (or reboot).

LAMP TEST Press this button to test all the LED lamps within the
Nova73 plug-in modules.

MODULE
TAKEOVER 

If you have a main and redundant Router Module fitted
to the Nova73, then press this button to force a 
takeover to the redundant control system.

After a few seconds, the ACTIVE and STANDBY
LEDs on the two modules update accordingly.

ETHERNET A

ETHERNET B

Connects to the control surface.

Connects to the Lawo system network.

Both connections are RJ45. The ACTIVITY LEDs flash
in green when data is being transferred.

POWER Button This recessed button will power cycle the Router
Module. It should only be used as a last resort if all
other restart methods fail.

Silk Screen Shows the part number of the module.

Further  information can be found in  the data sheet,  available  in  the  "mc2_Nova73_documentation"
guide.
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Replacing a Router Module

Router modules are individually hot-pluggable.

If main and redundant Router Modules are fitted to the Nova73, then you may replace the redundant
module (in STANDBY) without affecting the operation of the system.

Warning

If only one Router Module is fitted, then replacing the module will shut down the system!

See Installation: Mounting the Nova73 Modules for instructions. 
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Replacing a System or User Data Flashcard

A backup image copy of the System Flashcard and/or Data Flashcard can be created and stored,
so that it can be replaced if necessary.

Full  instructions  on  how  to  create  the  image  copies  are  provided  in  the  separate  technical
documentation "Creating CF Cards using the Virtual Machine".

Once you have the new flashcard, it can be replaced as follows.

You must power off the Nova73, thereby shutting down the system, in order to replace a
flashcard.

If main and redundant Router Modules are fitted to the Nova73, then please see the
additional instructions on updating data in a redundant system.

Both flashcards are located on the Router Module MKII (980/33) within the Nova73:

1. Power off the Nova73 (both PSUs if fitted) and remove the Router Module.

You will  see the System  and Data Flashcards  slotted into  the Control  System;  each should be
clearly labelled.

2. Remove the appropriate card and slide in your replacement.

3. Replace the Router Module and power on.

The control system boots and reads the new data.
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Updating Configuration and Software in a Redundant System

For redundancy to work,  both main and redundant  control  systems  must  hold  identical  information
and mirror each other. 

User  data  (productions  and  warm  start  data)  is  mirrored  at  all  times.  However,  the  cold  start
configuration and system  software are only synchronised when the control  system  boots  up.  This
has implications if you wish to upload a new AdminHD configuration or update system software.

Let’s take an example where your main control system is called A and the redundant control system
is called B. If you upload your new configuration or software to control system A and then perform a
cold start, the following will occur:

The  system  responds  to  the  cold  start  of  the  main  control  system  (A)  by  automatically
switching to the redundant control system (B).

At  the end of  the cold  start,  data from  the active control  system  (B)  is  copied  back  to  the
redundant control system (A). In other words, your new data is overwritten!

To avoid this, and upload a new configuration or update software successfully:

1. Disable the redundant control system.

This can be achieved by releasing the locking catches, fitted to the top and bottom of the redundant
Router Module (in STANDBY):

This unlocks the module from the Nova73 and automatically disables it; the module's LEDs should be
off. Note that it is not necessary to pull out or remove the module.

2. Now upload your new AdminHD configuration, or upload the new software, and cold start.

The system restarts using the new configuration files or software.

3. Once the control system is running (ACTIVE LED flashing), lock the redundant Router Module
back into place to reactivate it.

The redundant  Router  Module  boots  up,  and  all  data  from  the  main  control  system  is  copied
across.

4. Cold start the system once more to confirm that step 3 was successful.
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I/O & DSP Modules: LEDs & Switches

The front of each I/O and DSP module provides some useful LEDs:

ACTIVE LED – shows that the module’s internal control system is booted and running.

The  ACTIVE  LED  on  each  Nova73  module,  or  DALLIS  card,  should  blink  in  time  with  all  other
ACTIVE LEDs (at approximately 100Hz). This shows that the card is synchronous to the rest of the
system.  If  an LED  is  out  of  sync,  then check that  the card is  fitted correctly,  and  if  the  symptom
persists, replace the card.

Other LEDs & Switches – some modules include additional status LEDs and switches. For
details, please consult the relevant data sheet, available in the "mc2_Nova73_documentation"
guide. See also RAVENNA Port Status LEDs.

Silk Screen – shows the part number of the module.
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Replacing an I/O or DSP Module

All  I/O  and  DSP  modules  are  individually  hot-pluggable  enabling  modules  to  be  replaced  without
affecting the rest of the system.

See Installation: Mounting the Nova73 Modules for instructions.
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DALLIS Unit(s)

This section covers servicing the DALLIS hardware:

Replacing a Power Supply Unit

Master Board: LEDs & Switches

Replacing a Master Board

Replacing the Lithium Battery

I/O Cards: LEDs & Switches

Replacing an I/O Card
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Replacing a Power Supply Unit

Each of the PSUs are individually hot pluggable. 

To  operate  the  DALLIS,  one  PSU  is  sufficient.  Therefore,  when  two  supplies  are  fitted,  you  can
replace a PSU without affecting the operation.

Warning

If only one PSU is fitted, then powering off will cause an interruption in audio from the
DALLIS unit!

The replacement PSU must be of the same type; you cannot mix PSU types.

1. On the rear of the DALLIS frame, disconnect the mains from either the PSU 1 or PSU 2 IEC
mains connector as appropriate.

2. Unfasten the two screws on the right hand side of the hinged PSU cage door (marked by the
arrows below). 

3. And pull the door open to access the PSU docking bays:

Unfasten these screws: Pull door open to reveal PSUs:

4. Unfasten the metal catch which holds the PSUs in place by pushing on the catch as shown:

5. Remove the relevant power supply unit and replace with the spare.

6. Fasten the catch back into place.

7. Replace the cage door and fasten the two screws.

8. Re-apply the mains to the PSU IEC mains connector and switch on!
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Master Board: LEDs & Switches

A choice of  DALLIS  master  boards  support  different  connections  to/from  the  Nova73.  All  versions
provide similar front panel functions:

ACTIVE
LED

Flashes green when the card’s internal control
system is booted and running.

The  ACTIVE  LED  on  each  Nova73  module,  or
DALLIS  card,  should  blink  in  time  with  all  other
ACTIVE LEDs (at approximately 100Hz). This shows
that  the  card  is  synchronous  to  the  rest  of  the
system. If an LED is out of sync, then check that the
card is  fitted correctly,  and if  the symptom  persists,
replace the card.

 

WCLK OK
LED

Illuminates in green when the DALLIS is receiving a
valid sync signal.

POWER OK
LED

Illuminates in solid green when the DALLIS PSUs are
running normally. 

If the LED flashes, then there is a PSU error.

ALARM
LED

Illuminates in red when the local DALLIS alarm is
active.

WCLK Port The DALLIS may be synchronised to an external
sync reference connected to this BNC.

I/O Ports See DALLIS master boards for details on the different
I/O connections.

On some boards, LEDs show the status of the
signals arriving at the connection.

CTRL Port This port may be used to connect a local computer to
update firmware or provide diagnostics.

Silk Screen Shows the part number of the master board.

Further  information can be found in  the data sheet,  available  in  the  "mc2_Nova73_documentation"
guide.
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Replacing a Master Board

Master boards are individually hot-pluggable.

If main and redundant master boards are fitted to the DALLIS,  then you may replace the redundant
board without affecting the operation.

Warning

If only one master board is fitted, then its replacement will cause an interruption in audio
from the DALLIS unit!

See Installation: Mounting the DALLIS Cards for instructions.
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Replacing the Lithium Battery

The  DALLIS  master  board  is  fitted  with  a  lithium  battery.  This  battery  guarantees  that  user  data
remains saved when the system is powered off. As a precaution we recommend that the battery is
replaced  after  about  eight  years  of  operation.  Please  send  the  master  board  to  your  local  Lawo
service representative to perform this procedure.

Only Lawo service staff may replace batteries.
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I/O Cards: LEDs & Switches

The front of each I/O card provides some useful LEDs:

ACTIVE LED – shows that the module’s internal control system is booted and running.

The  ACTIVE  LED  on  each  Nova73  module,  or  DALLIS  card,  should  blink  in  time  with  all  other
ACTIVE LEDs (at approximately 100Hz). This shows that the card is synchronous to the rest of the
system.  If  an LED  is  out  of  sync,  then check that  the card is  fitted correctly,  and  if  the  symptom
persists, replace the card.

Other  LEDs &  Switches  –  some cards  include additional  status  LEDs  and switches.  For
details, please consult the relevant data sheet, available in the "mc2_Nova73_documentation"
guide. See also RAVENNA Port Status LEDs.

Silk Screen – shows the part number of the card.
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Replacing an I/O Card

With the exception of the Phantom Power card, all cards are individually hot-pluggable enabling cards
to be replaced without affecting other aspects of the system.

See Installation: Mounting the DALLIS Cards for instructions.
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RAVENNA Interfaces

This section covers information relevant to RAVENNA interfaces: the
981/61 Nova73 module and 947/21 DALLIS master board:

AdminHD: Configuration Options

RAVENNA Port Connections

Optical Fibre SFP Modules

RAVENNA Port Status LEDs

The Control Port

Control Port IP Addresses

Updating and Servicing RAVENNA Interfaces

For more details, please refer to the relevant data sheet,  available  in
the "mc2_Nova73_documentation" guide.
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AdminHD: Configuration Options

The  981/61  Nova73  module  provides  4  RAVENNA  ports
which are defined by the AdminHD configuration. The channel
count  per  port  is  defined  by  the  module  type,  see  Fitting
Modules to the Core.

Three different options are available:

981/61 Ravenna Link 4 x 128 channel

981/61 Ravenna Link 2 x 256 channel/2 x 128 channel

981/61  Ravenna  Link  2  x  128  channel;  1  x  256
channel

Each RAVENNA port is then configured for its application. See Defining the I/O Ports.

128  channel  ports  -  can  connect  to  a  DALLIS,  the  mc256  MKII  Local  I/O  board  or  be
configured as Tie-Lines.

256 channel ports - must be configured as Tie-Lines.

RAVENNA 128 channel Port Options RAVENNA 256 channel Port Options

If  you  select  a  DALLIS,  then  the  DALLIS  frame  is  automatically  fitted  with  the  947/21  RAVENNA
master board:

You may configure a redundant 947/21 master board in the usual manner, see Port Redundancy.

RAVENNA can provide link redundancy, without a second master board, by installing both
the copper and fibre optic connections between the Nova73 module and DALLIS master
board.
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RAVENNA Port Connections

Each RAVENNA port provides:

Ravenna Link 1.0, multi-channel digital audio over IP interface.

Two physical connections, per port, for standard CAT 5 Ethernet and optical fibre:

o CAT 5/6/7 Gigabit Ethernet, RJ45 connectors, crossed or straight (1:1) cable, up to 100m.

o Optical  transceivers  (SFPs)  can be installed for  multi-mode or  single-mode fibre.  These
must be Lawo-certified, see SFP Modules.

Up to  128-channels  at  48kHz,  and  96kHz*,  per  port,  for  DALLIS  interconnects.  (RAVENNA
supports 128/256-channels per port for non-DALLIS applications.)

* 96kHz RAVENNA is a future option.

RAVENNA links  should  be  directly  wired  to  the  corresponding  RAVENNA  port.  The  interface  is
completely self-configuring. Thus, once you have connected the ports (from your Nova73 to DALLIS),
no further network configuration is necessary.

Warning

To guarantee low latency, reliability and easy setup, do NOT connect any network
equipment between the two RAVENNA ports. 

When both copper and fibre are installed at start-up, fibre is the preferred medium. In either case, the
second medium can be hot-plugged without disturbing the current operating link. If a link breaks, then
the card automatically switches to the second medium (if installed) - note that there will be an audible
audio interruption until the automatic link/stream setup re-establishes the connection.

Close any unused optical connectors, with a protection plug, to avoid performance
degradation by dust or dirt.
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Optical Fibre SFP Modules

Each RAVENNA port provides an optical  fibre connection which can be used by installing a Lawo-
certified SFP module:

SFP Module Description Part Number

1000 BASE SX: 850nm, -7dBm, multi-mode fibre, 550m 981/60-10

1000 BASE LX: 1310nm, -3dBm, single-mode fibre, 10km 981/60-20

1000 BASE ZX: 1550nm, 0dBm, single-mode fibre, 80km 981/60-30

CWDM: 1270-1610nm, single-mode fibre; up to 40km 981/60-40 to 981/60-57

Warning

The SFP modules must be Lawo certified (from the table above).

The SFP transceivers are hot-pluggable. To install:

1. Push the SFP module into the rectangular slot:

2. Press gently and firmly until the module locks into position.
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RAVENNA Port Status LEDs

Each RAVENNA port provides the following status LEDs:

Lock LED Off = no signal.

Green,  steady state  =  the  link  is  active,  and  the  signal  and
streaming are ok.

Red, steady state or flashing = the link is active but  has  one
of the following errors:

Streaming format error

Streaming lock error

Stream is asynchronous

Stdby LED

(Standby)

Off = port is active.

Yellow  =  port  is  configured  as  a  redundant  port  and  is  in
standby (inactive).
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The Control Port

All RAVENNA interfaces include an Ethernet control port (labelled SERVICE on the 981/61 and CTRL
on the 947/21).

You  should  connect  the  RAVENNA control  ports  to  the  Lawo  system  network,  so  that  you  may
access each interface from a service computer (via FTP or Telnet).

You will need this connection in order to update or service the interface.

Network Connection

Using either a crossed or straight (1:1) network cable (STP-CAT 5 with RJ45 connectors):

1. Connect  each  RAVENNA  control  port,  and  your  service  computer,  to  the  Lawo  System
Network. For example:
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Control Port IP Addresses

To establish communication, you will need to know the IP address of the RAVENNA control port.

The IP addresses are pre-configured, as shown in the table below, and are dependent on the Nova73
slot position.

Note that the Network segment and Gateway can be configured from a file called the "pre_config.tcl",
and so may vary from those shown below.

Note also that the 947/21 DALLIS master board has a standard IP address if it is  NOT connected to
the Lawo control system = 192.168.110.253.

The table lists all the pre-configured RAVENNA control port IP addresses:

Orange = 981/61 Nova73 modules, according to slot position.

Yellow  =  947/21  DALLIS  master  boards,  according  to  their  Nova73  connection  (via  the
RAVENNA link port).

Grey = reserved for future implementation.

For example:

The IP address of a 981/61 module fitted to Nova73 slot 5 is 192.168.110.205.

The IP address of a 947/21 master board connected to this module's  first  RAVENNA port  is
192.168.110.33.
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Interrogating RAVENNA devices via the Web Browser Interface

You can open the Web Browser  Interface (from  a service computer  connected to  the mc²56 MKII
control system), to view all configured RAVENNA devices on the network.

This  is  especially useful  if  the IP  address  Network segment  or  Gateway have been  modified.  Our
example shows three RAVENNA link devices, with IP addresses configured using the "pre_config.tcl"
file:
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Updating and Servicing RAVENNA Interfaces

To update or service a RAVENNA interface,  you will  need to  open a FTP and Telnet  session from
your service computer to the device.

To achieve this, the RAVENNA interface must be connected to the Lawo system network
via its control port.

 To update the software on a RAVENNA interface:

1. Using a computer  connected to  the Lawo system  network,  open  a  FTP  connection  to  the
RAVENNA interface.

You  will  need  to  know  the  IP  address  of  the  interface  you  wish  to  update,  see  Control  Port  IP
Addresses. 

In our example, we are connected to a 947/21 master board with an IP address = 192.168.120.33

The  username  (root)  and  password  (hong)  are  the  same  as  for  the  main  mc²56  MKII  control
system. See File Transfer via FTP for more details.

2. Upload the software update file from your computer to the /data/update  folder on the remote
device:
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3. Then open a telnet session to the RAVENNA interface - use the same IP address  as  before
(e.g. = 192.168.120.33) and username (root) and password (hong).

4. At the RAVENNA control system prompt, type updateSystem and press Enter.

A list of software update files appear - this should include the file you uploaded earlier.

5. Select the correct file number, press Enter and follow the instructions to perform the update:
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 To download the Log file from a RAVENNA interface:

1. Using a computer  connected to  the Lawo system  network,  open  a  FTP  connection  to  the
RAVENNA interface.

You  will  need  to  know  the  IP  address  of  the  interface  you  wish  to  update,  see  Control  Port  IP
Addresses. 

In our example, we are connected to a 981/61 Nova73 module with an IP address = 192.168.120.205

The  username  (root)  and  password  (hong)  are  the  same  as  for  the  main  mc²56  MKII  control
system. See File Transfer via FTP for more details.

2. Download the messages file, from the /var/log folder, to copy the log file to your computer:
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Control Surface

This section covers servicing the control surface hardware:

Replacing a Panel

Using the Hood Fastener

Calibrating a Touch-screen

Replacing a TFT Display

Bay Server Rotary Switch Settings

Replacing a Power Supply Unit

Replacing the Local I/O Board

Adjusting the Local I/O Jumper Switch Positions

If the graphics on an individual display freeze, or the controls on a panel are not
responding, then try restarting the Bay Server.
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Replacing a Panel

Each  control  surface  panel  is  individually  hot-pluggable  enabling  panels  to  be  replaced  without
affecting the rest of the system.

Channel bays are fitted with one 16-fader panel per bay. The centre section is fitted with one central
panel connecting to two circuit boards.

 To replace a panel:

1. Remove the panel screws (along the front buffer) using a T20 Torx driver:

You should remove the screws completely and place them carefully to one side,  so that  they do
not fall into the frame when the panel is  lifted. The springs  beneath the panel  will  raise it  slightly
from the frame.

2. Gently lift the panel using your fingers:

If you are lifting the central panel to gain access to the components beneath, then use the 
Hood Fastener to keep the panel in place while you work.
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3. Remove the USB and power connectors taking notes on where each one should be fitted:

Fader panels have one USB and one power connector. From the central panel, there are two USB
and two power connectors.

Channel Bay: Centre Section:

4. Carefully remove the panel by lifting it out of the frame.

5. Check that the rotary switch settings on your replacement panel are correct - they should both
be set to 0, irrespective of  the frame position.  For  details,  please check the panel's  data sheet,
available in the "mc2_Nova73_documentation" guide.

6. Insert and reconnect the replacement panel, and fasten the screws back into place.

 If the control surface is powered, the panel will boot within a couple of seconds.
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Hood Fastener

The Hood Fastener can be used to keep the central panel in place while you work inside the console.
This  avoids  having to  disconnect  cables,  and remove the  panel,  when  you  need  access  to  other
components.

1. Follow the previous section's steps to lift the panel - you will see the Hood Fastener, stowed
safely along the front buffer:

Central Panel lifted: Hood Fastener Stowed:

2. Release the fastener from its catch, and position it against the metal  plate  (to  the left  of  the
trackball) as shown:

3. When you have completed your service procedure,  replace the fastener  safely back into  its
catch, before lowering the central panel.
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Calibrating a Touch-screen

The Channel and Central touch-screen displays can be calibrated as follows:

1. Select the GUI's System Settings menu, GUI topic and Screen Calibration:

Touch-screen calibration is activated across all displays.

2. Follow the on-screen instructions to calibrate the first display. You will be prompted to  touch
various points on the screen. 

When the last  point  is  touched,  calibration  is  complete,  and  all  displays  revert  to  their  normal
operation.

3. Repeat steps 1 and 2 to calibrate a different touch-screen.
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Replacing a TFT Display

Each of  the touch-screen  displays  is  individually  hot-pluggable,  enabling  you  to  replace  a  display
without affecting any other bay within the console. (Note that you will lose control from panels within
the bay, as the Ethernet Bay Server is mounted behind the TFT display.)

If you need to replace the centre section display, then connect an mxGUI computer so that
it may run online and provide continued access to central GUI operations.

 To replace a display:

1. Unfasten the three screws at the top of the display using a long T20 Torx driver, and gently tilt
the unit forwards:

Warning

The Torx driver shaft MUST be long enough to turn the countersunk screws without
scratching the front panel. If you attempt to use a short driver, or driver attachment,
damage may occur.
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2. Lift  the display unit  out  of  the frame and lay  it  carefully  face-down  on  a  piece  of  foam,  or
similar protective material, on top of the control surface:

3. Remove the LVDS, USB and power connectors taking notes  on where each one should be
fitted.

4. Check that the Bay Server's rotary switch settings on your replacement panel are correct.

5. Fit the replacement in the reverse manner.

If the control surface is powered, the display will refresh within a couple of seconds.
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Bay Server Rotary Switch Settings

Each channel  and central  bay  is  supported  by  an  Ethernet  Bay  Server,  mounted  behind  its  TFT
display. The Bay Server has a rotary switch with two settings:

Function - determines whether the Bay Server supports a channel or centre section bay.

Address  –  determines  the  Bay  Server  index,  counted  from  left  to  right  across  the  frame
starting at 0. 

You may need to adjust these settings if you are replacing a TFT display or adding an extender. 

The settings also determine how the Bay Server control system is named; this will help locate its IP
address should you need to perform a remote login. 

Bay Server
Location Function

Address Control System Naming

Centre Section 8 0 "nickname"_GUI_0

Channel Bay 0 0, 2, 4, etc. "nickname"_BAY_0, BAY_1, etc.

Note that for channel bays, address 0 is the left-most bay.

The example below shows the settings for a 32+16C+16 frame:

Adding an Extender Bay

If an extender is added to the left of the main frame, then the addresses of each main frame bay must
be shifted upwards. 

If the extender is added to the right, then its address can be counted upwards from the main frame.
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To Adjust a Bay Server's Rotary Switch Settings

1. Remove the TFT display from the bay you wish to adjust. If you lay the display on top of  the
control surface panel, you do not need to disconnect any cables.

2. Locate the two rotary switches on the Bay Server control board. This is the board mounted at
the top of the display unit (closest to you in the pictures below):

3. Adjust the Function and/or Address settings.

4. Replace the TFT display.
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Replacing a Power Supply Unit

Depending on the frame size, either one or two PSU blocks are fitted to each control surface frame.
To replace one you will need to disconnect the PSU block from its distribution board (located beneath
the control surface panel), and remove the TFT display (to access the PSU block).

There is always one PSU block fitted to the central bay:

For larger frames, the second PSU block is fitted to the left-most channel bay:

Extenders are also fitted with their own PSU block:
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 To replace a PSU block:

1. Turn off the power to the control surface by disconnecting ALL MAINS connectors - press the
red button on the IEC connector to release the plug.

Warning

DO NOT attempt to access the power supply unit without disconnecting the mains.

You must remove the MAINS connectors from the frame, rather than from the wall, as the
IEC sockets form part of the PSU module. If you do not, then the PSU module will get
stuck during step 7.

2. Lift the control surface panel in the PSU bay, to gain access to  the distribution board.  In  the
central bay, the distribution board is located on the right below the Overbridge:

3. Using a T20 Torx driver, disconnect the PSU block from the distribution board by removing the
4 wires shown below:

Warning

Do NOT disconnect any wires other than those shown.

4. Lower  the  control  surface  panel  back  into  place,  but  do  not  fasten  the  panel  screws  as
access will be required again in step 11.
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5. Now remove the TFT display within the PSU bay. If you lay the display on top of  the control
surface panel, you will not need to disconnect any cables.

You will see the power supply block mounted at the rear of the frame:

6. Using a 7mm hex socket, remove the two screws  holding the power  supply block in  place,
followed by the single screw attaching the protective earth:

Warning

Take care NOT to drop any nuts or washers into the desk.

7. Remove the PSU block from the frame, taking care to  extract  the distribution and protective
earth cables along with the unit.

8. Now  fit  the replacement  block (which comes  with  its  own 4-wire distribution and protective
earth cabling). The 4-wire distribution cables should be fed down the distribution board area.

9. Screw the protective earth to the frame, and replace the two securing screws (see step 6).

10. Then replace the TFT display (see step 5).

11. Lift the control surface panel once more, and connect the PSU block to the distribution board
(see step 3).

12. Replace the control surface panel, and fasten into place.

13. When everything is  back  in  place,  re-connect  the  rear  mains  IEC  power  connectors,  and
power on.
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Replacing the Local I/O Board

The  local  I/O  board  is  mounted  inside  the  control  surface  beneath  the  central  panel.  It  may  be
replaced as follows. The instructions apply to both local I/O board types - 958/55 (MADI) and 958/50
(RAVENNA).

Central Panel Lifted (no local I/O fitted) Local I/O Carrier Unit (disconnected)

 To replace the Local I/O:

1. Turn off the power to the control surface by disconnecting ALL MAINS connectors - press the
red button on the IEC connector to release the plug.

Warning

DO NOT attempt to access the local I/O board without disconnecting the mains.

2. Lift the central panel to gain access to the local I/O (on the left hand side), and use the Hood
Fastener to keep the panel in place while you work:
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3. Remove all of the connectors from the local I/O carrier, in the order  described below,  taking
notes on where each one should be fitted:

Local I/O (side view)

a. Disconnect  the  power  connector  from  the  backplane,  and  open  the  clamp  to  release  the
cable.

b. Disconnect the master connector - either MADI (optical SC) or RAVENNA (CAT5 RJ45). The
connector type depends on the version of your local I/O board.

Note  that  on  the  958/55  MADI  board,  the  9-pin  D-Sub  and  BNC  are  unused.  On  the  958/50
RAVENNA board,  the master  cable connects  to  the left-hand RJ45 socket,  while  the right  hand
RJ45, BNC and SFP cage are unused. 

958/55 MADI 958/50 RAVENNA

c. Disconnect  all  of  the  I/O  cables  by  unlocking  and  removing  each  D-Sub  connector.  The
numbers beside the connectors correspond to the ribbon cable labelling. The following reference
diagram can be found on the cable duct to the right of the local I/O:

Start with the two upper 37-pin D-Subs (2 & 3); then the two lower 37-pin D-Subs (1 & 4); then the
50-pin GPIO D-Sub (6); the four 15-pin D-Subs (1, 2, 5 & 3); and finally the 37-pin PHONES D-Sub
(no number, it is the only rounded connector).
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Some D-Subs are unlocked by loosening the two connector screws. Others unlock by moving the
sliding lock mechanism (use a small flat-bladed screwdriver  to  slide the mechanism  carefully to
the left or right).

D-Sub Unlocked/Locked by Screws D-Sub Sliding Lock Mechanism

There are two versions of the I/O carrier in the field, using different  directions  for  the sliding lock
mechanism. You can verify the direction by looking at the position of the screws; when open, the
screws are not covered by the sliding part:

Version 1: To open, slide to the right Version 2: To open, slide to the left

4. Once all the cables have been disconnected and carefully stowed, loosen the local I/O carrier
from the console frame. There are two nuts, one at the front (near the console arm rest), and one
at the rear (below the Overbridge).

The front nut should be removed completely and placed to one side. The front  of  the carrier  unit
may now be lifted over the bolt, and if the rear nut is loose, the unit will slide forwards.

If the rear nut has been tightened, then you may need to loosen it by opening the Overbridge (see
Replacing a TFT display for how to gain access).

Front Nut Rear Nut
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5. Carefully remove the carrier by sliding it forwards and out of the console frame. Take care that
the frame does not scrape the unit, and that the cables do not get caught:

You are now ready to fit the replacement.

6. Check the replacement unit - all D-Sub connectors should be in their open position,  and the
DIP switches set to ON (to enable remote control of headphone volume):

7. Slide the unit into the console frame (see step 5), taking care not to scratch the unit or get any
cables caught underneath. The unit should slide underneath the rear nut;  fit  and tighten the front
nut to secure (see step 4).

In mobile installations, such as an OB van or fly-away kit, the rear nut should also be
tightened. To access to the nut, you will need to open the Overbridge (see Replacing a
TFT display).

8. Replace the I/O, master and power connectors (see step 3), making sure that you lock each
of the D-Sub connectors.

9. Replace the central panel, and fasten into place (see step 2).

10. If  not  already  connected,  replace  the  Nova73  connection  (MADI  or  RAVENNA)  and  audio
connections on the rear panel of the console.

11. When everything is  back  in  place,  re-connect  the  rear  mains  IEC  power  connectors,  and
power on. Then check the functionality of the local I/O.
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Adjusting the Local I/O Jumper Switch Positions

The local I/O connector board includes four adjustable jumper  switches  (JP 1,2  and JP 3,4)  which
determine two settings: the choice of "internal talkback mic source" and the connection to Line input
16. See Jumper Switch Positions for an overview.

To adjust the switch positions:

1. Remove the Central GUI's TFT display to gain access to the local I/O connector board:

The following reference diagram can be found on the cable duct to the right of the local I/O board
(beneath the central panel):

2. Locate the correct  pair  of  jumper  switches:  either  3  &  4  (JP  3,4)  or  1  &  2  (JP  1,2)  -  the
locations and default positions are shown above and below:

Jumpers 3 & 4 (adjust Line In 16) Jumpers 1 & 2 (adjust the TBK source)
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3. In each case, take care to move BOTH jumpers to change a setting:

Jumpers 3 & 4 = position 1, 2: Line input  16 comes  from  the talkback source (the default
setting).

Jumpers 3 & 4 = position 2, 3: Line input 16 comes the LINE IN 9-16 connector.

Jumpers 1 &  2 =  position  1,  2:  Internal  talkback  comes  from  the  standard  talkback  mic
preamp. 

Jumpers 1 & 2 =  position 2,  3:  Internal  talkback comes  from  the optional  962/16 talkback
mic preamp.

For more details on the options and signal flow, see Local I/O Wiring.



V4.24/1310 mc²56 MKII Technical Manual

Trouble-shooting

Trouble-shooting

Introduction

This section includes  a series  of  example problems  and tips  to  help you fault  find the mc²56 MKII
system.

For further assistance, please contact your local Lawo representative or the service
department at service@lawo.de.

The system will not boot or does not boot correctly

The system boots up but I have no audio

The complete control surface is not responding

One of the control surface panels is not working

The graphics on the TFT displays freeze temporarily

The graphics on one of the displays freezes or looks odd

The network connection between my computer and the control system is not working

Running a PING test (to check network communcation)

mailto:service@lawo.de
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The system will not boot or does not boot correctly

The system will not boot or does not boot correctly

1. Power off the Nova73 and wait for the system to shutdown.

The system has completed its shutdown when the blue LED of the trackball is off.

2. Power on to try a warm start.

3. If this is unsuccessful perform a cold start.

If the system now boots correctly, then your warm start user data is corrupt. Check your production
data by loading a production. If this is the cause of the problem, perform another cold start and try a
different production. If there is a problem with all production data, then you may need to  replace the
Data Flashcard.

4. If this is still unsuccessful, then you should try replacing the System Flashcard with a backup
copy.
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The system boots up but I have no audio

The system boots up but I have no audio

1. Check the System Settings display to see if there any reported errors.

If a Nova73 module or DALLIS I/O card is shown in red, then there is a problem with the connection
or module/card.

2. Check the connections between the Nova73 I/O module and any DALLIS units.

Are the fibres reversed?

3. Check that all the ACTIVE LEDs on modules within the Nova73, and cards within the DALLIS,
are green and flashing synchronously. 

The  ACTIVE  LED  on  each  Nova73  module,  or  DALLIS  card,  should  blink  in  time  with  all  other
ACTIVE LEDs (at approximately 100Hz). This shows that the card is synchronous to the rest of the
system.  If  an LED  is  out  of  sync,  then check that  the card is  fitted correctly,  and  if  the  symptom
persists, replace the card.

4. If  everything  still  looks  ok,  then  try  reloading  the  DSP  configuration  from  the  DSP
Configurations display.
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Trouble-shooting
The complete control surface is not responding

The complete control surface is not responding

1. Check the Ethernet A connections between the control surface and Nova73 Router Module.

2. If main and redundant Router Modules are fitted to the Nova73, try forcing a manual takeover
to the redundant control system.

3. If not, power off the Nova73 and wait for the system to shutdown. And power on to try a warm
start.
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One of the control surface panels is not working

One of the control surface panels is not working

1. Try restarting the Ethernet Bay Server.

2. Carefully remove the panel, and check the connections.

3. Try disconnecting and reconnecting the USB and power connectors to the panel.

Try this a few times to see if the panel will boot. If not, then the panel may be faulty so please contact
your local service representative.
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Trouble-shooting
The graphics on the TFT displays freeze temporarily

The graphics on the TFT displays freeze temporarily

This may occur if the load on the CPU exceeds 95% - for example, during a production load.  Audio
processing is unaffected, and therefore the behaviour  should be ignored.  Once the production has
loaded, and the CPU returns to normal levels of operation, all graphics should update correctly.
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The graphics on one of the displays freezes or looks odd

The graphics on one of the displays freezes or looks odd

This may occur if a Bay Server looses its Ethernet connection to the Control System. 

1. Try restarting the Ethernet Bay Server.

If the problem  persists,  then the display or  Bay Server  may be faulty so please contact  your  local
service representative.
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The network connection to the control system is not working

The network connection to the control system is not working

If you cannot establish network communication between your computer and the control system:

1. Check  the  network  connection  and  TCP/IP  settings  of  your  computer's  network  interface
card.

2. If  applicable,  check that  the software  you  are  running  is  compatible  with  the  mc2  system.
When connecting from  mxGUI or  AdminHD,  the first  three digits  of  the software versions  must
match.

3. Try a PING command to test whether you have a valid network connection:

If the ping test fails, then there is something wrong with your network configuration.

If the ping test is successful, then this confirms that the network communication is working. If
you still cannot connect to the mc²56 MKII control system, then something on your computer
is blocking the network connection. Try disabling any firewall and/or antivirus software.
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Running a PING test

The PING command is a built-in Windows and Mac function, that allows you to test whether you have
a valid network connection to and from any networked device.

1. Make sure that your computer is connected to the Lawo system network, and that  you have
configured the TCP/IP settings of your computer's network interface card.

2. On a Windows  7 PC,  type cmd  into  the "Search programs  and files"  field  under  the  Start
menu and press Enter.

This opens the DOS command prompt window:

Alternatively, on a Mac, open the Terminal program (found in the Applications -> Utilities folder).

3. On both platforms, perform the ping test as follows:

Type ping xxx.xxx.xxx.xx (where xx.. is  the IP address of the device you are trying to  connect  to)
and press Enter.

You can check the IP address of your control system from the console GUI (using the Signal Settings
display). See also TCP/IP Addresses for a list of the default IP addresses for different Lawo products.

For example, to test the connection to a mc256 with a default IP address, you would type:

ping 192.168.102.56

Your computer will now try to establish communication...
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 Ping Test Fail

If the ping test fails, then the request will time out, and you will not receive any successful packets:

 

There is something wrong with your network configuration,  so check the network connections,  and
TCP/IP settings again. Or contact your network administrator.

 Ping Test Success

If the ping test is  successful, then the result will show that the Sent packets have been successfully
Received:

This confirms that  the network communication is  working.  If  you still  cannot  connect  to  the mc²56
MKII  control  system,  then  something  on  your  computer  is  blocking  the  network  connection.  Try
disabling any firewall and/or antivirus software.
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Technical Data

Control Surface

Frame widths from 16 to 80 faders .

Remote stand-alone extender frames from 16 faders.

6 banks each with 2 layers.

100mm  fader  +  two  freely  adjustable  rotary  controls  (Free  Controls)  +  Input-Gain  rotary
control + Channel GUI display for each fader.

TFT  display:  mono,  stereo  or  up  to  7.1  metering  +  bus  assignment  +  gain  reduction  for
dynamics + AfV status + VCA assignment + Mix Minus bus assign.

External display of GUI pages (via mxGUI), e.g. metering.

Fader colour coding, reset via snapshots.

Fader notch and PFL overpress (Backstop PFL).

12 channel user buttons.

9 central user buttons.

Optional:  one integrated user  panel  (automation,  40 user  buttons,  reveal  fader  surround  or
intercom), RTW goniometer integration, script tray.

Signal Processing

888 channels + 144 summing busses, 40bit floating point.*

Up to 760 inputs with A/B input, up to 64 sub-groups, 32 aux sends, up to 96 track busses, up
to 48 main sums.*

Rapid switching of channel and bus to mono/stereo/surround.

Up to 96 surround masters + 128 VCA groups with metering + 256 GPCs (General Purpose
Channels).

Surround formats: DTS/Dolby ® Digital 5.1, Dolby ®  Prologic  4.0,  DTS ES/Dolby ®  EX 6.1,
SDDS 7.1 or DTS-HD 7.1. Diverse panning characteristics + surround aux bus.

2 AFL: 1 surround 8-channel + 1 stereo.

2 PFL, both stereo.

Audio-follow-Video with 128 events, controlled via RemoteMNOPL, GPI or matrix connection.
Envelope adjustable up to 10s fade time.

Solo in place (enabled/disabled from System Settings display).

Permanent  input  meter  beside  fader  +  adjustable  INPUT,  PF,  AF,  DIROUT  meter  point  in
Channel display.

Loudness  Metering  according  to  EBU  R128  and  ATSC  A/85,  momentary  or  short  term  in
every channel,  integrated measurement  on  sum  channels  with  display  of  integrated  LUFS
value in the Central GUI headline.
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Processing Modules**: INMIX with MS decoder,  digital  amp (DAMP),  2-band fully parametric
FILTER, 4-band fully parametric EQ, 2-band fully parametric side chain filter (SCF), INSERT,
DELAY up to 1800ms (switchable to metres, milliseconds or frames), 4 independent dynamic
modules: EXPANDER, GATE, COMPRESSOR, LIMITER,  stereo IMAGE,  METER  point,  and
DIRECT OUT.

AMBIT Upmix, available on every 5.1 channel, fully Downmix compatible.

Inline configuration, with per channel or global send/return switching.

Fully-equipped surround channel with coupling of all channel parameters and hyperpanning.

* Figures are for a Nova73 HD fitted with 8 DSP boards running at 48kHz. At higher sample rates, the
number of channels and summing busses is halved.

**  The  processing  modules  listed  are  for  a  Recording  channel.  Broadcast  channels  offer  less
processing modules in return for twice as many channels.

See Channel Types for more on the differences between Recording and Broadcast channels.

Routing Matrix

Up to 8192 cross points, non-blocking.

Up to 96kHz, 24-bit. (Higher sample rate operation is defined by AdminHD).

Fully redundant signal path.

Level adjustment for all inputs and outputs.

Downmix from surround (up to 7.1) to stereo.

Integrated monitoring devices for remote locations, e.g. director’s room.

Full  networking  of  up  to  16  systems,  share  and  import  sources  and  destinations,  studio
intervention.

Full snapshot and production portability independent of matrix and DSP size.

Level control for every input and output.

Plug-in Server

Full VST plug-in  integration with  storage of  plug-in  parameters  in  snapshots  and production
data.

Static and Dynamic Automation

Snapshot automation.

Sequence automation with trim and cross fade.

Dynamic timecode-based automation for all parameters including bus assign. Modes include
touch, glide, join, punch in/out and absolute/trim (including trim "on the fly").

Offline timecode automation editing (copy, paste, delete, cut, insert, etc.)
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Interfaces

Mic/Line,  Line Out,  AES,  3G SDI,  MADI,  ATM,  GPIO,  Serial,  MIDI.  (For  details,  see  DALLIS
product information.)

Stereo and surround monitoring systems.

Local I/O within console frame: 16 Line I/O, 8 AES I/O, 8 GPIO, 2 Headphones.

Synchronisation

2 redundant sync inputs with automatic Blackburst, Wordclock, AES 3, MADI detection.

Redundancy

Redundant PSUs (standard).

Redundant DSP board (defined in the DSP Configurations display).

Optional  Redundant  Router  card  provides  redundant  routing  matrix  and  control  system,
exchangeable during run time, with full data redundancy.

Optional Redundant DALLIS cards offer fully redundant signal paths.

Control Features

Bay Isolate (ISO BAY) with separate bank and layer switching + second PFL/AFL bus.

Global A/B input switching.

Enhanced mix-minus control with independent off-air conference.

Direct out mute by fader.

Fader control of all level parameters.

Diverse tally and fader start modes.

Program switch.

Machine control.

Audio-follow-Video, up to 128 camera tallies, Ethernet or GPI controlled.

Extensive talkback system integration.

Camera mic remote via GPI or voltage control.

Remote desktop access from TFT to external computer.

mxGUI: remote control of GUI pages via external computer.

iPhone App: remote control of fader level, monitoring and snapshots.

Remote Maintenance

Connection via Internet remote software.

Software updates, error diagnostics, remote assistance.
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External Control Systems

Remote control of all routing parameters via network.

Remote control of monitoring units in remote locations.

Remote control of integrated matrix monitoring units.

Remote control of signal parameters such as SDI, silence detects, mic gain, etc. (for details,
see the Remote MNOPL documentation).

Online  configuration  with  AdminHD,  graphical  configuration  of  Nova73  and  DALLIS
components.

External matrix controllers: VSM, Evertz, Quartz, BFE, Pharos, and others.

EmBER+ control protocol (available 2013).
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Appendices
This section includes the following appendices:

System Part Numbers

Control Surface Options

Nova73 Compact

Nova73 Module Options

DALLIS Interface Options

Local I/O Wiring

DSP Configurations

SDI Parameters

GNU Public License

Control System Locations

TCP/IP Addresses
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System Part Numbers

The following part numbers will help you locate data sheets for the principle system components:

System Component Part Number

mc256 MKII Frame: 16C 959-09

16 + 16C 959-10

16 + 16C + 16 959-11

32 + 16C + 16 959-12

32 + 16C + 32 959-13

Extender (16-fader) 959-22

Control Surface Modules: Fader Panel 958-10

Central Panel 958-20

Channel Display                   958-13

DALLIS Unit Frames: 3RU DALLIS Frame 940-30

6RU DALLIS Frame 940-60

Nova73 HD Frame 10RU Nova73 HD Frame 980-02

Nova73 Compact Frame 7RU Nova73 Compact Frame 980-06

See also Control Surface Options, Nova73 Module Options and DALLIS Interface Options.
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Control Surface Options

This  section summarises  the main  control  surface  options.  For  more  details,  please  refer  to  the
relevant data sheet, available in the "mc2_Nova73_documentation" guide.

See also Installing the Control Surface and Service/Maintenance: Control Surface.

Note:

Monitoring, Headphones, External Metering & Talkback - the local I/O, integrated within
the control surface, provides audio connections for monitoring, headphones, external metering
and talkback. Therefore, there is no need to specify these as additional options. See Local I/O
Wiring for details.

19" Integration/User Panels - there are no 19" or USER panels (other than those permitted
in the Overbridge).

Power Cables - country-specific power cables are supplied for all system components.
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Frame Layouts

The  mc256  control  surface  comes  in  a  range  of  predetermined  frame  sizes.  Any  frame  may  be
expanded by fitting stand-alone extenders:

Frame Layout Part Number

16C 959-09

16+16C 959-10

16+16C+16 959-11

32+16C+16 959-12

32+16C+32 959-13

16 Fader Extender 959-22

Ethernet  and  PSU  connecting  cables  are  available  in  a  variety  of  lengths  and  must  be  ordered
separately.
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By default, frames come fully-fitted with the appropriate control surface panels:

Control Surface Panel Part Number

Fader Panel (1 per 16-fader decentral bay) 958-10

Central Panel (1 per console) 958-20

Channel display (1 per bay) 958-13

You may fit dummy panels within a frame, to reduce the initial cost of the system, and allow for future
expansion.
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Frame Version

Two different frame versions are available, designed for either studio or OB van installation.

The version affects  the  side  panels  fitted  to  the  console.  You  should  specify  the  OB  version  for
narrow side panels and a reduced console width:

Option Part Number

Studio Side Panels 959-30

OB Van Side Panels 959-31

Please see Dimensions and Weight for details.
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Stand

Optionally, the console may be delivered with a stand:

Option Part Number

Console Stand 959-32
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Overbridge Options

Space is available in the Overbridge to fit either RTW metering (shown above)  and/or  a  Lawo User
Panel. 

The permitted variations are:

Part Number RTW User Panel Fitted

958/90 No No Blank Panel

958/91 Yes No TM 9 (shown above)

958/92 Yes Yes TM 7 + User Panel

958/93 No Yes Blank Panel + User Panel

When the RTW TM 7 or TM 9 are fitted, they connect to the AES3 in/out 5-8 of the local I/O.

The default  configuration usually sets  the RTW  to automatically follow  the CRM 1  monitor  source
selector.
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The Overbridge User Panel options are:

Part Number User Panel Description

962/29 REVEAL FADER 5 dedicated faders for revealing surround slaves.

962/14 USER KEYS 40 user buttons configured from the Custom Functions
display.

962/16 INTERCOM integrated loudspeaker and internal talkback microphone,
see Local I/O Wiring.

962/18 AUTOMATION timecode automation controls.

962/15 USER CONTROLS 8 rotary controls defined by the factory configuration.

REVEAL FADER USER KEYS

INTERCOM AUTOMATION

USER CONTROLS
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Local I/O Connection

The local  I/O  board,  integrated within  the control  surface,  is  available  in  two  versions;  the  version
determines the connection to/from the Nova73:

Option Part Number

Local I/O (MADI) 958-55

Local I/O (RAVENNA) 958-50

You will need to reserve one MADI, or one RAVENNA, port within the Nova73 for this connection, see
Nova73 Module Options.
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Console Keyboard

The console keyboard is available in English or German:

Option Part Number

English Keyboard 956-23

German Keyboard 956-24

Please see Console Keyboard Driver Installation for details on how to change the language version.
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Script Tray

Optionally, one or more removable script trays may be fitted:

Option Part Number

Removable Script Tray 959-41
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Recording Com Kit

The optional Recording Com Kit provides Sony 9pin (P2), LTC and MIDI connections  to  an external
playback device.

Option Part Number

Recording Com Kit (P2, LTC, MIDI) 958-80

Machine control functions may be mapped onto user buttons from the console's  Custom  Functions
display, or handled from the optional machine control panel, mounted externally from the console.

For more details, please see the "Technical Documentation: Recording Com Kit", available from the
Download-Center after logging in at www.lawo.de.

http://www.lawo.de
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Nova73 Compact Core

The Nova73 Compact offers an alternative to the Nova73 HD for space-restricted installations:

Nova73 HD (10RU) Nova73 Compact (7RU)

Operationally,  the two cores  are identical,  and  share  the  same  Router,  DSP  and  I/O  Modules.  A
second Router  Module may be fitted for  redundancy.  And either  core  may  operate  stand-alone  or
within a larger networked system.

The key features and differences are:

Nova73 HD Nova73 Compact

Width 19”

483mm (front plate)

440mm (chassis)

Height 10RU 7RU

Weight 16.25 Kg (one PSU fitted) 14.5 Kg (two PSUs fitted)

Depth 510mm 489mm

Max. number of DSP + I/O Modules 16

(8k2 capacity router at 48kHz)

10

(5k2 capacity router at 48kHz)

Max. number of DSP Modules 8 5

Max. number of AES Modules 8 2 (fitted in slots 2 and 6)

Redundant Power Supplies optional standard

Redundant Router Module MKII optional optional

Configured using AdminHD Yes Yes

Support for Dual Self-Healing Star Yes No

To achieve its smaller footprint, the Nova73 Compact utilises a different frame (980/06),  with  front-
mounted plug-in  power  supply modules  (980/27)  and  rear-mounted  fan  units  (980/28).  The  frame
comes fitted with rear connector panels for any front-mounted AES modules (in slots 2 and 6). 
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Nova73 Module Options

The following tables summarise the Nova73 modules supported in this release of software. For more
details, please refer to the relevant data sheet, available in the "mc2_Nova73_documentation" guide. 

See also Installing the Nova73 Plug-in Modules and Service/Maintenance: Nova73.

Nova73 Plug-in Module Options

Not every I/O or DSP module can be used in every slot so it is best to check your
configuration within AdminHD before fitting the physical modules.

One MADI, or ATM, port is required to provide the Port DSP resources used for the
console's monitoring (Listen surround and Listen stereo). Therefore, you must fit at
least one MADI, or one ATM, module to the Nova73.
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Central Router Modules

980/33 ROUTER
MKII

Routing matrix (8k² at 48kHz, or 4k² at 96kHz) and integrated control system.

I/O Modules

981/02 AES3 + MADI 32 inputs and 32 outputs AES/EBU (via D-Sub or BNC rear connector panel);

1 port MADI (optical, multi-mode fibre)

981/31 MADI 2 ports MADI (optical, multi-mode fibre)

981/38 MADI 8 ports MADI (optical, multi-mode fibre)

981/32 MADI 2 double ports MADI, redundant fibre (optical, multi-mode fibre)

981/36 MADI 6 double ports MADI, redundant fibre (optical, multi-mode fibre)

981/41 MADI 2 ports MADI (optical, single-mode fibre)

981/53 ATM 3 ports ATM (optical, multi-mode fibre)

981/56 ATM 6 double ports ATM, redundant fibre (optical, multi-mode fibre)

981/61 RAVENNA 4 ports RAVENNA (CAT 5 Ethernet and SFP option for single or multi-mode
optical fibre); the port configuration and redundancy are configured by
AdminHD. See RAVENNA Interfaces.

DSP Modules

983/02 DSP 24 24 channels for the mc2 series mixing consoles.

983/03 DSP 48/24 * 48/24 DSP channels for the mc2 series mixing consoles: 48 channels at
48kHz; 24 channels at 96kHz.

983/06 DSP
IOSONO

For project-specific applications, please check your system specification.

*  The 983/03 DSP  module may be configured for  different  applications  by changing  the  AdminHD
configuration and updating the module’s firmware:

983/03  DSP  48/24  -  DSP  channels  for  the  mc2  series  mixing  consoles,  see  DSP
Configurations.

983/03-077 mxDSP - DSP paths for the routing matrix, see mxDSP Configuration.

983/03-060 DSP WFS (mix), 983/03-061 DSP WFS (filter) and 983/03-062 DSP spatial mixer
- for project-specific applications, please check your system specification.
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Nova73 Rear Connector Panels

The Nova73 HD supports two types of AES3 rear connector panel: the 980/14 (D-Sub) and 980/15
(BNC).

Pin-outs for the Nova73 Compact AES3 rear connectors are identical to the 980/14.

980/14 Connector Panel D-Sub

Outputs: 4 plugs D-Sub 25-pin, each with 8 balanced contacts 110 

Inputs: 4 plug sockets D-Sub 25-pin, each with 8 balanced contacts 110 
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980/15 Connector Panel BNC

Outputs: 32 BNC connector, unbalanced contacts 75 

Inputs: 32 BNC connector, unbalanced contacts 75 
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DALLIS Interface Options

The following tables  summarise the DALLIS  interfaces  supported  in  this  release  of  software.  For
more details, please refer to the relevant data sheet, available  in  the "mc2_Nova73_documentation"
guide. 

See also Installing the DALLIS Plug-in Cards and Service/Maintenance: DALLIS.

 3RU DALLIS (example configuration)

Not every interface card can be used in every slot. As a general rule, if an interface card is
permitted within AdminHD, then it can be fitted to your system.

The type of DALLIS master board, and hence the connection, determines the maximum
number of audio channels to/from the Nova73: up to 60 (MADI), 80 (ATM) or 128
(RAVENNA).

The Maximum Analogue Level of the whole system is defined by the DALLIS card with the
lowest GDA (General Device Address) - this is the card with  the lowest  address  fitted to
the DALLIS frame connected to the lowest port number of  the first  Nova73.  (If  a  different
fixed level analogue card is fitted elsewhere within the system, then a warning appears in
the log file; however, the card with the lowest GDA still wins.)

DALLIS Master Boards Connects to:

947/05 MADI 1 port MADI (optical, multi-mode fibre) 981/02, 31, 38

947/07 MADI 2 double ports MADI, redundant fibre (optical, multi-mode fibre) 981/32, 36

947/15 MADI 1 port MADI (optical, single-mode fibre) 981/41

947/03 ATM 1 port ATM (optical, multi-mode fibre) 981/53, 56

947/21
RAVENNA

1 port RAVENNA (CAT 5 Ethernet and SFP option for single or
multi-mode optical fibre). See RAVENNA Interfaces.

981/61
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DALLIS I/O Cards Part Number & Connector Type

 Inputs  OutputsAnalogue D-Sub XLR BNC

Mic/Line (trafo-balanced) 941/52 941/62 - 4 mono -

Line in (trafo-balanced) 941/02, 04, 06 941/12, 14, 16 - 4 mono -

Line out (trafo-balanced) 942/02, 04, 06 942/12, 14, 16 - - 4 mono

Mic/Line (elect-balanced) 941/51, 53 - - 8 mono -

Line in (elect-balanced) 941/84 - - 8 mono -

Line in/out (elect-balanced) 941/83 - - 8 mono 8 mono

Line out (elect-balanced) 942/84 - - - 8 mono

DALLIS I/O Cards Part Number & Connector Type

 Inputs  OutputsAES3 D-Sub XLR BNC

AES3 in (SRC) 943/02, 03 943/12, 13 - 4 stereo -

AES3 in (SRC) Hi-Z/Thru 943/01, 84, 85 - - 4 stereo 4 thru

AES3 in/out (SRC in) 943/52, 53 - 943/72, 73 4 stereo 4 stereo

AES3 in/out (SRC in/out) 943/54, 55 - 943/74, 75 4 stereo 4 stereo

AES3 out 944/01, 02 944/11, 12 - - 4 stereo

DALLIS I/O Cards

Part Number Description Connector TypeSpecial

Headphones 942/61 4 stereo headphone outputs 1 x D-Sub

Intercom (Riedel interface) 943/81, 82 4 AES3 in/out 4 x BNC (bi-directional)

Optical Switch 945/61 Optical to BNC change-over
switch for MADI or ATM.

2 x BNC: 1 in, 1 out

3 x MT-RJ

ADAT in/out 946/31 8 channel ADAT interface 2 x ADAT: 1 in, 1 out

IP Codec 946/34 Real-time audio streaming
over IP: up to 2 channels sim
encode/decode

1 x RJ45 (Ethernet)

1 x RJ45 (RS232)

RAVENNA (Audio over IP) 946/41  8 channel RAVENNA
interface.

1 x RJ45 (Ethernet)

1 x SFP (optical fibre)

Phantom Power 947/10 48 V supply for transformer-
balanced Mic/Line cards

n/a
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DALLIS I/O Cards

Part Number Description  Connector TypeGPI

GPI/Opto Relays 945/01 8 opto-coupler in; 8 relay out 1 x D-Sub

GPI/Opto/VCA Relays 945/05 8 opto-coupler in; 8 relay out;
4 VCA in

1 x D-Sub

DALLIS I/O Cards

Part Number Audio de-embedder /
embedder

Connector Type
SDI

3G/HD/SD SDI 946/17 up to 8 AES3 in/out (stereo) 4 x BNC: in, thru, 2 out

2 x D-Sub: metadata

HD/SD SDI

SD SDI

946/13

946/09

up to 4 AES3 in/out (stereo) 4 x BNC: in, thru, 2 out

HD/SD SDI

SDI SDI

946/05

946/01

up to 4 AES3 in/out (stereo) 3 x BNC: in, thru, out

DALLIS I/O Cards

Part Number Description Connector TypeDSP

Summing matrix 947/41, 42 8 in/out internal summing
matrix with signal generator

n/a

DALLIS I/O Cards

Part Number Description Connector TypeData

RS422 945/21 4 bi-directional data ports for
RS422 

4 x RJ45

Serial Data 945/22 4 bi-directional data ports for
RS232, RS422 or MIDI

4 x RJ45
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Local I/O Wiring

The following diagrams illustrate the wiring, pin-outs and default jumper switch positions for the local
I/O.

Note that AES IN 5-8 and AES OUT  5-8  connect  to  the RTW  meter  if  either  of  the TM 7 or  TM 9
Overbridge options are fitted.
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Local I/O Jumper Switch Positions

There are four jumper switches on the local I/O connector board, which control two settings:

JP 3,4 - set the connection to the Line input 16 A-D converter. This can be taken from:

o an "internal talkback mic preamp" (set by JP 1,2).

o the LINE IN 16 connection from the rear panel. 

JP 1,2 - set the "internal talkback mic preamp" to:

o the integrated talkback mic preamp (fitted as standard).

o the talkback mic preamp fitted to the optional 962/16 INTERCOM user panel.

Note that the JP 1,2 switch positions affect both the connection to the Line input 16 A-D converter,
and the line level talkback output available via the TBK connector.

The factory default positions, shown above, support talkback via the integrated talkback mic preamp.

You may need to adjust the jumper switches if:

the  962/16  INTERCOM  user  panel  is  fitted.  Move  JP  1,2  to  connect  talkback  from  the
INTERCOM panel's talkback mic preamp.

you are using an external  talkback source,  and wish to  "free up"  Line  input  16  for  another
application. Move JP 3,4 to connect Line input 16 from the LINE IN 9-16 connector.

Please see Adjusting the Local I/O Jumper Switch Positions for details. 

For more details on the 962/16 INTERCOM user panel, please refer to the relevant data sheet.
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DSP Configurations

DSP resources are allocated using DSP configurations.

Please note that the variation with 1 DSP board includes: 1 x stereo PFL; 1 x  stereo AFL. 

All other variations include: 2 x stereo PFL; 1 x  stereo AFL; 1 x surround AFL (7.1).

Higher sample rates use twice as much DSP resource as lower sample rates.

More channels, from the same DSP resource, become available if you use Broadcast channels.

For further details on the variations available, we recommend installing mxGUI and viewing the DSP
Configurations display.
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SDI Parameters

AdminHD can define a number of parameters  for  the SDI Card,  SDI Signal  In  and SDI Signal  Out.
The  parameters  are  what  the  system  resets  to  after  a  cold  start.  Users  can  change  these
parameters later from the GUI.

The parameters are similar to those on the mc2 GUI's Signal settings display, and vary depending
on the type card:

SDI Parameters (3G SDI Card)

SDI Parameters (non 3G SDI Cards)
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SDI Parameters (3G SDI Card)

The DALLIS  3G/HD/SD  SDI card (946/17)  is  a  multi-rate  SDI  card  with  BNC  input,  thru  and  two
outputs. It contains an audio embedder and de-embedder for up to 16 audio channels, and a VANC
embedder and de-embedder for two independent Dolby E Metadata streams. There is onboard video
and audio delay, and an integrated sample rate converter. It occupies two DALLIS card slots and may
be configured to run in a number of different modes using AdminHD. 

Further  information can be found in  the data sheet,  available  in  the  "mc2_Nova73_documentation"
guide.

Note that  SDI signals  have parameters  for  both the signal  and the card.  The  SDI  parameters  are
adjusted by selecting the card:

1. Select the 946/17 card from the System tree.

2. Then select one of the four parameter tabs:

Note that SDI card parameters may be adjusted whether the card is local to the system, or fitted to a
remote network partner.

Note that SDI parameters are never  stored by snapshots.  From  Version 4.8.0.2 onwards,  they are
stored  and  recalled  by  productions.  You  may  use  the  Global  isolate  of  SDI  parameters  custom
function to isolate SDI parameters so that settings are not affected by a production load.
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3G SDI

SRC – check this  option to  enable sample rate conversion.  Note that  SRC  is  applied to  all
channels on the card. Normally, SRC should be enabled. If SRC is off (unchecked), then the
system must be clocked to the same reference as the sending device.

Enable  video delay &  Video delay (frames)  –  this  option applies  a delay to  the SDI data
from the de-embedder to embedder. Video and audio containted in the stream are delayed by
the same amount. Set the amount of Video delay in steps of 1 video frame.

Video  generator  mode,  format  &  test  pattern  –  the  SDI  card  is  equipped  with  a  free-
running video test pattern generator. Set the mode to either:

o Auto – if the input is locked to an incoming video signal, then the output will  automatically
track the format of the input. If the input fails, then the video test pattern generator transmits
the last received video format. When the SDI module is part of a SDI chain, this  option is
recommended.

o Force On – in this mode it is assumed that the card is used as a video master and that no
SDI input  signal  is  applied.  The test  pattern generator  is  forced on all  the time.  Use  the
Video generator format and Generator test pattern options to define the video signal. In
this mode the embedder sample rate is derived from the generator, and the SDI receiver is
switched off. Note that the de-embedder cannot be used.
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Embedder

Clean – check this option to set the embedder  mode to  “Clean”.  In  this  mode the incoming
audio stream  is  deleted  and  a  new  data  structure  generated  according  to  your  embedder
settings. Note that if you select this mode any existing audio data will be lost.

Embedder Group Enable – audio is embedded in groups of four channels into SDI. There is
a total of four groups per SDI, resulting in 16 audio channels. For each group, this  checkbox
determines whether the incoming SDI stream is replaced:

o Enable the checkbox to replace the audio group content.

o Disable the checkbox to leave the audio group untouched.

If there is no audio at the SDI input, then a new audio group will be generated. 

Note that in AdminHD modes 16/0 and 8/0, all embedder group enables are turned off as the whole
embedder section is bypassed.

Embedder source 1 to 16 – use these options to define the source for each embedder.
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De-Embedder

DALLIS  signal  in  source  1 to  16  –  use  these  options  to  define  the  source  for  each  de-
embedder.



V4.24/1356 mc²56 MKII Technical Manual

Appendices
SDI Parameters

Metadata

The SDI module offers 2 metadata ports  according to  SMPTE RDD-2008.  This  allows  embedding,
de-embedding and transport of two independent  Dolby metadata streams  alongside with  the video.
The streams can be accessed via two D-Sub connectors at the front panel.

Metadata de-emb.  &  emb.  to  port  1,  2  -  use these options  to  define the streams  for  the
Metadata ports.

Metadata embedder mode & line  – set the mode to Auto to track the input, or select Pre-
selected line and define a Metdata embedder line.
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SDI Parameters (non 3G SDI Cards)

The DALLIS HD or SD SDI cards  (946/13,  09,  05,  01)  provide the ability  to  route a maximum  of  8
channels to/from the SDI stream.  Sample rate conversion may be applied to  the whole card (all  8
channels), and delay may be applied to either the embedded or de-embedded signals.

Further  information can be found in  the data sheet,  available  in  the  "mc2_Nova73_documentation"
guide.

SDI parameters can be adjusted for the card and for individual input and output signals.

Note that SDI parameters are never  stored by snapshots.  From  Version 4.8.0.2 onwards,  they are
stored  and  recalled  by  productions.  You  may  use  the  Global  isolate  of  SDI  parameters  custom
function to isolate SDI parameters so that settings are not affected by a production load.
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SDI Card

Select an SDI card from the System tree, and click on SDI to adjust the following card parameters:

SRC – check this option to enable sample rate conversion. Note that SRC is applied to all  8
channels on the card. Normally, SRC should be enabled. If SRC is  off (unchecked), then the
system must be clocked to the same reference as the sending device.

Delay – select whether delay is  enabled for  the Embedded  (SDI output)  or  De-embedded
(SDI input) signals; delay cannot be applied to both.

Generator  signal,  mode  and  format  –  defines  the  output  generator  signal  for  the  SDI
stream.

Embedder mode – select from:

o On – audio channels  will  be replaced within  the existing SDI data structure according to
your SDI output group selections.

o Off – no audio replacement; the SDI stream remains unaltered.

o Clean – deletes the incoming audio stream and generates a new data structure according
to your embedder settings. Note that if you select this mode any existing audio data will be
lost. 
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SDI Inputs

Select  an SDI input  signal  from  the  System  tree,  and  click  on  SDI  to  adjust  the  following  signal
parameters:

Group select – this field defines which pair of SDI channels will map to the selected SDI card
input. In our example, Group 2 Channels 3&4 from the SDI stream will be de-embedded to
SDI Signal In 1 and 2. 

Delay time & Delay – check the Delay option to enable delay for the stereo input, and set the
delay time in ms. Delay time can be adjusted from 0 to 240ms.

Delay is only applied to SDI inputs if the SDI card Delay parameter is set to De-embedder.
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SDI Outputs

Select  an  SDI  output  signal  from  the  System  tree,  and  click  on  SDI  to  adjust  the  following
parameters:

Group select – this field defines which pair of SDI channels will map to the selected SDI card
output. In our  example,  Group 1 Channels 1&2  from  the SDI stream  will  be embedded to
SDI Signal Out 1 and 2. 

 The assignment is only active if the SDI card Embedder mode is set to On or Clean.

Delay time  & Delay – check the Delay option to enable delay for the stereo output,  and set
the delay time in ms.

 Delay is only applied to SDI outputs if the SDI card Delay parameter is set to Embedder.

Wordlength – choose from the available drop-down menu options.

 When 16 or 20-bit are selected, dither is automatically applied.
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GNU Public License

The following modules are used in the Nova73:

Box Nova 73

Linux Kernel 2.6 x

µ CLinux 2.4 x x

netsnmp x x

busy box x x

TCL x x

xFree86 x

The GPL source code contained in this product is available at Lawo service department. If you would
like a copy of the GPL source code in this product on a CD, please send  to Lawo for the cost of
preparing and mailing the CD to you.
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Control System Locations

The table below shows the location of the control system for different mc2 and Nova73 products. 

Note that:

The Router Module MKII (980/33) control system provides two network ports: ETHERNET  A
connects to the mc2 control surface; ETHERNET B connects to the Lawo system network.

For  control  systems  located  inside  the  control  surface,  you  may  use  any  console
ETHERNET port to connect to the Lawo system network.

System Router
Module

Control
System

Location System Network
Port

mc² 56 classic 980/33 Intel Nova73 ETHERNET B

mc² 56 MKII 980/33 Intel Nova73 ETHERNET B

mc² 66 classic 980/31, 32 Intel control surface ETHERNET (any)

mc² 66 top1 980/31, 32 Intel control surface ETHERNET (any)

mc² 66 MKII 980/33 Intel Nova73 ETHERNET B

mc² 90 980/31, 32 Intel control surface ETHERNET (any)

mc² 90 980/33 Intel Nova73 ETHERNET B

mc² 90 star² 980/33 Intel Nova73 ETHERNET B

Nova73 Standalone
MKI 980/31, 32 Motorola Nova73 ETHERNET

Nova73 Ripper MKI 980/31, 32 Intel 1HE Ripper
see Technical
Documentation

Nova73 DSHS MKI 980/32 Intel 1HE Ripper
see Technical
Documentation

Nova73 HD MKII 980/33 Intel Nova73 ETHERNET B

Nova73 Compact MKII 980/33 Intel Nova73 ETHERNET B

Nova73 HD DSHS
MKII 980/33 Intel Nova73 ETHERNET B
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TCP/IP Addresses

Default IP Addresses

The default IP addresses, for different Lawo product control systems, are:

mc256 = 192.168.102.56

mc266 = 192.168.102.65

mc290 = 192.168.102.90

Nova73 (HD & Compact) = 192.168.102.143

Nova73 HD DSHS: primary 'star' = 192.168.102.32; secondary 'star' = 192.168.102.160

mxGUI (local control system) = 192.168.56.101

You  can  check  the  IP  address  of  your  control  system  from  the  GUI  (using  the  Signal  Settings
display).

Subnet Mask

For all products, the default Subnet Mask is 255.255.255.0.

Other IP Addresses

The table below lists the other IP addresses used within a mc²56 MKII installation:

Device Port IP Address Notes

Router Module Slot A ETHERNET A 192.168.105.1 Fixed address.

Router Module Slot A ETHERNET B 192.168.102.xxx Default address of the control
system (as listed above). This
address can be modified by 
AdminHD.

Router Module Slot B
(optional)

ETHERNET A 192.168.106.1 Fixed address.

Router Module Slot B
(optional)

ETHERNET B 192.168.102.xxx This address is always one digit
higher than that of the main
control system. It is set
automatically by AdminHD.

Ethernet Switch
(optional)

- 192.168.102.250 Default address.

ISDN Dialup Router
(optional)

- 192.168.102.200 Default address.

We recommend keeping the default IP addresses, where possible, as this will simplify
remote maintenance.
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48kHz or 44.1kHz See Sample Rate.

Access On mc2 consoles, much of the channel parameter operation is
performed by assigning a fader strip to the Central Control Section. This
is otherwise known as putting a source ‘in access’. 

AdminHD Lawo’s configuration and control software for Nova73 systems.

ATM Asynchronous Transfer Mode (Packing of signals in small portions;
commonly used and highly standardised network protocol).

Attack Time In the context of dynamics processing (compressor, limiter, gate or
expander), the attack time defines the duration over which an input signal
is measured. The longer the attack time, the slower the processor will
react. For example, when using a gate, a fast attack time causes the
gate to open quickly when signal exceeds the gate threshold.

Aux Auxiliary

An Aux is a general purpose mono, stereo or multi-channel summing
bus which can be used for a variety of applications such as sending to
outboard effects devices.

Aux Send Auxiliary Send

Source channels feed onto each aux via their Aux Send. The aux send
from each channel can be either pre or post fader and has variable level
control.

Aux Master Auxiliary Master

The Aux Master is a master source channel used to control the level and
processing of the Aux output. The direct output of the Aux Master is the
signal routed to the outboard effects send.

Aux Return Auxiliary Return

The Aux Return is the name given to the return channel from the
outboard effects device. This channel controls the level and processing
of the effect as it is summed into the rest of the mix. 

Band Pass Filter See Filters.

Balance Balance is applied to the input of a stereo channel and is the ratio
between the left and right input levels. When Balance is set to its default
value, the level of left and right inputs are equally weighted.

Bargraph An optical display instrument in the shape of a LED bar for displaying
signal level.

Clean Feed See Mix Minus.
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Compressor A dynamics processor used to smooth out uneven signal levels. For
example, when a presenter shouts and then whispers, they are
producing sound which has a wide dynamic range; one moment it is very
loud and the next very quiet. This can mean that if we listened to this
signal on our radio without compression, we would forever be turning the
level up and down! A compressor smoothes the signal such very loud
audio is reduced in level and very quiet audio is increased in level. This
results in smaller dynamic range ideal for radio transmission. 

Configuration The system configuration is a file created by the AdminHD software. The
file may be exported and uploaded to the system’s cold start data where
it will load following a cold start. Or, the file may be uploaded to the
system’s warm start data where it is then loaded every time the system
reboots or powers on. The configuration defines key elements of the
system such as the hardware components, and default signal
parameters.

ControlHD Lawo’s control software for Nova73 systems.

DALLIS Lawo’s modular I/O interfacing system based on 19” frames using plug-
in cards for different interfaces.

dB deciBel 

A unit of transmission giving the ratio of two powers. 

The number of bels is the logarithm to the base 10 of the ratio of the two
powers. One decibel equals one tenth of a bel.

dBU dBU is used to describe levels within the analogue domain, and is a
measure of absolute voltage level based on 0dBU = 0.775 Volts (RMS).
dBU is often used to indicate nominal broadcast operating levels.

dBFS dB Full Scale

dBFS is used to describe levels within the digital domain. 0dBFS
describes the system’s internal clipping point; this is the maximum level
which may be handled by the system without signal distortion.

Delay The signal output from a delay module is x ms behind the signal input to
the module. Delay is often applied to audio sources whose video has
undergone digital video processing; delay is required such the audio
remains in sync with the video.

Direct Out Direct Output

The direct output of a channel is the output of the individual source.
Direct Outputs are often used to provide a record or ‘snoop’ feed of a
single source, and may be taken from various points within signal flow:
pre fader, post fader, etc.

Drop-out Interruption of the audio signal caused by an error in the signal transfer or
recording.
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DSP Digital Signal Processing

Digital signal processing (DSP) is the study of signals in a digital
representation and the processing methods of these signals.

Within mc2 consoles and the Nova73, DSP is also used as the collective
name given to the processing cards, within the Nova73, which provide
audio signal processing such as equalization, dynamics and delay.

Dynamics Dynamics is the collective terms given to audio processing which
responds to changes in signal level. For example, a Compressor,
Limiter, Gate or Expander.

EQ Equaliser.

An equaliser is a processor which changes the frequency characteristics
of a signal, for example to increase the amount of treble or bass
components in the signal.

Expander A dynamics processor used to magnify changes in the dynamic range of
the input signal. For example, to reduce noise in speech pauses. See
also Compressor. 

Fader A potentiometer used to adjust the gain of a signal.

Filters Filters are equaliser sections which are used to cut out or reduce
specific frequency bands within the signal. For example, a Low Pass
Filter cuts out high frequencies so will result in less treble to the sound. A
High Pass Filter cuts out low frequencies, for example you may use this
to remove unwanted low frequencies like hum or rumble. A Band Pass
Filter cuts out both high and low frequencies allowing frequency
components within the band to pass through the signal; for example, you
may use this type of filter to create a telephone effect on a normal voice.

Gain Adjusting the gain of a signal results in a change in the perceived level or
amplitude. An increase in gain (positive values) results in amplification
and a reduction in gain (negative values) in attenuation.

Gate A dynamics processor used to remove unwanted signals below a certain
threshold level. For example, if a gate is applied to a presenter’s
microphone source, then when they speak signal level exceeds the gate
threshold and the gate opens, while if they make a low level sound, like
shuffling in their seat, the gate remains closed. The result is that only the
signal we want to hear is output from the source channel!

GPI General Purpose Interface (IEEE488) is a standardised platform
independent short-range digital interface, to allow switching connections
between broadcast equipment from different manufacturers.

Headroom The amount of operating level which is in reserve between normal
operating level and 0dBFS.

High Pass Filter See Filters.
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Insert Point A connection point within the source channel which interrupts the signal
flow and routes out to a piece of external equipment and returns back to
the source channel. 

Insert send = route out from the source channel to the external device.

Insert return = input to the source channel from the external device.

Limiter A dynamics processor used to stop signals exceeding a certain
threshold level. For example, you may place a limiter across the main
output of the programme to prevent a sudden increase in level exceeding
the clipping point of your transmission feed and causing signal distortion.

Low Pass Filter See Filters.

MADI Multi-channel Audio Interface; digital interface for combining audio signals
of 56 or 64 channels.

Mix Minus Mix Minus, Clean Feed and N-1 are all terms used to describe a feed
which is created from a number of channels minus a particular channel
or channels. For example, to provide telephone hybrids with a feed of the
programme minus the incoming phone call.

Monitor Term used to describe the outputs and functionality of feeds to
loudspeakers or headphones for the purpose of listening to a mix.

ms milliseconds

Unit of time measurement.

M-S Middle and Side Stereo

Used to describe an arrangement of two coincident microphones, one
pointing to the front (Middle) and the other (bidirectional) at right angles
providing a Side signal. The mc2 consoles provide M-S to X-Y decoding
to turn the Middle and Side signal into normal Left and Right stereo. 

mxGUI Lawo’s control software for mc2 and Nova73 systems. The software
runs GUI displays from an external PC and can be used either online or
offline.

Nova73 The heart of the mc2 system (includes the routing matrix, control system,
I/O modules and DSP). Can exist as a stand-alone routing matrix with
networking capabilities.

N-1 See Mix Minus.

On-Air Term used to indicate that a radio or TV programme is being broadcast.

Overload Occurs when the signal level is too large for the system, resulting in
signal distortion.

Panning Used to control the left/right position of a mono source when routed to a
stereo or multi-channel output. For example, if a source is panned left,
then you will all signal from the source is routed to the left side of the
summing bus. If a source is panned centre, equal levels are applied to
the left and right sides of the summing bus, etc.
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PFL Pre Fade Listen

Used to listen to signals before the application of fader level. Provides a
way of listening to a source when the fader is closed to check its signal
before the fader is opened to route it onto the programme output.

Phantom Power This is the power supply required when working with condenser
microphones. The console supplies 48V to the microphone via the audio
connector.

Programme The main output of a live broadcast console. This is the mix which feeds
the transmission chain.

RAS Radio Automation System control protocol is Lawo’s universal protocol
for communication between a mixing console (MIXER) and a radio
automation system (RAS).

Ratio In the context of a compressor or expander, the ratio defines how much
compression or expansion is applied. For example, the higher the
compressor ratio, the more signal levels above the compressor
threshold will be compressed.

Release Time In the context of dynamics processing (compressor, limiter, gate or
expander), the release time defines the time taken for the action of the
processor to subside. For example, when using a gate, a short release
time will cause the gate to close quickly after signal falls below the gate
threshold.

Remote MNOPL The remote control protocol RemoteMNOPL is a LAN based client-
server network byte order protocol to enable third party systems to
control Lawo’s digital mixing consoles or standalone routers.

Roll-off Frequency See Shelving EQ.

Routing Signal Routing

Term used to describe the connection made between an input and
output.

RS422 Type of serial interface used to communicate with external devices.

RU

Sample Rate The speed at which the internal processing of the system takes samples
respective to values from a continuous, analogue audio signal to make a
discrete, digital one. For example, when running at 48kHz, incoming
analogue audio is sampled at a rate of 48000 values per second.

Shelving EQ A shelving equaliser band is used to increase or decrease high or low
frequency components of a signal. The slope of the shelf defines how
steeply the gain increase/decrease is applied. The roll-off frequency
defines the frequency at which signal level is reduced by 3dB. 

Slope See Shelving EQ.

SMPTE Abbreviation for Society of Motion Picture and Television Engineers
Standardised protocol for the synchronisation of audio and video
technology - timecode.
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SRC Sample Rate Converter.

Sum Summing Bus

The result of several audio signals mixed together within the console. 

Within mc2 consoles, the name given to the main output busses
(programme busses).

Telephone Hybrid Device which deals with bi-directional signals to/from a 2-wire phone
line. One line provides an incoming feed from the phone line (e.g. the
guests voice), and the other sends signal back to the receiver (e.g. the
mix minus feed).

Threshold In the context of dynamics processing (compressor, limiter, gate or
expander), the threshold defines the signal level at which the processor
starts to act. For example, the gate threshold sets the level at which the
gate will open and then close.
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